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In Max/MSP/Jitter for Music, expert author and music technologist V. J. Manzo provides a user-
friendly introduction to a powerful programming language that can be used to write custom
software for musical interaction. Through clear, step-by-step instructions illustrated with
numerous examples of working systems, the book equips readers with everything they need to
know in order to design and complete meaningful music projects. The book also discusses ways
to interact with software beyond the mouse and keyboard through use of camera tracking, pitch
tracking, video game controllers, sensors, mobile devices, and more. The book does not require
any prerequisite programming skills, but rather walks readers through a series of small projects
through which they will immediately begin to develop software applications for practical musical
projects. As the book progresses, and as the individual's knowledge of the language grows, the
projects become more sophisticated.This new and expanded second edition brings the book
fully up-to-date including additional applications in integrating Max with Ableton Live. It also
includes a variety of additional projects as part of the final three project chapters.The book is of
special value both to software programmers working in Max/MSP/Jitter and to music educators
looking to supplement their lessons with interactive instructional tools, develop adaptive
instruments to aid in student composition and performance activities, and create measurement
tools with which to conduct music education research.

From the Inside FlapImprove your ukulele playing — fast! — with hundreds of fun exercises,
drills and practice tunesYou got yourself a ukulele and taught yourself to play a passable 'Happy
Birthday,' but now you're ready to take it to the next level. You've come to the right place. This
exercise book is your ticket to becoming a bona fide ukulele hero. It supplies expert tips, tricks
and plenty of jammin' exercises that will have you strumming and picking your way through
everything from the classic ukulele tunes to cool jazz progressions, intricate instrumental pieces
and blues riffs like a pro — in no time. And if you're brand-new to the uke, you'll find a lot to like
here as well.Brush up on the fundamentals — discover how to hold your ukulele; play common
chords; read ukulele notation and tab, chord diagrams, neck diagrams, and rhythm chartsStart
practising on the right foot — shorten your learning curve with pre-practice warm-ups, including
finger- and hand-stretches, breathing exercises, and strength-building exercisesDo some
serious strumming — strengthen your rhythm, timing and ability to find the right pattern for any
song, or even transform simple strumming patterns into sweet improvsBecome a power-picker
— master rhythmic fingerpicking songs and solo fingerstyle pieces with exercises that quickly
improve speed, flexibility, and fluidityMaster the fretboard — learn to build major and minor
scales across the neck of the ukulele, build chords in different positions up, and down the
fretboard and craft slick solos in rock, blues and jazz stylesAudio download includesOver an



hour and a half of audio featuring the exercises and songs from the book — so you can hear
exactly how they should soundOpen the book and find:Hundreds of exercises in various keys,
tempos and stylesStrumming exercises from common chord changes to advanced
techniquesScales and scale sequencesPicking patterns and exercises that build speed and
confidenceWays to apply the techniques and tricks you learn to play actual songsWarm up
exercises that make learning faster and easierTips on performing before an audienceFrom the
Back CoverImprove your ukulele playing ― fast! ― with hundreds of fun exercises, drills and
practice tunesYou got yourself a ukulele and taught yourself to play a passable 'Happy Birthday,'
but now you're ready to take it to the next level. You've come to the right place. This exercise
book is your ticket to becoming a bona fide ukulele hero. It supplies expert tips, tricks and plenty
of jammin' exercises that will have you strumming and picking your way through everything from
the classic ukulele tunes to cool jazz progressions, intricate instrumental pieces and blues riffs
like a pro ― in no time. And if you're brand-new to the uke, you'll find a lot to like here as
well.Brush up on the fundamentals ― discover how to hold your ukulele; play common chords;
read ukulele notation and tab, chord diagrams, neck diagrams, and rhythm chartsStart
practising on the right foot ― shorten your learning curve with pre-practice warm-ups, including
finger- and hand-stretches, breathing exercises, and strength-building exercisesDo some
serious strumming ― strengthen your rhythm, timing and ability to find the right pattern for any
song, or even transform simple strumming patterns into sweet improvsBecome a power-picker
― master rhythmic fingerpicking songs and solo fingerstyle pieces with exercises that quickly
improve speed, flexibility, and fluidityMaster the fretboard ― learn to build major and minor
scales across the neck of the ukulele, build chords in different positions up, and down the
fretboard and craft slick solos in rock, blues and jazz stylesAudio download includesOver an
hour and a half of audio featuring the exercises and songs from the book ― so you can hear
exactly how they should soundOpen the book and find:Hundreds of exercises in various keys,
tempos and stylesStrumming exercises from common chord changes to advanced
techniquesScales and scale sequencesPicking patterns and exercises that build speed and
confidenceWays to apply the techniques and tricks you learn to play actual songsWarm up
exercises that make learning faster and easierTips on performing before an audienceAbout the
AuthorBrett McQueen is a musician, songwriter and the founder of ukuleletricks.com, one of the
most popular ukulele sites in the world, where he provides audio, video, and written instructional
material (along with personalised feedback) to freshly minted ukulele fans everywhere. Alistair
Wood is the man (the myth and the legend) behind ukulelehunt.com and the author of Ukulele
For Dummies.Read more
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Cataloging-in-Publication DataNames: Manzo, V.J.Title: Max/MSP/Jitter for music : a practical
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2Paperback printed by WebCom, Inc., CanadaHardback printed by Bridgeport National
Bindery, Inc., United States of AmericaContentsForeword by David
ElliottPrefaceAcknowledgmentsAbout the Companion Website1 Introduction to
ProgrammingCovers the basic tools of operation and navigation in Max as well as an
introduction to the basic ways to work with data.• Introduction to Max• The Max Window• Help
Patchers• Arguments• Separating Items in a Message• Numbers: Integers and Floating Points•
Aligning• Commenting• Inspector2 Generating MusicIntroduces elements of algorithmic
composition. We will create a program that randomly generates pitches at a specified tempo.
The program will have the ability to change a number of musical variables including timbre,
velocity, and tempo. We will also write a program that allows your MIDI keyboard to function as a
synthesizer. These two programs will be the basis of future projects related to composition and
performance.• The RAT Patch• MIDI (Musical Instrument Digital Interface)• Synthesizing MIDI
Numbers• Adding Timing• Slider Patch• Rat Patch 2• MIDI Input3 Math and MusicDiscusses
some of the math used in musical operations. We will examine the math behind musical
concepts like transposing music by some interval and adding chord tones to a root note. We will
also look at some of the things that will help make your program look better and more accessible
to users. We will create a program that harmonizes MIDI notes.• Math in Max• Forming Intervals•
Window Dressing• Creating Chords• Presentation Mode• Further Customization• Comments4
Scales and ChordsDescribes how to build scales and chords and play them back in a variety of



ways. By the end of the chapter, you will write a program that allows users to play diatonic
chords in a specified key using just the number keys on your computer keyboard.• Scale Maker•
Chord Maker• Order of Operations• Setting Values5 Interactive Ear TrainingDescribes how to
make an interactive ear-training program.• Ear Trainer• Further Customization6 Data
StructuresDescribes how to write a program that randomly generates diatonic pitches at a
specified tempo. We will learn how to filter chromatic notes to those of a specific mode by using
stored data about scales. By the end of this chapter, you will have created a program that
composes diatonic music with a simple rhythm. We will also learn about adding objects in order
to expand the Max language.• Adding External Objects• Tonality in Max• Filtering Chromatic
Notes to Diatonic Notes• Random Tonal Music• Abstractions and Subpatchers• Working with
Pitch Classes• Alternate Way• Tables7 Control InterfacesExamines some premade patches
demonstrating a few techniques for designing diatonic musical instruments. We will review some
of the basic ins and outs of MIDI, learn some ways to program more efficiently, and discuss a
number of control options for your patches.• bpatchers• MIDI Out bpatcher• Saving Settings•
Chords• Storing Presets8 Control Interfaces ContinuedExamines some innovative ways to
control music making as we develop musical instruments. We will use your computer keyboard
and mouse as performance instruments as well as discuss the use of videogame controllers in
your patches.• Arguments for Abstractions• Using the Mouse• Using Videogame Controllers9
Tools for Music Theory ConceptsDescribes how to design some tools to aid in the discussions
of concepts related to music theory. In particular, we will discuss chord progressions, scale
analysis, chord analysis, mode relationships, harmonic direction of chords, and harmonization.
By the end of this chapter, you will have an arsenal of tools for explaining theoretical concepts of
music.• Chord Progressions• Scale Analysis• Mode Relationships• Harmonic Direction•
Harmonization10 Working with TimeDiscusses aspects of time, rhythm, and the sequencing of
events. You will learn to create interactive performance and compositions systems as well as
create patches that demonstrate rhythmic complexity. By the end of the chapter, you will have
created patches that can record and loop MIDI sequences as well as a number of patches that
work with notes over time.• Sequencing• Step Sequencers• The Transport• Overdrive11
Building Standalone ApplicationsAnalyzes a “Chord Namer” application that allows a user to
enter a chord name and see the notes on a MIDI keyboard. We will “build” this patch as a
standalone program that can be used on any computer even if it does not have Max installed.•
Preparing the Application• Building the Application• Icons• Styles• Permission and Cross-
platform Building12 Introduction to Max for LiveDiscusses using Max for Live, the add-on for the
digital audio workstation Ableton Live that allows users to incorporate Max/MSP/Jitter into their
Ableton Live projects.• Overview• Crash Course in Ableton Live• Writing a MIDI Program13
Working with AudioDiscusses MSP, a collection of objects that work with audio signals. The
MSP objects can handle actual sound recordings, like audio from a microphone, as well
generate signals.• Basic Ins and Outs of Audio• Sine Waves• Timbre• Synthesizer• Synth
Building14 Audio Playback and Pitch TrackingLooks at some of the ways that you can play back



and record sound files. We will also look at some ways to track the pitch of analog audio and
convert it into MIDI numbers.• Playback• Pitch to MIDI Tracking• Pitch Tracking to MIDI
Harmonization• Preserve Pitch While Adjusting Tempo• Pitch Correction15 Audio
BuffersDiscusses how to record audio into a storage container called a buffer. By the end of this
chapter, you will be able to record a performance through your microphone and loop the
recording while you make sonic changes to it. You will also learn how to make a polyphonic
synthesizer that uses a single recording of your voice as the pitches.• All about Buffers•
Recording into a Buffer• Max for Live• Referencing Playback Speed to a MIDI Note16 Audio
Effects and ProcessingAddresses implementing audio effects into patches with live audio and
sound files.• Preparing the Patch• Delays• EQ• Other Effects17 Working with Live
VideoDiscusses Jitter, a set of objects that handle video and visual-related content in Max. By
the end of this chapter, you will have created a patch that changes the color of a live video when
pitches are played.• Matrix• Camera Input• Adjusting Color• Mapping MIDI Pitches to Color18
Working with Video FilesWorking with preexisting video files located within the Max search path.
By the end of this chapter, you will have created patches that detect presence in certain areas of
a video. We will also examine some aspects of tracking colors in video.• Video• Presence
Detection• Color Tracking• Preassembled Video Patches19 Research InstrumentsLooks at
various research instruments designed to measure stimulus and response, hearing, perception,
and more.• Stimulus Testing Instrument• Working with Paths• Populating a List of Files• Hearing•
Perception• Application20 Informal Music Learning InstrumentsLooks at a collection of
interactive systems used to facilitate music making with individuals who lack prior musicianship
skills.• Playing Diatonic Music with Ease• E001• E005• E003• E002• E006 and EAMIR Note•
FMT and Music Basics21 Interactive CompositionsExamines some ways to interact with audio
processing objects, and, in particular, compositions for live acoustic instruments and Max.•
Electroacoustic Music• Delayed to Rest: Composition for Electric Guitar and Computer•
Discourse: Composition for E Clarinet and Computer• ConclusionReferencesForewordMax/
MSP/Jitter for Music—aptly subtitled A Practical Guide to Developing Interactive Music Systems
for Education and More—is a groundbreaking, step-by-step approach to empowering the
creativity of music educators and music students through interactive computer software
design.V.J. Manzo provides a brilliantly organized, detailed, and illustrated explanation of how to
create, customize, and individualize music software to support whatever music teachers and
students want to do: compose, perform, improvise, analyze, research, and/or enhance and
assess student’s development of musical concepts, aural skills, notational and theoretical
competencies, knowledge of multiple musical styles, and much, much more.Divided into a
careful sequence of twenty-one chapters, this practical guide begins with a clear introduction to
the nature and uses of Max/MSP/Jitter, or Max (for short). Max is distinctive among music
programming languages because it employs a user-friendly graphic interface that facilitates both
formal and informal music teaching and learning. Importantly, this book is not a dry handbook/
textbook; it includes a wealth of practical examples and tutorials, sometimes in easy-to-follow



“cookbook” format.Among the themes and strategies discussed and implemented in Max/ MSP/
Jitter for Music are discussions of generating music through algorithmic composition; the “math”
underlying musical concepts, theory, and harmony; and ways of building scales and chords in
“painless” ways for use in personalized creativity. Among many other highlights of the book is the
way Manzo explains how to create musical instruments with Max; build and visualize chords on
a MIDI keyboard; record and play back student performances and compositions; and use Jitter
to create and manage video content.V.J. writes in a very clear and personal style, which is based
not only his vast knowledge of music software and hardware, but on his many years of practical
experience as an extraordinary classroom teacher. Indeed, I have seen V.J. in action on
numerous occasions. He embodies all the attributes of the complete musician-educator: artistry,
creativity, savvy, intelligence, and highly informed action.David ElliottProfessor of Music and
Music EducationNew York UniversityPrefaceAn interactive music system is a hardware and/or
software configuration that allows an individual to accomplish a musical task, typically in real
time, through some interaction. Though commonly associated with composition and
performance, the tasks associated with interactive music systems can include analysis,
instruction, assessment, rehearsal, research, therapy, synthesis, and more. These systems
typically have some set of controls, hardware or software, such as switches, keys, buttons, and
sensors by which musical elements like harmony, rhythm, dynamics, and timbre can be
manipulated in real time through user interaction.In this book, we use the programming
language Max/MSP/Jitter to write custom software for musical interaction. We discuss the
concepts needed to complete your project, complete many projects in a step-by-step style
guide, and look at examples of working systems. Emphasis is placed on the pedagogical
implications of software creation to accomplish these tasks. Whether you want to create a
program for composers that explores relationships between two modes or an exercise for
beginners that helps improve finger dexterity, you will soon learn how writing customized
software can supplement and complement your instructional objectives. We also discuss ways
to interact with the software beyond just the mouse and keyboard through use of camera
tracking, pitch tracking, videogame controllers, sensors, mobile devices, and more.Why Design
Custom Software?Today, there are software applications for just about everything, but to what
extent do we allow music software to dictate how we teach musical concepts? After installation
of a software application, it’s normal to look at the program and ask “what does it do,” “how can I
perform with this,” and “how can I make a demonstration or instructional activity out of this for my
class?” There’s certainly nothing wrong with this, but you may already have some musical ideas
in mind and are looking for a way to express them using the efficiency and interactivity of
technology. However, existing software may not be able to address the particular concepts you
want to address from the angle you prefer.Imagine teaching harmony with the aid of a
specialized program that showed common tones between the chords and scales, or a program
that used the first seven number keys to play the seven diatonic chords of a key. Imagine
composing a piece of music with a program that showed how chord functions tend to resolve in



a given key.Software developers typically design a program’s layout to be accessible and
intuitive, but in doing so, they are bound to show certain biases toward the visibility of what are
considered the more common features. In an instructional setting, if the feature that is going to
help the instructor explain concepts of rhythm or harmony is somewhat buried in the program’s
menus, he or she may be less inclined to teach those musical concepts right away because
there is too much requisite knowledge of the software involved just to get to the desired menu.
Instructors would have to teach a number of software concepts just to get to the place where
they could teach the musical concept they wanted to address in the first place. It’s not the
software company’s fault; after all, they don’t know what and how you teach. However, it’s a
common case of technology dictating the instruction instead of instruction dictating the use of
technology.This problem is not unique to technology. Even the conventions of traditional notation
using staff paper can dictate how we’re going to teach; if we don’t enjoy counting notes on
ledger lines, we just stick to writing notes on the staff. In the same way, it’s just as easy for
software to confine us. If we want to teach some musical concept in an interactive way using the
efficiency of technology but can’t find the technology to support it, the notion of an interesting
approach to teaching the concept likely gets dropped.At the same time, teaching with
technology can be seen as trendy and gimmicky. Suppose you decide to write a program that
plays diatonic chords in a key by using the buttons of a videogame controller. The activity in a
classroom setting can be fun, but at the same time, it can be pretty pointless if the program
doesn’t address some musical concept and the activity isn’t accompanied by solid teaching.
However, if these things are in place, the student is then able to accomplish some musical task
using a controller that is easy to use—and probably more familiar than that one-octave
xylophone he’s hated using all year. It’s easy to worship technology because of its “ooh wow”
factor, especially in a classroom setting. However, after the novelty of the technology wears off,
we’re still music educators first and technologists second. A good interactive system should
allow a user to do musical things with efficiency, greater control, and clarity; it should not just
exist for the sake of having technology in the classroom.Technology in the ClassroomHaving an
arsenal of customized software to explain specific musical concepts can make your teaching life
so much easier. How many times do you really need to write out the whole step and half step
patterns of a major scale on the chalkboard? What if you had an application that showed the
pitches, and steps for a scale, any scale, starting on any pitch? Not only will using such an app
save you time, but it’s a program that you could allow your students to download and interact
with on their own.Many teachers are terrified of teaching “technology lessons” because they
don’t want to be in the situation where some little kid knows more about technology than they do,
when the reality is that having a kid like that in class can be an incredible benefit! That kid
already understands the technology, so first, he’ll be the cheapest and most accessible tech
support you’ll ever find when something goes wrong in the classroom—let him troubleshoot for
you and his peers when things stop working. Second, and more important, since he already
understands the technological side of things, it helps you to conceptually explain to him the



musical side of things, which I guarantee he doesn’t understand nearly as well as you. Musical
concepts, as you’ll recall, are the sorts of things you went to school to learn about.These days,
you can’t walk into a convenience store without seeing seven or eight computers being actively
used for a specific intended outcome—why should the music classroom be any different? Even
band classrooms! Technology truly can help facilitate our teaching objectives. However, students
don’t just need teachers to show them new tech toys or cool software; they can find that on
YouTube, from their friends, and in their local music store. What they need is for a trained
musician to help them make sense of the musical world around them—the use of interactive
music systems can make this process richer and more palatable. That’s knowledge students
can’t find just anywhere.Book DesignThis book is divided into 21 chapters that address common
uses for the software Max/MSP/Jitter as they pertain to music educators. The book is structured
in a step-by-step guide by which we’ll build programs. We address the musical concepts and
pedagogical implications behind the programs we write and provide instruction for adaptation
and expansion of the programs.If you are an instructor using this book as the text for a semester
course, I would recommend covering about two chapters per week with the exception of longer
chapters like 6 and 12 or wherever a little more time is needed on a given topic. New material
builds upon previously learned concepts, so while skipping chapters is possible, students
should be told to read the Help file for any unfamiliar objects or terms. Each chapter concludes
by providing a list of objects and terms introduced in the chapter. There are assignments at the
end of each chapter that are somewhat more rigid in design at first, but soon allow the reader
some level of individuality in completing them. Regular assessments and individualized projects
are strongly encouraged.Basic TroubleshootingThe activities provided in this book have been
tested, and you should not encounter any problems—in theory! As you move through the book,
you’re going to have to act as your own troubleshooting team if something goes awry. For every
activity we do, there is a picture reference in the text and a working example of the software
available on this book’s companion website (see “About the Companion Website” following the
acknowledgments).A few basic steps will help to make sure that you don’t run into problems:1.
Save early and save often—ensure that you save your work frequently and that you keep your
saved files organized. Don’t accidentally overwrite files with the same name unless instructed to
do so in the text.2. Follow the steps—ensure that you’ve followed the instructions exactly as
written by connecting things correctly and entering text correctly, noting spaces if present.3.
Consult the picture and reference patch—as mentioned, a working example of each activity is
available from the companion website.4. Restart the program—if you are still running into
problems, save your work, restart the program completely and re-open your work.5. Restart the
computer—if your computer is being unresponsive, it is a good idea to shut it down, wait for a
minute or so, and turn it back on (don’t forget to turn it back on as this is considered to be an
important step).6. Getting help—consult the floating Max Window, the Max Help files, and the
Max reference files, all of which are explained in the first chapter.7. If for some reason you still
encounter an error, you should try to recreate the error on a different computer to identify



problems with your machine; it’s always possible that your volume is down, speakers are
unplugged, the keyboard is not working, and so on. Errors like this are best discovered in the
privacy of your own home to minimize the amount of humiliation experienced.8. Cycling ’74, the
authors of the software Max/MSP/Jitter have a support forum on their website. However, you
should refrain from posting your questions on this site until you have read through this book and
all the reference files (including tutorials) in the program. The users on the forum are helpful for
matters that go beyond information that is clearly covered in the aforementioned references. If
you’re a student, it’s also not a good idea to try to pay people on the forum to complete
assignments for you. If you are reading this book as part of a course, the chances are strong that
your instructor subscribes to the forums and will see your post.This book and the activities
described herein have been revised slightly for Max 7 in this second edition of the book, though
most concepts introduced are still compatible with both Max versions 5 and 6. As new versions
of Max are released, some changes to the program documentation, layout, and functionality
may occur that are different from how they appear in this text. Simply consult the Help files and
revision history documents provided within the program in these cases. Be patient; some
concepts are a little tricky and you may have to reread something a few times before it sinks in.
All in all, Max/MSP/Jitter is not hard to learn, but be patient. We’ll create software with Max in a
way that exposes you to the language, but keep in mind: there’s more than one way to write the
same program. Soon, you’ll get the hang of it and will be writing your own programs in no time.
Enjoy!AcknowledgmentsThis book is special to me for a variety of reasons, but, primarily,
because writing the first edition was very different from other types of writing I had done at the
time, and very different from writing music or software. There were many people who helped me
then and even more who have since helped by giving me feedback and suggestions; many of
which I have integrated into this edition. If you read the first edition, or one of my other books and
are now reading this one, thank you for sticking around.I would like to thank all of my colleagues
at Worcester Polytechnic Institute for their support and encouragement. Thank you to my
colleagues in music technology, Frederick Bianchi and Scott Barton, Dean Karen Oates, and my
department head Kristin Boudreau for supporting our vision to make WPI an innovative place for
music making. Thank you to all of the students at WPI who have helped to test-drive this book—
especially, Erica Bowden. Thanks!To my colleagues in the Kean University Conservatory of
Music: my continued thanks for your help all those years ago when I was beginning in academic.
To Mathew Halper: thanks for telling me about Quorn all those years ago … oh, and something
about Tristan or something; this second edition exceeds the first in that it goes up to eleven. To
my colleagues at the New Jersey Institute of Technology and Montclair State University: thank
you for your support and insight throughout my time there. Thank you to Michael Halper and
Scott Skeebo for continuing to do some very good work in that area. To Deborah Confredo and
my colleagues in the Boyer College of Music and Dance at Temple University: thank you for your
openness to spending time talking about my research ideas involving technology for music
education during my doctoral years. To Alex Ruthmann, David Elliott, and the music faculty at



NYU: thank you for demonstrating the vast implications for technology in music. Thank you also
to David Elliott for writing the forward. To my colleagues in the Technology Institute for Music
Education (TI:ME) and the Association for Technology in Music Instruction (ATMI): thank you for
your continued support and input about my work. Thank you Will Kuhn, my co-author for
Interactive Composition (2015). Thank you Rick Dammers, Bill Bauer, and Dave Williams for
your excitement and enthusiasm about using technology to reach the 80% of students who
aren’t part of their school’s band, choir, or orchestra.Thank you to Ableton, Cycling ’74, the many
members of the Ableton and Cycling ’74 forums, and the numerous developers and artists
throughout the world that contribute to this very unique community. Thank you, also, to all users
of the Modal Object Library and the EAMIR SDK, and all EAMIR supporters—you’re the best!To
Queen and Roy Thomas Baker—thank you for making me reconsider my ranking for favorite
Queen album on a regular basis: currently, Queen II, or Queen, but Sheer Heart Attack is so
good … see what I mean?To Norm Hirschy at Oxford University Press: it’s been a great
experience getting to know you and work with you since we first met to discuss this book (back
in 2009!). Thanks for sharing the vision for this book.Of course, I would be lost without the
support of my family, my lovely wife Raquel and her family, all of my friends, and the various
animals in our family. Thank you!About the Companion WebsiteOxford has created a password-
protected website to accompany Max/MSP/ Jitter for Music. The site features documented
source code for each example in the book. Throughout the text, the caption for each figure
pictured includes the file name of a patch that you can open as a reference example. Simply
follow along in the book while developing your own software or using the example code in case
you get stuck.The site also features numerous examples of larger projects written in Max/MSP/
Jitter, third-party external objects and patches addressed in the text, and other media data,
which you can modify and use for your own projects.You may access the site using username
Music4 and password Book2497.Max/MSP/Jitter for Music1Introduction to ProgrammingA
programming language is a means to specify processes performed by a computer. A
programming language is somewhat similar to the language we speak. Each word in the
language serves some function and the ordering of each word follows a syntax from which we
derive meaning.In a programming language, these words are commonly referred to as functions
or objects. Each object has some purpose germane to the programming language. For example,
an object called number might allow a user to specify a number. Another object called + might
be used to add that number to another number. The objects, each with a specific purpose, work
together to create some intended outcome; this is how a program works. In this case, the
program we defined added two numbers together.In a typical programming language, there are
numerous objects, each with a specific function. One difficulty in the beginning stages of
learning to program is that you do not know the fundamental objects that form the basic
vocabulary of that programming language. In this book, we will begin by developing small music
programs that use only a few objects. As we progress in chapters, more objects will be
introduced and your programs will become more sophisticated as you incorporate more objects



into them.Another difficulty lies in thinking about the steps involved in creating a program. There
are different ways to write programs that achieve the same result, but they all require that precise
activity to be specified in order to produce that result.In an early experience as a kindergarten
music teacher, the teacher stood at the door of my classroom and greeted the students as they
entered the room. “Good morning, let’s take out our books and begin class.” At that moment, the
students hadn’t yet put their backpacks down, walked to their seats, or sat in their chairs. It was
obvious that they were not ready to begin class. Some students scrambled to find any book
anywhere in the room. Some took all of their books out of their backpacks. One student began
crying. It was a disaster.The problem was that the teacher didn’t clearly describe the individual,
sequential processes that needed to take place. Instead of using a number of small processes in
conjunction with one another, the teacher attempted to use one “high-level” command that
would do it all. It is important to think of the overall flow of actions before you begin to program;
break down the objective into smaller, “low-level” tasks and create a procedure for
accomplishing the objective.In this book, we will be using a programming language called Max/
MSP/Jitter, commonly referred to as simply Max. Max is different from most programming
languages in that it uses a graphical interface to display each object as a small rectangle on the
screen. This rectangle is called an object and is the basic unit of function in Max.Objects
typically have inlets on the top of the rectangle for receiving data from other objects, and outlets
on the bottom for sending data to other objects. Data are sent from one object to another by
drawing a small line, called a patch cord, from the outlet of one object to the inlet of another
object. With the objects connected via patch cords, it is easy to see the dataflow between each
object in your program. In many ways, the process is not unlike connecting guitar pedals
together.There is an unlimited number of programs you can write using Max. For the purpose of
this book, we will focus on the necessary skills to write programs for composition, performance,
and music instruction. Those who may find this book particularly useful are music educators who
want to supplement their lessons with interactive instructional tools, develop adaptive
instruments to aid in student composition and performance activities, and create measurement
tools with which to conduct music education research. There are no prerequisite programming
skills required at all and the programs we will write can be useful for children as well as adults.It
would be beneficial to read this book while working through the tutorials included in the Max
software application. At the end of each chapter, a few related tutorials are given as
supplemental reading materials. As you begin to learn this language and grasp the concepts of
programming, you will quickly see how easily you can develop software applications to
accomplish your objectives.Example files for each chapter are available from the Oxford
University Press companion website for this book. Portions of these files are pictured in figures
throughout each chapter. For your reference, in the description beneath each picture is the file
name from which the picture was taken.The steps involved in creating these patches are listed in
a “cookbook” style numbered list. If you get stuck or if something doesn’t work correctly, go back
and ensure that you have completed each step exactly as described, and you’ll find yourself



back on track.If you have not already done so, download and install the latest version of Max
from This book, now in its second edition, has been updated for use with Max 7. You will also
need to download the demonstration files that accompany this book from the companion Oxford
University Press website at for this book or from The demonstration files also contain a zip file
called EAMIR SDK that you should install prior to reading Chapter 6.Introduction to MaxAs we
begin building some programs together, be brave. At times, you may not understand the
programming concepts at first and it may feel as if you were just blindly following instructions.
Continue to follow each step in the programming process and these concepts will soon become
clear.In this chapter, we will look at the basic tools of operation and navigation in the Max
programming environment. As we spend time discussing these tools, don’t expect to make any
music until the next chapter. An understanding of these tools is necessary to use the Max
program.A document in Max is referred to as a patcher or, simply, a patch. A patch is a blank
canvas on which programmers to put objects. When launching Max, you are greeted with a
Welcome Screen, but for now, close this window leaving only the Max window behind it open.
From within the Max application, click the menu item marked File at the top of the screen and
select New Patcher or use the key command  +n (Mac) or ctrl+n (Windows).1 To create a new
object, press the n key. When you do so, a small rectangle appears on the screen allowing you to
type in the name of an object in the Max language. You can also add an object by clicking the
Object icon located at the top left of the patch window.It’s time to learn our first object called
button. Note that the object names are case-sensitive.1. Create a new object box by pressing
the n key on your computer keyboard2. Type the word button in the new object box3. Hit the
enter/return keyFIGURE 1.1an inlet atop a button (left) alongside an outlet under a button
(right)If you’ve accidentally clicked away from the new object box without typing in the word
button, you can double click the object box to allow text to be entered once again. Once the
word button has been entered, the button object appears on the screen as a small circle.The top
of the button object has one inlet for receiving data. If you hold your mouse over the inlet on top
of the button object, a red circle appears around the inlet as well as a message window giving
you some description about the data that the inlet can receive. Now, hold your mouse over the
outlet on the bottom of the object. A button sends out a message called a bang from its outlet.If
you are having trouble viewing the inlet, you can Zoom In and Zoom Out on a patch by clicking
View from the top menu, or by using the key commands  += (Mac) or ctrl+= (Windows) and  +-
(Mac) or ctrl+- (Windows).A bang is an event in Max that triggers an object to perform some
task. The only task the button object performs is to send and receive bangs. The button is such a
common object in Max that it has its own key command shortcut, the b key, for putting the object
in your patch.4. Add 5 more buttons to your patch by pressing the b key or by highlighting an
existing button and copying and pasting it. Copying and pasting is accomplished in Max by
going to the Edit menu or by using the key commands  +c (Mac) or ctrl+c (Windows) and  +v
(Mac) or ctrl+v (Windows). You can also copy an object by holding the alt/option key and
dragging an objectTo move buttons to different locations in your patch, simply click the center of



the object and drag it to the desired location. You can also resize the button by holding your
mouse over the bottom right of the object until your mouse shows two arrows at an angle and
dragging while holding the mouse button down.FIGURE 1.2a group of buttons |
button_tree.maxpatWe’ve been working in what Max calls the Patching Mode or Patching View.
In Patching Mode, you can create new objects, move them around, resize them, and connect
them to each other. By going to the View menu at the top of the screen and unchecking the item
marked Edit, the patch will become Locked; that is, the patcher will function as a program and
cannot be edited in any way until the patch is unlocked again. You can lock and unlock a patch
by clicking the small Lock icon at the bottom of the patcher window or by using the key
command  +e (Mac) or ctrl+e (Windows). You can also  +click (Mac) or ctrl+click (Windows) on
any blank space in the patch to toggle lock modes.5. With your patcher locked, click on the
button objects you’ve madeNotice that they blink when clicked. This is a graphical display of a
bang message being sent or received from the button object. Unlock the patch and you can
once again make edits in Patching Mode.Now let’s send data from one button to another via
patch cords. A patch cord will be created when you click on the outlet of an object. The cord will
travel wherever your mouse does and will not disappear until you click on the inlet of another
object or press the esc key.Unlock your patch and6. Click on the outlet of one of your top level
buttons and move your mouse to the inlet of another button beneath it until a red circle appears
above the second buttonPatch cords can connect from object outlets to inlets and the other way
around, though it is advised that you begin by connecting outlets only to inlets. Once again, keep
in mind that if you click on an object’s outlet, the patch cord will follow your mouse until you
connect it to another object’s inlet or press the esc key.FIGURE 1.3a button tree |
button_tree.maxpat7. When your mouse pointer hovers over the inlet of the second button, click
your mouse and the two objects will be connectedIn this book, when we reference connecting
one object’s outlet to another object’s inlet, this is the process. Please note that Max 7 will
display a more curved patch cable than in previous versions of Max. This can be changed via
the Preferences menu item beneath the top menu Max (Mac), or Options (Windows).8. Lock
your patch and click on the top button in your button treeThe bang flows from the top button and
triggers a bang to all of the connected buttons. If you click on a button beneath the top one, the
top button does not turn yellow because it did not receive any data to its inlet. This illustrates the
dataflow within Max. To save this patch, click File>Save from the top menu or use the key
command  +s (Mac) or ctrl+s (Windows). When asked for a file-name, name the file
“button_tree.” Notice that the Max file name extension “.maxpat” is given to your file. After you
have saved the patch, close it.Look at the following illustration and try to determine what will
happen when you click on one of the buttons:When you click a button, a bang will flow from one
button to another without any way to stop the data. The bang will continue to flow forever without
any way of ever stopping. This causes an error called stack overflow. It’s a concept similar to the
way that feedback is heard when a microphone is too close to a public address speaker. Make
sure that objects are not feeding data back into themselves. Errors like this one will cause an



error message to appear at the top of the patch describing the problem and listing the culprit
object. Clicking the error message will highlight the problem object in the patch. The error
message may be cleared by clicking the small “x” on the right of the message. In some cases,
you may be instructed to go to the Edit menu and click Resume.FIGURE 1.4a button loopThe
Max WindowCreate a new patcher, and1. Create a new object called printThe print object is
used to display some information in what is called the Max Console, or the Max window. Open
the Max Console by choosing Window>Max Console from the top menu or by using the key
command  +m (Mac) or ctrl+m (Windows). Important messages, like errors, for instance, will
appear in the Max Console. If an error occurs somewhere in your patch, you can locate where
the error occurred by double clicking on the error message (highlighted) in the Max window. This
will cause the troublesome object or objects to become temporarily highlighted.2. Create a
button object3. Connect the outlet of the button to the inlet of the print object4. Lock the patch
and click the buttonYou will notice that the message “bang” appears in the Max Console. The
print object will print to the Max Console any message you send it. Since a button sends out a
bang message, the print object will print the message “bang.” Unlock your patch and5. Create a
new object called messageA message object, also called a message box, allows you to enter a
message as text by typing into it. The message you type can contain just about anything: words,
numbers, words and numbers. Unlike number objects whose values are temporarily visible in the
object but disappear when the patch is closed and reopened later, message boxes will retain the
messages entered in them. Objects will receive the data in messages and interpret it in some
way. The message is such a common object in Max that it has its own key command shortcut,
the m key, for putting the object in your patch.Be careful that you do not accidentally use a
message box in place of an object box and vice versa. Take a moment to notice the visual
difference between the message objects and new objects.6. Enter the text Hello World into the
message boxIf you’ve already clicked away from the message box, double click the object to
allow text to be entered once again.7. Connect the outlet of the message box to the inlet of the
print object8. Lock the patch and click the message boxFIGURE 1.5a print object receiving data
from a message box | hello_world.maxpatWhen the message box is clicked, the message Hello
World will appear in the Max window. You can bring the Max window to the front of the screen by
double clicking on the print object.Help PatchersIf you want help seeing how an object works,
you can open up the Help file for each object in an unlocked patch by ctrl+clicking2 (Mac) or
right clicking (Windows) on the object and selecting Open Help from the contextual menu. You
may also open Help by holding the alt/option key down and clicking on an object in an unlocked
patcher. Unlock the patch and9. Open the Help file for the print objectIn the Help file for an
object, a description of the object is given along with fully working examples of how the object
may function within a patch.The interesting thing about Max Help files is that they too can be
unlocked and edited just like patches.10. Unlock the print Help file11. Highlight all of the objects
in the Help patch and copy them using the commands  +c (Mac) or ctrl+c (Windows)You can
construct entire Max patches by copying working code from the Help files. To find out more



information about an object including all of the available messages you can send to it, click on
the Open Reference link within the top right corner of an object’s Help file.On the top menu of
each Help file is a menu item labeled “?”. This menu shows objects that are somehow related to
the object whose Help file you are currently reading. If you select one of these objects from the
menu, its Help file will open up. Looking through these related objects is a great way to learn the
Max language fast. Also, if you are trying to find an object that operates similarly, but not exactly
the same, to an object you know, you may find that object via this menu. You can also create a
new object and type in the desired function you’re looking for as if the new object box were a
search engine!An additional option in Max is to enable Help in Locked Patchers. This allows you
to open the Help file for an object in a locked patch by holding the alt/option key down and
clicking on an object. To enable Help in Locked Patchers, go to the Options menu item at the top
of the screen. In this book, we will not open Help in any locked patchers, so there is no need to
enable it, though you may find it useful for your personal projects.12. Close the Help file for
print13. Paste the contents copied from the print Help file into your patch using the commands 
+v (Mac) or ctrl+v (Windows)ArgumentsIn your patch, notice that some of the print objects in the
Help file contents you just copied contain extra words to the right of the “print” object name.
These are called arguments. Arguments are used to set or change variables for an object and
are related to the types of data and messages the object deals with. In most cases, specifying
an argument replaces some default value, if the object had one, with a new one. In the case of
the print object, an argument will replace the default word “print” in the Max Console.14. Change
or add the print argument to a single word of your choosing15. Lock the patch and click the
message box16. Open the Max window to reveal that the word you chose has replaced the word
“print”Look at Figure 1.6 and try to determine what will happen when you click on the message
box:FIGURE 1.6a print object with an argument | hello_world2.maxpatThe supplied argument is
two words: this and argument. However, the print object only takes one argument so the second
argument, argument, is dropped. The message in the Max window readsObject: this
Message: Hello WorldSeparating Items in a MessageNow, unlock your patch and17. Double
click the message box containing the text Hello World and put a comma after the word
HelloFIGURE 1.7printing a list to the Max Window | hello_world3.maxpatThe comma is used to
separate items in a message box. The message box now contains two separate items. Each
item in the message will be printed to the Max window on a separate line.18. Lock your patch
and click the same message boxTake a moment to save your patch as hello_world.maxpat.
Close the patch.Numbers: Integers and Floating PointsCreate a new patcher, and1. Create new
object called numberThe number object, also called a number box, is such a common object in
Max that it has its own key command shortcut, the i key, for putting the object in your patch.
Think of the i as short for integer as opposed to the other type of number box we’ll deal with in
Max: the floating-point numbers; numbers with a decimal point.A number object simply holds a
number.2. Lock your patch, and click on the number objectNow, type the number 34 into that
object. The number 34 will stay in that number box until you change it or close the patch. When



the patch is closed, the number box will return to its default value of 0.3. Click on the number in
the number box and drag the number up or down to increase or decrease the value. You may
also use the arrow keys to increase or decrease the value once you have clicked in the number
boxUnlock your patch and4. Create 3 new message boxes containing the values 44, 55, and
42.85, respectively5. Connect the outlet of each message box to the inlet of the number box6.
Lock your patch and click each message boxFIGURE 1.8connecting message boxes to number
boxes | number_boxes.maxpatNotice that the value of the number box changes for each value
you send to it by clicking a message box. Note that when you send the number box the floating
point value 42.85, it drops the decimal point values completely. The number object only takes
the integer part of a floating point number. It does not round the number up or down; it simply
truncates it.Unlock your patch and7. Create a new object called a flonumA flonum object is a
floating-point number box. Floating-point number boxes can be used to show more precise
numbers than integer numbers. Is the singer singing exactly at A 440 or is she singing at A
440.91? A flonum will represent this value more accurately than a number box since, unlike the
number box, it can contain the numbers after the decimal point. The flonum object, sometimes
called a float, is such a common object in Max that it has its own key command shortcut, the f
key, for putting the object in your patch.8. Create 3 new message boxes with the values 55.72,
44.35, and 55, respectively9. Connect the outlet of each message box to the first inlet of the
flonum box10. Lock your patch and click on each message boxThe first two message boxes
send the floating-point number to the flonum object. If you send a floating-point number with
more than two decimal places, you will need to resize the flonum object to see these places by
clicking on the button right corner of the object and dragging to the right. The third message box,
55, is still received by the flonum even though it is not a floating-point number.FIGURE
1.9connecting message boxes to flonum boxes | number_boxes.maxpatAligningYou may have
noticed that the patch cords in the chapter examples may look more segmented than yours. With
Segmented Patch Cords selected from the Options menu, you are able to click at multiple points
along the path between objects controlling the shape of the cable. You can also align patch
cords by highlighting them (ctrl+clicking [Mac] or right clicking [Windows]) it after they’re
connected to some objects and selecting Align, or by using the key command  +y (Mac) or ctrl
+shift+a (Windows).You can also align highlighted objects using the same key command.3 You
can highlight multiple objects, either by holding the shift key and clicking the desired objects, or
by drawing a marquee rectangle around them with the mouse. To highlight patch cords while you
are drawing a marquee, hold the alt/option key. The Arrange menu also provides the option to
snap objects in place according to a grid or even to snap objects in place relative to each
other.CommentingIt is a good idea to make comments within a patch while you are writing it. As
patches become larger, they can become difficult to read, and if you haven’t opened the patch
up in a while, it is easy to forget what you did and how certain parts of it function.11. Create a
new object called commentThe comment object, also called a comment box, allows you to type
directly into your patch and document it. The comment object is such a common object in Max



that it has its own key command shortcut, the c key, for putting the object in your patch.12.
Create 2 new objects called comment containing the text integers and floating point numbers,
respectively13. Label the number objects as integers and the flonum objects as floating-point
numbers by moving the comments near these objectsFIGURE 1.10commenting your patch |
number_boxes.maxpatIn general practice, it is important to be descriptive when documenting
your patch.14. Create a third comment object, which we will use for the title, and enter the text
ints and floatsFIGURE 1.11the arrow icon over a comment objectInspectorIt would be nice to
see our title comment “ints and floats” in a somewhat larger font. To change properties about this
or any object, go to the Inspector by Ctrl+clicking (Mac) or right clicking (Windows) an object
and selecting Inspector from the contextual menu while the patch is unlocked. With an object
highlighted, you can also use the key command  +i (Mac) or ctrl+i (Windows), or click the
Inspector icon located on the right side of the patch window. Another method of getting to the
Inspector is to hold your mouse in the middle of the left side of the object, click the arrow icon
that appears, and choose the Inspector label.15. Open the Inspector for the comment box
containing the title “ints and floats”From the Inspector menu, you can select tabs for which to
edit the object’s properties. The tab All is selected by default and contains all of the property
options of the other tabs. Please note: in other Max menus similar to this one, the Basic tab is
shown by default, so switch to the All tab if necessary.FIGURE 1.12changing an object’s
properties through the Inspector | number_boxes.maxpat16. In the Inspector, scroll down to the
line marked Font Size and increase the font to 30 by double clicking the default number and
typing in the number 30Take a moment to save your patch as number_boxes. Close the
patch.Key Commands:• New Patcher:  +n (Mac) or ctrl+n (Windows)• Save Patcher:  +s (Mac)
or ctrl+s (Windows)• Zoom In:  += (Mac) or ctrl+= (Windows)• Zoom Out:  +- (Mac) or ctrl+-
(Windows)• Copy:  +c (Mac) or ctrl+c (Windows)• Paste:  +v (Mac) or ctrl+v (Windows)• New
Object Box: n• Button object: b• Toggle Lock & Edit Modes:  +e (Mac) or ctrl+e (Windows)•
Message object: m• Max window:  +m (Mac) or ctrl+m (Windows)• Help: alt/option then click an
object• Number (integer) object: i• Flonum (floating-point number) object: f• Align:  +y (Mac) or
ctrl+shift+a (Windows)• Comment: c• Inspector:  +i (Mac) or ctrl+e (Windows) with the object
highlightedNew Objects Learned:• button• print• message• number• flonum•
commentRemember:• A document in Max is referred to as a patcher or a patch.• You can copy
an object by holding the alt/option key and dragging an object.• You can resize an object by
holding your mouse over the bottom right of the object until your mouse shows two arrows at an
angle, and dragging while holding the mouse button down.• Segmented Patch Cords is an
option that causes a patch cord to be created when you click on the outlet of an object.• With
Segmented Patch Cords selected, if you click on an object’s outlet, the patch cord will follow
your mouse until you connect it to another object’s inlet or press the esc key.• Patch cords
always connect from outlets to inlets and never the other way around.• The file-name extension
“.maxpat” is given to all Max patches.• To avoid a Stack Overflow, make sure objects are not
feeding data back into themselves.• The Max window shows important messages and useful



debugging information in case of errors.• Open Help by holding the alt/option key down and
clicking on an object.• To find out more information about an object, click on the Open Reference
link within the object’s Help file.• Arguments are parameters that can be set for an object that
relate somehow to the types of data that object handles.• The number box truncates decimal
point values completely. It does not round numbers up or down at all.• It is important to be as
descriptive as possible when commenting your patch.• To change properties about an object, go
to the Inspector.Additional Tutorials:Tutorials are available from within the Max application by
clicking Help from the top menu and selecting Reference.Under the Max heading, click and
read• The Basic Activities of Making Patches• Tips and ShortcutsSelect Max Tutorials and read•
Hello—Creating objects and connections• Bang!—The bang message• Numbers and Lists—
Types of data in MaxOn Your Own:• Read the Help file for each of the new objects introduced in
this chapter.• Write a patch that allows a user to click on a single button to send 3 different
message boxes with numerical values (integer or floating-point) to 3 separate objects: the print
object, the number box, and the flonum box. Specify an argument for the print object. Comment
the patch with a title in size 30 font. Use your knowledge of key commands to speed up the
process.1 Throughout this book, key commands are noted for both Mac and Windows by using,
for example, the following syntax:  +n (Mac) or ctrl+n (Windows), which indicates that a user
should press the command key  plus the n key on Mac, or the control key ctrl plus the n key on
Windows. Though a plus sign (+) is indicated, it is not an additional key to be held during these
functions unless specifically noted.2 Mac users will have to use ctrl+click if right clicking has not
been enabled in System Preferences or if their mouse or touchpad does not support right
clicking capabilities.3 This option is best used for objects positioned along the same plane.
Highlighting everything in the patch and clicking align could make a mess.2Generating MusicIn
this chapter, we will create a program that randomly generates pitches at a specified tempo. The
program will have the ability to change a number of musical variables including timbre, velocity,
and tempo. We will also write a program that allows your MIDI keyboard to function as a
synthesizer. These two programs will be the basis of future projects related to composition and
performance.Going forward in this book, since you’ve already learned a number of objects in the
previous chapter, let’s agree that when you’re asked to create an object that you already know,
like button, for example, it will be sufficient for me to say “create a button” instead of repeating
the process of creating a new object box and typing in the word button. Combining steps in this
way will help us to get through the instructions with greater speed while reinforcing your
understanding of how certain objects work. In this way, the instruction, for example, “create a
message box containing the numbers 41 and 38” actually combines several smaller, and
hopefully intuitive, instructions into a single step. I will slowly stop mentioning key commands
and other shortcuts for objects and tasks that I’ve already introduced.The RAT PatchCreate a
new patch and1. Create a new object (press n) called randomThe random object takes a
number as its only argument and randomly generates a number between 0 and one less than
the argument when it receives a bang in its inlet.2. Give this random object the argument 128



(Note: if you already clicked away from the object, double click it in order to, once again, enable
typing within the object box)Be sure to put a space between the word random and the argument
128 or else Max will look for an object called random 128 that does not exist.3. Create a new
button (press b)4. Connect the outlet of button to the first inlet of random 1285. Create a number
box (press i)6. Connect the outlet of random 128 to the inlet of the number boxFIGURE
2.1outputs random numbers from 0 to 127 when a bang is received | the _RAT_patch.maxpatDo
you remember that kid that you went to grammar school with who asked you to count to 10 and
when you started counting “1, 2, 3 . . .” he stopped you and laughed as he declared “No! You
forgot the number zero!!!” I’m sure you remember that kid, or maybe you were that kid. Well, in
Max, we almost always start counting at the number 0, not the number 1. With the argument
128, the random object will randomly output a total of 128 possible numbers starting at 0, which
means that the range of numbers being randomly generated from random will be between 0 and
127.7. Lock your patch and click the button to see random numbers between 0 and 127MIDI
(Musical Instrument Digital Interface)The MIDI protocol is a language that computers use to
convey musical messages. Synthesizers as well as nearly all computer music software
applications deal with MIDI in some way. What are these MIDI messages?In essence, MIDI is a
bunch of messages in which a total of 128 numbers, the numbers 0–127, are used to represent
musical elements like pitch and velocity. The lowest MIDI note, 0, is the pitch C at 5 octaves
below middle C. The number 1 is the C /D directly above that C, and so on. The MIDI note 12 is
the C above the lowest C.Velocity is a measure of MIDI volume represented by the same
number numbers 0–127. The value 0 means that the note is off whereas the value 127 is the
loudest volume that MIDI can produce. Therefore, the note 60 with a velocity of 127 could be
described as middle C at a very loud volume.FIGURE 2.2MIDI Note C as it relates to the grand
staffSynthesizing MIDI NumbersWith the objects described earlier, we are able to generate
random numbers, which is not a very musical task. However, since MIDI uses numbers to
represent pitches, there’s no reason we can’t use those random numbers as pitches. We would
then hear each random number as a random pitch. To accomplish this, we need to format those
pitches into a MIDI message that includes some information about the velocity of the random
pitch and how long the note will sound. An easy way to do this formatting is with the makenote
object. The makenote object takes two numbers as arguments to specify a default velocity (first
argument) and default duration (second argument) which will be associated with the random
pitch value. The duration value is how long, in milliseconds, the note will last until makenote
sends out a velocity 0 value to turn the note off. Unlock your patch and8. Create a new object
called makenote with the arguments 100 and 5009. Connect the first outlet of the number box to
the first inlet of makenote 100 50010. Create 2 number boxes11. Connect each outlet of
makenote 100 500 to the inlet of the 2 newly created number boxes, respectively12. Lock your
patch and click the buttonYou’ve likely noticed that although we see the numbers change, there
is no sound. Remember, we’ve only now organized a bunch of messages; we haven’t included
an object to allow us to hear the note through our computer’s sound-card. With the objects we’ve



assembled this far, clicking on the button will generate a random number between 0 and 127,
the full range of MIDI pitches. The random number will be treated as the pitch in a MIDI message
and partnered with a default velocity value, which we have supplied as 100. The note will last for
500 milliseconds, after which the makenote object will output a velocity value of 0 for that pitch
turning the note off.FIGURE 2.3formats a MIDI message using the random number as pitch. |
the_RAT_patch.maxpatLook at the number box connected to makenote’s last outlet as you click
the button. It outputs the velocity value of 100 for half a second and then sends the “note off”
message: velocity 0. The makenote object keeps track of what numbers it receives and ensures
that all notes are given a “note off”/velocity 0 message after the duration value, in this case, 500
milliseconds.Now, let’s actually hear what this sounds like by adding the object noteout so that
makenote can communicate with our soundcard.If you unlock your patch and hold your mouse
over the two outlets of the makenote object, you will see that it sends MIDI pitch numbers out of
the left outlet and MIDI velocity numbers out of the right outlet. The noteout object takes pitch
numbers in its leftmost inlet and velocity numbers in its middle inlet. With your patch unlocked13.
Create a new object called noteout14. Connect the outlets of makenote 100 500 to the first 2
inlets of noteoutThe noteout object takes a number in its third inlet to specify the MIDI channel
number. You can also specify a default argument for the MIDI channel by supplying a number in
the object box after the word noteout. For now, we’ll use the object’s default MIDI channel,
channel 1.15. Lock your patch and click the button to generate a random number, which will be
synthesized as a MIDI pitch with a velocity of 100 and a duration of 500 millisecondsSince the
duration of each note lasts one half of a second, it would be nice to have the patch automatically
generate a new random note each half a second.FIGURE 2.4sends a random number out |
the_RAT_patch .maxpatAdding TimingThe metro object functions like a metronome sending out
bangs at a specified interval of time. The time, in milliseconds, is specified as an argument for
metro. In the same patch, unlock your patch and16. Create a new object called metro and give it
the argument 50017. Create a button18. Connect the outlet of metro 500 to the inlet of the
buttonWhen the metro object is “on,” it will cause the button to blink (send bangs) every 500
milliseconds. To turn the metro on, we will use the toggle object.The toggle object is an on/off
switch for Max objects. Like a light switch, toggle has two states: on or off. The toggle is such a
common object in Max that it has its own key command shortcut for putting the object in your
patch by pressing the t key.19. Create a new object called toggle20. Connect the outlet of the
toggle to the first inlet of metro 500FIGURE 2.5sends a random number out |
the_RAT_patch.maxpat21. Lock the patch and click on the toggle to turn it onAn X means the
toggle is on and that the metro object will begin sending out bang messages to the button every
500 milliseconds.22. Click on the toggle again to turn it offThe toggle actually only outputs the
numbers 0 and 1 where a 0 indicates that something is off and 1 indicates that something is on.
We could have also sent the metro object a message box containing a 1 to turn it on, and
another message box with a 0 in it to turn it off, but toggle provides a more graphical way of
doing it.Since our metro 500 is outputting bangs, it seems we have an extra button in our patch.



Unlock your patch and23. Delete the button connected to metro 500’s outlet by highlighting the
button and pressing delete24. Connect the outlet of metro 500 to the inlet of the button above
the random 128 objectWith the toggle turned on, the metro will trigger a random number to
become synthesized every 500 milliseconds.25. Lock the patch and click on the toggle to turn it
on26. Click on the toggle again to turn it offThis patch creates what my students and I
affectionately call Random Atonal Trash or the RAT patch.FIGURE 2.6creates random atonal
trash | the_RAT_patch .maxpatNow that we’ve made our first RAT patch, we will discuss some
of the ways that you can control this patch. Currently, the patch has only one control: the toggle
to turn the patch on and off, which generates random pitches. However, there are many
variables within the patch that could conceivably have controls. For instance, if you want to
change the speed of the metro, you can send a number, either as a message box or a number
box, to metro’s right inlet to replace metro’s default argument of 500. Unlock your patch and27.
Create a number box to the upper right of metro 50028. Connect the first outlet of the number
box to metro 500’s second inletIf you change the number inside the newly created number box
by clicking in it (locked) and typing a new number,1 the number of milliseconds metro will wait
until it sends out another bang will change from being every 500 milliseconds to whatever
number you specify. This is how you replace arguments for objects. Arguments don’t change
visually within objects just internally, so even though the 500 remains in the object box, metro’s
argument will change to whatever you enter in the number box. Since we’ve “hard-coded” the
number 500 as metro’s default argument, when you open the patch, the metro object’s default
time interval will be 500 milliseconds and, thus, will send out bangs every 500 milliseconds until
a new number is supplied to metro’s second inlet.Since metro’s speed and makenote’s duration
are both 500 milliseconds, it makes sense that if we change the argument for one, we should
change it for the other or else we’d have either overlapping or staccato notes. If you hold your
mouse over makenote’s third inlet, you will see that it receives a duration value.29. Create a new
number box near makenote 100 50030. Connect the first outlet of this number box to the last
inlet of makenote 100 500If you specify the same argument for both the metro and the
makenote, you will ensure that generated notes are legato and not staccato or
overlapping.FIGURE 2.7control your RAT patch by changing the default arguments |
the_RAT_patch.maxpat31. Lock the patch and click on the toggle to turn it on32. Change the
arguments for metro and makenote by clicking in the newly created number boxes33. Turn the
toggle offThis patch functions fine as it is, but what would really be useful for those who will use
this patch (your users) would be some sort of graphical object that allows you to control numbers
more easily than the number boxes alone. One such object is the slider object. Unlock your
patch and34. Create a new object called sliderWhen you create a new object call slider, the
object turns into a vertical control resembling a fader on a mixing board. By default, slider
outputs the numbers 0–127 depending on where the horizontal knob in the slider is positioned. If
you connect the slider to the two number boxes that control metro speed and make-note
duration, you can control both numbers simultaneously with one control.35. Connect the outlet



of slider to the inlet of the number boxes connected to the last inlet of metro and makenote36.
Lock the patch on click on the toggle to turn it onFIGURE 2.8control your RAT patch with UI
objects like slider | the_RAT_patch.maxpatAlgorithmic CompositionThe term algorithmic
composition is used to describe music that is composed by using some sort of process. It
commonly refers to music composed with the use of computer algorithms or processes.
However, algorithmic composition is as old as composition itself.One of the earliest examples is
found in Guido D’Arezzo’s treatise on medieval music Micrologus, written around 1026. Guido
notated a scale on the staff and wrote a different vowel beneath each pitch. Then, using some
Latin text, he matched the vowel sound of each syllable in the text to the pitch in his scale that
used the similar-sounding vowel. In effect, the word alleluia might be used to yield the pitches C
for syllable a, D for syllable e (from “lle”), G for syllable u (from “lu”), and A for syllable a (from
“ia”). Imagine creating a similar compositional activity by using the patch you just made as a tool
where, instead of using the vowels a, e, i, o, and u, you used the numbers 1 through 8.FIGURE
AGuido D’Arezzo-style algorithmic compositionAnother type of algorithmic technique, often
credited to Mozart, was used to compose a minuet by reordering precomposed measures of
music through controlled chance. In one such technique, a number of 2-bar “opening” phrases
were composed along with an equal number of 2-bar “closing” phrases that end in some form of
cadence. Each opening and closing phrase was given a letter as an identifier and placed in 1 of
2 hats. As guests entered the party, each drew a slip of paper with a one-letter identifier written
on it from 1 of 2 hats that referred to one of the opening or closing phrases. The order of the
letters, then, indicated the order in which the phrases should be played. When all the guests had
arrived, a musician would then perform the new piece composed algorithmically through
recombination of the precomposed phrases. Mozart’s so-called Musikalisches Würfelspiel (K.
516f), or “music dice game,” used a similar controlled-randomness approach by rolling dice.This
technique of recombinance is similar to the Experiments in Musical Intelligence (EMI) described
by David Cope (1991; 1996; 2000) in which new compositions were created in the style of
composers such as J. S. Bach, Chopin, and Beethoven through an algorithmic process data-
driven by the works of these composers.In Interactive Music Systems, Robert Rowe (1993)
describes 3 methods of algorithmic composition:Generative methods use sets of rules to
produce complete musical output from the stored fundamental material.Sequenced techniques
use prerecorded music fragments in response to some real-time input. Some aspects of these
fragments may be varied in performance, such as tempo playback, dynamic shape, slight
rhythmic variations, etc.Transformative methods take some existing musical material and apply
transformation to it to produce variants. According to the technique, these variants may or may
not be recognizable related to the original. For transformative algorithms, the source material is
complete musical input.All compositions are generally in some nature algorithmic even if they do
not use a computer; a computer, however, can help to make the composition process much
more efficient. Estonian composer Arvo Pärt’s Cantus in Memoriam Benjamin Britten (1977) is a
prolation canon in which each instrument plays the descending notes of the a minor scale at



different harmonic speeds. In this composition, once the composer decided on this process, the
nature of composing the piece on staff paper was largely a matter of adhering to the process
and putting the notes into the right place. Of course, there are numerous musical judgments that
the composer also made in addition to carrying out the process. The point of this illustration is
that when the composer decided on a process, he had at least two choices: do it by hand, which
he did, or, if he had known a programming language, use a computer to carry out the task. The
latter would have been much more efficient and would have yielded the same piece.Though you
may not be interested in composing in the style of Pärt or Cope, we can certainly gather the
notion that technology-assisted composition can make traditional compositional processes
more efficient. Technology, and Max in particular, can also be used to develop compositional
processes that are both anchored in tradition and radically new.In future chapters, we will
continue to look at the ways that Max can be used to allow individuals to compose and perform
music, as well as the many ways that Max can help educators to teach composition and
theory.37. Click on the slider and increase or decrease the horizontal knob to send the numbers
0–127 to the argument inlets of metro and makenote38. Turn the toggle offAs I mentioned, by
default, slider outputs numbers from 0 to 127. To increase or decrease the range of numbers
slider outputs, open up slider’s Inspector menu. Note that the “output minimum” will offset the
starting number. For example, if your slider range is 200 and your minimum number is 50, the
slider will output the numbers 50–249, a range of 200 numbers. Unlock your patch and39. Open
the Inspector for slider and change the range of this slider to 1000 and leave its output minimum
at the default value 0You may feel that the notes come out too fast when the slider value is set
too low. In fact, on some slower computers, if the metro object tries to send out bangs at a rate
faster than around 20 milliseconds, it isn’t always stable. There is a way to help the latter with
something called Overdrive which we’ll discuss in Chapter 10. To address the former concern,
we can specify a minimum value for slider to output.40. In the Inspector for slider, set the output
minimum to 20Because we want to make our patches foolproof, it’s a good idea to put in default
arguments and limits to restrict the range of numbers to known or desired values. To do this,41.
Open the Inspector for the number box connected to metro’s last inlet and set the minimum
value to 2042. Do the same as the previous step for the number box connected to makenote’s
last inletSave this patch as a “the_RAT_patch.maxpat.” Before you close the RAT patch,
highlight and copy the makenote and noteout objects, as we’ll paste them into a new patch. This
brings up a good technique: reuse working parts of patches whenever possible.Slider
PatchClose the old patch and create a new patch.1. Paste makenote 100 500 and noteout into
the new patch or simply create these 2 objects2. Connect the 2 outlets of makenote 100 500 to
the first 2 inlets of noteout3. Create a new object called slider4. Connect the outlet of slider
directly to makenote 100 500’s left inlet5. Lock the patch and increase or decrease the slider
positionIn this patch, the numbers 0–127 flow directly from slider to makenote to note-out
without the need for any number boxes. Though this may save a few seconds in the creation of a
new patch, it is good practice to use number boxes after every user interface (UI) object and



other objects where the actual numbers you are working with are unclear. If something in your
patch is not working right, it’s much easier to locate the problem if you can see where numbers
are, or are not, going. Save the patch as the_RAT_reused.maxpat and close the patch.FIGURE
2.9parts of the RAT patch reused | the_RAT_reused .maxpatRat Patch 2Re-open the RAT patch
you created earlier or, for good practice, rebuild the RAT patch from memory and select Save As
from the File menu at the top. Name the file the_RAT_patch_2.maxpat.As musicians, we are not
used to thinking about musical time in terms of milliseconds; the tempo object would be more
appropriate as it allows us to discuss time in beats per minute, multiples of the beat, and division
of the beat into notes (quarters, eighths, sixteenths, etc.). Unlock the patch and1. Delete the
slider from this patch2. Double click the metro 500 object and highlight and replace the metro
500 with the word tempo with the arguments 120 for initial tempo in beats per minute (BPM), 1
for beat multiplier, and 8 for beat division, in this case, the eighth note.Our new patch with the
tempo object functions similarly to the original RAT patch, but we now have the ability to work
with timing in terms of beat values, values that musicians are typically more accustomed to
working with. Currently, the tempo will send a bang on every eighth note at 120 beats per minute.
The number box that formerly controlled the metro time interval can now be used to control the
BPM value for tempo. We know, from our discussion of changing default arguments, that the 8
indicating eighth notes can be changed, so let’s give our patch the ability to beat whole, half,
quarter, eighth and sixteenth notes.FIGURE 2.10the RAT patch controlled in BPM instead of
milliseconds | the_RAT_patch_2.maxpat3. Create 5 message boxes (press m) containing the
number 1 for whole notes, 2 for half notes, 4 for quarter notes, 8 for eighth notes, and 16 for
sixteenth notes, respectively4. Connect the outlet of each of these 5 message boxes to the
fourth inlet of the tempo object (the inlet that corresponds to the beat division value)Other beat
division values are possible, but let’s start with these numbers.5. Lock the patch and turn the
tempo object on via the toggle6. Change the beat division of tempo by clicking the different
message boxes you created7. Turn off the toggleAlthough we know what will happen to the
tempo when you click the message 8, the average user of your patch may not understand how
to use the control. Let’s take a moment to make some more articulate controls to our patch.
Unlock your patch and8. Create 5 new message boxes containing the text Whole Note, Half
Note, Quarter Note, 8th Note, and 16th Note, respectivelyThe tempo object will not understand
these much more descriptive message boxes, so we will connect these message boxes to the
first inlet of the numerical message boxes you created earlier. When we do so, clicking on the
descriptive message box will send a bang to the numerical message box that tempo can
interpret.9. Connect the outlet of the message box containing the text Whole Note to the first
inlet of the message box containing the number 110. Connect the outlet of the message box
containing the text Half Note to the first inlet of the message box containing the number 211.
Connect the outlet of the message box containing the text Quarter Note to the first inlet of the
message box containing the number 412. Connect the outlet of the message box containing the
text Eighth Note to the first inlet of the message box containing the number 813. Connect the



outlet of the message box containing the text 16th Note to the first inlet of the message box
containing the number 1614. Lock the patch and turn the toggle on15. Change the beat division
of tempo by clicking the descriptive message boxes you created16. Turn off the toggleWe can
create an even more descriptive message box that triggers both a tempo change and a beat
division change by connecting its outlet to other message boxes containing the desired
arguments. Unlock your patch and17. Create a message box containing the text 8th Notes at
Largo18. Create 2 message boxes containing the text 50 and 8, respectively19. Connect the
outlet of the message 8th Notes at Largo to the first inlet of the message boxes 50 and 8,
respectively20. Connect the outlet of message 50 to the number box connected to tempo’s
second inlet21. Connect the outlet of message 8 to tempo’s last inlet1. Lock the patch and turn
the toggle on2. Click on the message 8th Notes at Largo to trigger the value 50 to be sent as an
argument for the tempo and 8 to be sent as an argument for the beat division3. Turn off the
toggleNote that instead of a descriptive message box, a single button could also have been
used to trigger the change of multiple values. In principle, the multiple message boxes are acting
like dominoes, hitting into each other in order to trigger the numerical message to the object.4.
Save and close this patchFIGURE 2.11message boxes trigger beat divisions of the tempo object
| the_RAT_patch_2.maxpatFIGURE 2.12message boxes trigger multiple argument changes to
tempo | the_RAT_patch_2.maxpatMIDI InputThe next section involves getting MIDI data into
Max using a MIDI controller of some kind. If you have a MIDI keyboard or other device, take this
time to connect it to your computer. You will need to close and restart Max if your device was not
connected or powered up when you opened Max.We know how to get MIDI data out of Max
using the noteout object. We can get MIDI data into Max using the notein object. Create a new
patch and1. Create a new object called notein2. Create 3 number boxes3. Connect each of the 3
outlets of notein to the inlet of each number box, respectively4. Create a new object called
noteout5. Connect the first outlet of each of the 3 number boxes to the 3 inlets of noteout,
respectivelyFIGURE 2.13basic MIDI device input | MIDI_IO.maxpatAs you play notes on your
MIDI device, you can see the numerical MIDI values for pitch, velocity, and MIDI channel
displayed in the 3 number boxes. On your MIDI device, play middle C softly. The first number box
will read 60 and the second number box will read some value between 0 and 127 depending on
how softly you played the note. Notice that when you take your hand off the keyboard, you send
out a velocity value of zero for whatever pitch(es) you were playing. These velocity zero
messages are commonly referred to as “note off” messages. Even if you play just one key on
your keyboard, there are multiple numbers that are expressed as part of the MIDI message for
that note.The notein and noteout objects communicate with your computer’s sound-card and
any available MIDI devices. When the patch is locked, you can double click on one of these
objects to see a list of all MIDI devices currently connected to your computer.MIDI data are sent
on streams called channels. This allows a user to send musical data-like pitches and velocity for
separate instruments through a single cable without all of the separate MIDI data being merged
into one instrument. Data on each MIDI channel can then be assigned to use different timbres



and can even be routed to other synthesizers.In MIDI, a program refers to the type of timbre
used in the synthesis of MIDI pitches and velocities. Before synthesizer manufacturers agreed
on certain standards, later known as General MIDI, there were inconsistencies among the ways
these manufacturers organized their MIDI programs. If your favorite piano sound was located at
program number 001 on one keyboard, that same program number on another keyboard might
be a trumpet sound.When the General MIDI (GM) specification was created, the 128 MIDI
programs were standardized so that synthesizer manufactures had the same timbres in the
same locations. For example, GM program 0 is always “acoustic grand piano” while program 127
is always “gunshot.”2To change the MIDI program value in Max, use the pgmout object. This
object allows you to send the numbers 0–127 to change the MIDI timbre.6. Create a new object
called slider7. Create a number box8. Connect the outlet of slider to the inlet of the number box9.
Create a new object called pgmout10. Connect the first outlet of the number box to the first inlet
of the pgmout objectThe pgmout object does not need to be connected to any further objects.
Like noteout, it communicates with your computer’s MIDI output devices.11. Lock the patch and
increase/decrease the slider to change the MIDI program while playing notes on your MIDI
keyboardFIGURE 2.14send MIDI program changes through pmout | MIDI_IO.maxpatAs you
know, the default slider range is 0–127 which works perfectly with the range of numbers that
pgmout can receive. You have now programmed a fully functional MIDI keyboard synthesizer
capable of changing timbre.Your MIDI keyboard sends other types of MIDI data besides pitch,
velocity, program, and channel. Your controller likely has two wheels on the left-hand side: one
marked modulation and one marked pitch bend. These wheels send data into Max using the
ctlin object and the bendin3 object.Let’s make an instrument in which pitch is controlled by the
modulation wheel and velocity is controlled by the pitch bend wheel. Unlock your patch and12.
Create a new object called ctlin13. Create a number box14. Connect the first outlet of ctlin to the
inlet of the number box15. Create a new object called bendin16. Create a number box17.
Connect the first outlet of bendin to the inlet of the number box18. Create a makenote object
with the arguments 100 and 30019. Connect the first outlet of the number box receiving from
ctlin to the first inlet of makenote 100 30020. Connect the first outlet of the number box receiving
from bendin to the second inlet of makenote 100 30021. Create a new object called noteout22.
Connect both outlets of makenote 100 300 to the first two inlets of noteoutFIGURE 2.15mapping
wheel data to pitch and velocity | MIDI_IO.maxpatYou will now be able to control notes and
velocity just by moving the two wheels. Give it a shot.Since this “wheel” synthesizer is going to
exist in the same patch as the functional keyboard synthesizer we made earlier, we should
specify its noteout object to exist on MIDI channel 2 by supplying the argument 2 to noteout. To
be consistent, let’s go back and supply an argument of 1 for our keyboard synthesizer. With your
patch unlocked23. Double click the noteout object receiving from the ctlin and bendin and type
the number 2 next to it24. Double click the noteout object receiving from the notein and type the
number 1 next to itNow that our MIDI data are operating on two different channels, we can
change aspects of the instrument, such as timbre, on one channel without changing the



other.25. Highlight the slider, number box, and pgmout entity and copy/paste it to the right of the
ctlin and bendin entity26. Double click the newly copied pgmout object on the right and type the
number 2 next to it27. Double click the pgmout object you made earlier (Step 9) and type the
number 1 next to itSpecifying MIDI channel arguments for the noteout and pgmout objects will
allow the “keyboard” synth and the “wheel” synth to use different MIDI programs simultaneously
without interfering with each other because they are on separate MIDI channels, 1 and 2.28.
Lock the patch and set both sliders to different values, then use the MIDI keyboard and mod
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enter a chord name and see the notes on a MIDI keyboard. We will “build” this patch as a
standalone program that can be used on any computer even if it does not have Max installed.•
Preparing the Application• Building the Application• Icons• Styles• Permission and Cross-
platform Building12 Introduction to Max for LiveDiscusses using Max for Live, the add-on for the
digital audio workstation Ableton Live that allows users to incorporate Max/MSP/Jitter into their
Ableton Live projects.• Overview• Crash Course in Ableton Live• Writing a MIDI Program13
Working with AudioDiscusses MSP, a collection of objects that work with audio signals. The
MSP objects can handle actual sound recordings, like audio from a microphone, as well
generate signals.• Basic Ins and Outs of Audio• Sine Waves• Timbre• Synthesizer• Synth
Building14 Audio Playback and Pitch TrackingLooks at some of the ways that you can play back
and record sound files. We will also look at some ways to track the pitch of analog audio and
convert it into MIDI numbers.• Playback• Pitch to MIDI Tracking• Pitch Tracking to MIDI
Harmonization• Preserve Pitch While Adjusting Tempo• Pitch Correction15 Audio
BuffersDiscusses how to record audio into a storage container called a buffer. By the end of this
chapter, you will be able to record a performance through your microphone and loop the
recording while you make sonic changes to it. You will also learn how to make a polyphonic
synthesizer that uses a single recording of your voice as the pitches.• All about Buffers•
Recording into a Buffer• Max for Live• Referencing Playback Speed to a MIDI Note16 Audio
Effects and ProcessingAddresses implementing audio effects into patches with live audio and
sound files.• Preparing the Patch• Delays• EQ• Other Effects17 Working with Live
VideoDiscusses Jitter, a set of objects that handle video and visual-related content in Max. By
the end of this chapter, you will have created a patch that changes the color of a live video when
pitches are played.• Matrix• Camera Input• Adjusting Color• Mapping MIDI Pitches to Color18



Working with Video FilesWorking with preexisting video files located within the Max search path.
By the end of this chapter, you will have created patches that detect presence in certain areas of
a video. We will also examine some aspects of tracking colors in video.• Video• Presence
Detection• Color Tracking• Preassembled Video Patches19 Research InstrumentsLooks at
various research instruments designed to measure stimulus and response, hearing, perception,
and more.• Stimulus Testing Instrument• Working with Paths• Populating a List of Files• Hearing•
Perception• Application20 Informal Music Learning InstrumentsLooks at a collection of
interactive systems used to facilitate music making with individuals who lack prior musicianship
skills.• Playing Diatonic Music with Ease• E001• E005• E003• E002• E006 and EAMIR Note•
FMT and Music Basics21 Interactive CompositionsExamines some ways to interact with audio
processing objects, and, in particular, compositions for live acoustic instruments and Max.•
Electroacoustic Music• Delayed to Rest: Composition for Electric Guitar and Computer•
Discourse: Composition for E Clarinet and Computer•
ConclusionReferencesContentsForeword by David ElliottPrefaceAcknowledgmentsAbout the
Companion Website1 Introduction to ProgrammingCovers the basic tools of operation and
navigation in Max as well as an introduction to the basic ways to work with data.• Introduction to
Max• The Max Window• Help Patchers• Arguments• Separating Items in a Message• Numbers:
Integers and Floating Points• Aligning• Commenting• Inspector2 Generating MusicIntroduces
elements of algorithmic composition. We will create a program that randomly generates pitches
at a specified tempo. The program will have the ability to change a number of musical variables
including timbre, velocity, and tempo. We will also write a program that allows your MIDI
keyboard to function as a synthesizer. These two programs will be the basis of future projects
related to composition and performance.• The RAT Patch• MIDI (Musical Instrument Digital
Interface)• Synthesizing MIDI Numbers• Adding Timing• Slider Patch• Rat Patch 2• MIDI Input3
Math and MusicDiscusses some of the math used in musical operations. We will examine the
math behind musical concepts like transposing music by some interval and adding chord tones
to a root note. We will also look at some of the things that will help make your program look
better and more accessible to users. We will create a program that harmonizes MIDI notes.•
Math in Max• Forming Intervals• Window Dressing• Creating Chords• Presentation Mode•
Further Customization• Comments4 Scales and ChordsDescribes how to build scales and
chords and play them back in a variety of ways. By the end of the chapter, you will write a
program that allows users to play diatonic chords in a specified key using just the number keys
on your computer keyboard.• Scale Maker• Chord Maker• Order of Operations• Setting Values5
Interactive Ear TrainingDescribes how to make an interactive ear-training program.• Ear Trainer•
Further Customization6 Data StructuresDescribes how to write a program that randomly
generates diatonic pitches at a specified tempo. We will learn how to filter chromatic notes to
those of a specific mode by using stored data about scales. By the end of this chapter, you will
have created a program that composes diatonic music with a simple rhythm. We will also learn
about adding objects in order to expand the Max language.• Adding External Objects• Tonality in



Max• Filtering Chromatic Notes to Diatonic Notes• Random Tonal Music• Abstractions and
Subpatchers• Working with Pitch Classes• Alternate Way• Tables7 Control InterfacesExamines
some premade patches demonstrating a few techniques for designing diatonic musical
instruments. We will review some of the basic ins and outs of MIDI, learn some ways to program
more efficiently, and discuss a number of control options for your patches.• bpatchers• MIDI Out
bpatcher• Saving Settings• Chords• Storing Presets8 Control Interfaces ContinuedExamines
some innovative ways to control music making as we develop musical instruments. We will use
your computer keyboard and mouse as performance instruments as well as discuss the use of
videogame controllers in your patches.• Arguments for Abstractions• Using the Mouse• Using
Videogame Controllers9 Tools for Music Theory ConceptsDescribes how to design some tools
to aid in the discussions of concepts related to music theory. In particular, we will discuss chord
progressions, scale analysis, chord analysis, mode relationships, harmonic direction of chords,
and harmonization. By the end of this chapter, you will have an arsenal of tools for explaining
theoretical concepts of music.• Chord Progressions• Scale Analysis• Mode Relationships•
Harmonic Direction• Harmonization10 Working with TimeDiscusses aspects of time, rhythm,
and the sequencing of events. You will learn to create interactive performance and compositions
systems as well as create patches that demonstrate rhythmic complexity. By the end of the
chapter, you will have created patches that can record and loop MIDI sequences as well as a
number of patches that work with notes over time.• Sequencing• Step Sequencers• The
Transport• Overdrive11 Building Standalone ApplicationsAnalyzes a “Chord Namer” application
that allows a user to enter a chord name and see the notes on a MIDI keyboard. We will “build”
this patch as a standalone program that can be used on any computer even if it does not have
Max installed.• Preparing the Application• Building the Application• Icons• Styles• Permission
and Cross-platform Building12 Introduction to Max for LiveDiscusses using Max for Live, the
add-on for the digital audio workstation Ableton Live that allows users to incorporate Max/MSP/
Jitter into their Ableton Live projects.• Overview• Crash Course in Ableton Live• Writing a MIDI
Program13 Working with AudioDiscusses MSP, a collection of objects that work with audio
signals. The MSP objects can handle actual sound recordings, like audio from a microphone, as
well generate signals.• Basic Ins and Outs of Audio• Sine Waves• Timbre• Synthesizer• Synth
Building14 Audio Playback and Pitch TrackingLooks at some of the ways that you can play back
and record sound files. We will also look at some ways to track the pitch of analog audio and
convert it into MIDI numbers.• Playback• Pitch to MIDI Tracking• Pitch Tracking to MIDI
Harmonization• Preserve Pitch While Adjusting Tempo• Pitch Correction15 Audio
BuffersDiscusses how to record audio into a storage container called a buffer. By the end of this
chapter, you will be able to record a performance through your microphone and loop the
recording while you make sonic changes to it. You will also learn how to make a polyphonic
synthesizer that uses a single recording of your voice as the pitches.• All about Buffers•
Recording into a Buffer• Max for Live• Referencing Playback Speed to a MIDI Note16 Audio
Effects and ProcessingAddresses implementing audio effects into patches with live audio and



sound files.• Preparing the Patch• Delays• EQ• Other Effects17 Working with Live
VideoDiscusses Jitter, a set of objects that handle video and visual-related content in Max. By
the end of this chapter, you will have created a patch that changes the color of a live video when
pitches are played.• Matrix• Camera Input• Adjusting Color• Mapping MIDI Pitches to Color18
Working with Video FilesWorking with preexisting video files located within the Max search path.
By the end of this chapter, you will have created patches that detect presence in certain areas of
a video. We will also examine some aspects of tracking colors in video.• Video• Presence
Detection• Color Tracking• Preassembled Video Patches19 Research InstrumentsLooks at
various research instruments designed to measure stimulus and response, hearing, perception,
and more.• Stimulus Testing Instrument• Working with Paths• Populating a List of Files• Hearing•
Perception• Application20 Informal Music Learning InstrumentsLooks at a collection of
interactive systems used to facilitate music making with individuals who lack prior musicianship
skills.• Playing Diatonic Music with Ease• E001• E005• E003• E002• E006 and EAMIR Note•
FMT and Music Basics21 Interactive CompositionsExamines some ways to interact with audio
processing objects, and, in particular, compositions for live acoustic instruments and Max.•
Electroacoustic Music• Delayed to Rest: Composition for Electric Guitar and Computer•
Discourse: Composition for E Clarinet and Computer• ConclusionReferencesForewordMax/
MSP/Jitter for Music—aptly subtitled A Practical Guide to Developing Interactive Music Systems
for Education and More—is a groundbreaking, step-by-step approach to empowering the
creativity of music educators and music students through interactive computer software
design.V.J. Manzo provides a brilliantly organized, detailed, and illustrated explanation of how to
create, customize, and individualize music software to support whatever music teachers and
students want to do: compose, perform, improvise, analyze, research, and/or enhance and
assess student’s development of musical concepts, aural skills, notational and theoretical
competencies, knowledge of multiple musical styles, and much, much more.Divided into a
careful sequence of twenty-one chapters, this practical guide begins with a clear introduction to
the nature and uses of Max/MSP/Jitter, or Max (for short). Max is distinctive among music
programming languages because it employs a user-friendly graphic interface that facilitates both
formal and informal music teaching and learning. Importantly, this book is not a dry handbook/
textbook; it includes a wealth of practical examples and tutorials, sometimes in easy-to-follow
“cookbook” format.Among the themes and strategies discussed and implemented in Max/ MSP/
Jitter for Music are discussions of generating music through algorithmic composition; the “math”
underlying musical concepts, theory, and harmony; and ways of building scales and chords in
“painless” ways for use in personalized creativity. Among many other highlights of the book is the
way Manzo explains how to create musical instruments with Max; build and visualize chords on
a MIDI keyboard; record and play back student performances and compositions; and use Jitter
to create and manage video content.V.J. writes in a very clear and personal style, which is based
not only his vast knowledge of music software and hardware, but on his many years of practical
experience as an extraordinary classroom teacher. Indeed, I have seen V.J. in action on



numerous occasions. He embodies all the attributes of the complete musician-educator: artistry,
creativity, savvy, intelligence, and highly informed action.David ElliottProfessor of Music and
Music EducationNew York UniversityForewordMax/MSP/Jitter for Music—aptly subtitled A
Practical Guide to Developing Interactive Music Systems for Education and More—is a
groundbreaking, step-by-step approach to empowering the creativity of music educators and
music students through interactive computer software design.V.J. Manzo provides a brilliantly
organized, detailed, and illustrated explanation of how to create, customize, and individualize
music software to support whatever music teachers and students want to do: compose, perform,
improvise, analyze, research, and/or enhance and assess student’s development of musical
concepts, aural skills, notational and theoretical competencies, knowledge of multiple musical
styles, and much, much more.Divided into a careful sequence of twenty-one chapters, this
practical guide begins with a clear introduction to the nature and uses of Max/MSP/Jitter, or Max
(for short). Max is distinctive among music programming languages because it employs a user-
friendly graphic interface that facilitates both formal and informal music teaching and learning.
Importantly, this book is not a dry handbook/textbook; it includes a wealth of practical examples
and tutorials, sometimes in easy-to-follow “cookbook” format.Among the themes and strategies
discussed and implemented in Max/ MSP/Jitter for Music are discussions of generating music
through algorithmic composition; the “math” underlying musical concepts, theory, and harmony;
and ways of building scales and chords in “painless” ways for use in personalized creativity.
Among many other highlights of the book is the way Manzo explains how to create musical
instruments with Max; build and visualize chords on a MIDI keyboard; record and play back
student performances and compositions; and use Jitter to create and manage video content.V.J.
writes in a very clear and personal style, which is based not only his vast knowledge of music
software and hardware, but on his many years of practical experience as an extraordinary
classroom teacher. Indeed, I have seen V.J. in action on numerous occasions. He embodies all
the attributes of the complete musician-educator: artistry, creativity, savvy, intelligence, and
highly informed action.David ElliottProfessor of Music and Music EducationNew York
UniversityPrefaceAn interactive music system is a hardware and/or software configuration that
allows an individual to accomplish a musical task, typically in real time, through some
interaction. Though commonly associated with composition and performance, the tasks
associated with interactive music systems can include analysis, instruction, assessment,
rehearsal, research, therapy, synthesis, and more. These systems typically have some set of
controls, hardware or software, such as switches, keys, buttons, and sensors by which musical
elements like harmony, rhythm, dynamics, and timbre can be manipulated in real time through
user interaction.In this book, we use the programming language Max/MSP/Jitter to write custom
software for musical interaction. We discuss the concepts needed to complete your project,
complete many projects in a step-by-step style guide, and look at examples of working systems.
Emphasis is placed on the pedagogical implications of software creation to accomplish these
tasks. Whether you want to create a program for composers that explores relationships between



two modes or an exercise for beginners that helps improve finger dexterity, you will soon learn
how writing customized software can supplement and complement your instructional objectives.
We also discuss ways to interact with the software beyond just the mouse and keyboard through
use of camera tracking, pitch tracking, videogame controllers, sensors, mobile devices, and
more.Why Design Custom Software?Today, there are software applications for just about
everything, but to what extent do we allow music software to dictate how we teach musical
concepts? After installation of a software application, it’s normal to look at the program and ask
“what does it do,” “how can I perform with this,” and “how can I make a demonstration or
instructional activity out of this for my class?” There’s certainly nothing wrong with this, but you
may already have some musical ideas in mind and are looking for a way to express them using
the efficiency and interactivity of technology. However, existing software may not be able to
address the particular concepts you want to address from the angle you prefer.Imagine teaching
harmony with the aid of a specialized program that showed common tones between the chords
and scales, or a program that used the first seven number keys to play the seven diatonic chords
of a key. Imagine composing a piece of music with a program that showed how chord functions
tend to resolve in a given key.Software developers typically design a program’s layout to be
accessible and intuitive, but in doing so, they are bound to show certain biases toward the
visibility of what are considered the more common features. In an instructional setting, if the
feature that is going to help the instructor explain concepts of rhythm or harmony is somewhat
buried in the program’s menus, he or she may be less inclined to teach those musical concepts
right away because there is too much requisite knowledge of the software involved just to get to
the desired menu. Instructors would have to teach a number of software concepts just to get to
the place where they could teach the musical concept they wanted to address in the first place.
It’s not the software company’s fault; after all, they don’t know what and how you teach. However,
it’s a common case of technology dictating the instruction instead of instruction dictating the use
of technology.This problem is not unique to technology. Even the conventions of traditional
notation using staff paper can dictate how we’re going to teach; if we don’t enjoy counting notes
on ledger lines, we just stick to writing notes on the staff. In the same way, it’s just as easy for
software to confine us. If we want to teach some musical concept in an interactive way using the
efficiency of technology but can’t find the technology to support it, the notion of an interesting
approach to teaching the concept likely gets dropped.At the same time, teaching with
technology can be seen as trendy and gimmicky. Suppose you decide to write a program that
plays diatonic chords in a key by using the buttons of a videogame controller. The activity in a
classroom setting can be fun, but at the same time, it can be pretty pointless if the program
doesn’t address some musical concept and the activity isn’t accompanied by solid teaching.
However, if these things are in place, the student is then able to accomplish some musical task
using a controller that is easy to use—and probably more familiar than that one-octave
xylophone he’s hated using all year. It’s easy to worship technology because of its “ooh wow”
factor, especially in a classroom setting. However, after the novelty of the technology wears off,



we’re still music educators first and technologists second. A good interactive system should
allow a user to do musical things with efficiency, greater control, and clarity; it should not just
exist for the sake of having technology in the classroom.Technology in the ClassroomHaving an
arsenal of customized software to explain specific musical concepts can make your teaching life
so much easier. How many times do you really need to write out the whole step and half step
patterns of a major scale on the chalkboard? What if you had an application that showed the
pitches, and steps for a scale, any scale, starting on any pitch? Not only will using such an app
save you time, but it’s a program that you could allow your students to download and interact
with on their own.Many teachers are terrified of teaching “technology lessons” because they
don’t want to be in the situation where some little kid knows more about technology than they do,
when the reality is that having a kid like that in class can be an incredible benefit! That kid
already understands the technology, so first, he’ll be the cheapest and most accessible tech
support you’ll ever find when something goes wrong in the classroom—let him troubleshoot for
you and his peers when things stop working. Second, and more important, since he already
understands the technological side of things, it helps you to conceptually explain to him the
musical side of things, which I guarantee he doesn’t understand nearly as well as you. Musical
concepts, as you’ll recall, are the sorts of things you went to school to learn about.These days,
you can’t walk into a convenience store without seeing seven or eight computers being actively
used for a specific intended outcome—why should the music classroom be any different? Even
band classrooms! Technology truly can help facilitate our teaching objectives. However, students
don’t just need teachers to show them new tech toys or cool software; they can find that on
YouTube, from their friends, and in their local music store. What they need is for a trained
musician to help them make sense of the musical world around them—the use of interactive
music systems can make this process richer and more palatable. That’s knowledge students
can’t find just anywhere.Book DesignThis book is divided into 21 chapters that address common
uses for the software Max/MSP/Jitter as they pertain to music educators. The book is structured
in a step-by-step guide by which we’ll build programs. We address the musical concepts and
pedagogical implications behind the programs we write and provide instruction for adaptation
and expansion of the programs.If you are an instructor using this book as the text for a semester
course, I would recommend covering about two chapters per week with the exception of longer
chapters like 6 and 12 or wherever a little more time is needed on a given topic. New material
builds upon previously learned concepts, so while skipping chapters is possible, students
should be told to read the Help file for any unfamiliar objects or terms. Each chapter concludes
by providing a list of objects and terms introduced in the chapter. There are assignments at the
end of each chapter that are somewhat more rigid in design at first, but soon allow the reader
some level of individuality in completing them. Regular assessments and individualized projects
are strongly encouraged.Basic TroubleshootingThe activities provided in this book have been
tested, and you should not encounter any problems—in theory! As you move through the book,
you’re going to have to act as your own troubleshooting team if something goes awry. For every



activity we do, there is a picture reference in the text and a working example of the software
available on this book’s companion website (see “About the Companion Website” following the
acknowledgments).A few basic steps will help to make sure that you don’t run into problems:1.
Save early and save often—ensure that you save your work frequently and that you keep your
saved files organized. Don’t accidentally overwrite files with the same name unless instructed to
do so in the text.2. Follow the steps—ensure that you’ve followed the instructions exactly as
written by connecting things correctly and entering text correctly, noting spaces if present.3.
Consult the picture and reference patch—as mentioned, a working example of each activity is
available from the companion website.4. Restart the program—if you are still running into
problems, save your work, restart the program completely and re-open your work.5. Restart the
computer—if your computer is being unresponsive, it is a good idea to shut it down, wait for a
minute or so, and turn it back on (don’t forget to turn it back on as this is considered to be an
important step).6. Getting help—consult the floating Max Window, the Max Help files, and the
Max reference files, all of which are explained in the first chapter.7. If for some reason you still
encounter an error, you should try to recreate the error on a different computer to identify
problems with your machine; it’s always possible that your volume is down, speakers are
unplugged, the keyboard is not working, and so on. Errors like this are best discovered in the
privacy of your own home to minimize the amount of humiliation experienced.8. Cycling ’74, the
authors of the software Max/MSP/Jitter have a support forum on their website. However, you
should refrain from posting your questions on this site until you have read through this book and
all the reference files (including tutorials) in the program. The users on the forum are helpful for
matters that go beyond information that is clearly covered in the aforementioned references. If
you’re a student, it’s also not a good idea to try to pay people on the forum to complete
assignments for you. If you are reading this book as part of a course, the chances are strong that
your instructor subscribes to the forums and will see your post.This book and the activities
described herein have been revised slightly for Max 7 in this second edition of the book, though
most concepts introduced are still compatible with both Max versions 5 and 6. As new versions
of Max are released, some changes to the program documentation, layout, and functionality
may occur that are different from how they appear in this text. Simply consult the Help files and
revision history documents provided within the program in these cases. Be patient; some
concepts are a little tricky and you may have to reread something a few times before it sinks in.
All in all, Max/MSP/Jitter is not hard to learn, but be patient. We’ll create software with Max in a
way that exposes you to the language, but keep in mind: there’s more than one way to write the
same program. Soon, you’ll get the hang of it and will be writing your own programs in no time.
Enjoy!PrefaceAn interactive music system is a hardware and/or software configuration that
allows an individual to accomplish a musical task, typically in real time, through some
interaction. Though commonly associated with composition and performance, the tasks
associated with interactive music systems can include analysis, instruction, assessment,
rehearsal, research, therapy, synthesis, and more. These systems typically have some set of



controls, hardware or software, such as switches, keys, buttons, and sensors by which musical
elements like harmony, rhythm, dynamics, and timbre can be manipulated in real time through
user interaction.In this book, we use the programming language Max/MSP/Jitter to write custom
software for musical interaction. We discuss the concepts needed to complete your project,
complete many projects in a step-by-step style guide, and look at examples of working systems.
Emphasis is placed on the pedagogical implications of software creation to accomplish these
tasks. Whether you want to create a program for composers that explores relationships between
two modes or an exercise for beginners that helps improve finger dexterity, you will soon learn
how writing customized software can supplement and complement your instructional objectives.
We also discuss ways to interact with the software beyond just the mouse and keyboard through
use of camera tracking, pitch tracking, videogame controllers, sensors, mobile devices, and
more.Why Design Custom Software?Today, there are software applications for just about
everything, but to what extent do we allow music software to dictate how we teach musical
concepts? After installation of a software application, it’s normal to look at the program and ask
“what does it do,” “how can I perform with this,” and “how can I make a demonstration or
instructional activity out of this for my class?” There’s certainly nothing wrong with this, but you
may already have some musical ideas in mind and are looking for a way to express them using
the efficiency and interactivity of technology. However, existing software may not be able to
address the particular concepts you want to address from the angle you prefer.Imagine teaching
harmony with the aid of a specialized program that showed common tones between the chords
and scales, or a program that used the first seven number keys to play the seven diatonic chords
of a key. Imagine composing a piece of music with a program that showed how chord functions
tend to resolve in a given key.Software developers typically design a program’s layout to be
accessible and intuitive, but in doing so, they are bound to show certain biases toward the
visibility of what are considered the more common features. In an instructional setting, if the
feature that is going to help the instructor explain concepts of rhythm or harmony is somewhat
buried in the program’s menus, he or she may be less inclined to teach those musical concepts
right away because there is too much requisite knowledge of the software involved just to get to
the desired menu. Instructors would have to teach a number of software concepts just to get to
the place where they could teach the musical concept they wanted to address in the first place.
It’s not the software company’s fault; after all, they don’t know what and how you teach. However,
it’s a common case of technology dictating the instruction instead of instruction dictating the use
of technology.This problem is not unique to technology. Even the conventions of traditional
notation using staff paper can dictate how we’re going to teach; if we don’t enjoy counting notes
on ledger lines, we just stick to writing notes on the staff. In the same way, it’s just as easy for
software to confine us. If we want to teach some musical concept in an interactive way using the
efficiency of technology but can’t find the technology to support it, the notion of an interesting
approach to teaching the concept likely gets dropped.At the same time, teaching with
technology can be seen as trendy and gimmicky. Suppose you decide to write a program that



plays diatonic chords in a key by using the buttons of a videogame controller. The activity in a
classroom setting can be fun, but at the same time, it can be pretty pointless if the program
doesn’t address some musical concept and the activity isn’t accompanied by solid teaching.
However, if these things are in place, the student is then able to accomplish some musical task
using a controller that is easy to use—and probably more familiar than that one-octave
xylophone he’s hated using all year. It’s easy to worship technology because of its “ooh wow”
factor, especially in a classroom setting. However, after the novelty of the technology wears off,
we’re still music educators first and technologists second. A good interactive system should
allow a user to do musical things with efficiency, greater control, and clarity; it should not just
exist for the sake of having technology in the classroom.Technology in the ClassroomHaving an
arsenal of customized software to explain specific musical concepts can make your teaching life
so much easier. How many times do you really need to write out the whole step and half step
patterns of a major scale on the chalkboard? What if you had an application that showed the
pitches, and steps for a scale, any scale, starting on any pitch? Not only will using such an app
save you time, but it’s a program that you could allow your students to download and interact
with on their own.Many teachers are terrified of teaching “technology lessons” because they
don’t want to be in the situation where some little kid knows more about technology than they do,
when the reality is that having a kid like that in class can be an incredible benefit! That kid
already understands the technology, so first, he’ll be the cheapest and most accessible tech
support you’ll ever find when something goes wrong in the classroom—let him troubleshoot for
you and his peers when things stop working. Second, and more important, since he already
understands the technological side of things, it helps you to conceptually explain to him the
musical side of things, which I guarantee he doesn’t understand nearly as well as you. Musical
concepts, as you’ll recall, are the sorts of things you went to school to learn about.These days,
you can’t walk into a convenience store without seeing seven or eight computers being actively
used for a specific intended outcome—why should the music classroom be any different? Even
band classrooms! Technology truly can help facilitate our teaching objectives. However, students
don’t just need teachers to show them new tech toys or cool software; they can find that on
YouTube, from their friends, and in their local music store. What they need is for a trained
musician to help them make sense of the musical world around them—the use of interactive
music systems can make this process richer and more palatable. That’s knowledge students
can’t find just anywhere.Book DesignThis book is divided into 21 chapters that address common
uses for the software Max/MSP/Jitter as they pertain to music educators. The book is structured
in a step-by-step guide by which we’ll build programs. We address the musical concepts and
pedagogical implications behind the programs we write and provide instruction for adaptation
and expansion of the programs.If you are an instructor using this book as the text for a semester
course, I would recommend covering about two chapters per week with the exception of longer
chapters like 6 and 12 or wherever a little more time is needed on a given topic. New material
builds upon previously learned concepts, so while skipping chapters is possible, students



should be told to read the Help file for any unfamiliar objects or terms. Each chapter concludes
by providing a list of objects and terms introduced in the chapter. There are assignments at the
end of each chapter that are somewhat more rigid in design at first, but soon allow the reader
some level of individuality in completing them. Regular assessments and individualized projects
are strongly encouraged.Basic TroubleshootingThe activities provided in this book have been
tested, and you should not encounter any problems—in theory! As you move through the book,
you’re going to have to act as your own troubleshooting team if something goes awry. For every
activity we do, there is a picture reference in the text and a working example of the software
available on this book’s companion website (see “About the Companion Website” following the
acknowledgments).A few basic steps will help to make sure that you don’t run into problems:1.
Save early and save often—ensure that you save your work frequently and that you keep your
saved files organized. Don’t accidentally overwrite files with the same name unless instructed to
do so in the text.2. Follow the steps—ensure that you’ve followed the instructions exactly as
written by connecting things correctly and entering text correctly, noting spaces if present.3.
Consult the picture and reference patch—as mentioned, a working example of each activity is
available from the companion website.4. Restart the program—if you are still running into
problems, save your work, restart the program completely and re-open your work.5. Restart the
computer—if your computer is being unresponsive, it is a good idea to shut it down, wait for a
minute or so, and turn it back on (don’t forget to turn it back on as this is considered to be an
important step).6. Getting help—consult the floating Max Window, the Max Help files, and the
Max reference files, all of which are explained in the first chapter.7. If for some reason you still
encounter an error, you should try to recreate the error on a different computer to identify
problems with your machine; it’s always possible that your volume is down, speakers are
unplugged, the keyboard is not working, and so on. Errors like this are best discovered in the
privacy of your own home to minimize the amount of humiliation experienced.8. Cycling ’74, the
authors of the software Max/MSP/Jitter have a support forum on their website. However, you
should refrain from posting your questions on this site until you have read through this book and
all the reference files (including tutorials) in the program. The users on the forum are helpful for
matters that go beyond information that is clearly covered in the aforementioned references. If
you’re a student, it’s also not a good idea to try to pay people on the forum to complete
assignments for you. If you are reading this book as part of a course, the chances are strong that
your instructor subscribes to the forums and will see your post.1. Save early and save often—
ensure that you save your work frequently and that you keep your saved files organized. Don’t
accidentally overwrite files with the same name unless instructed to do so in the text.2. Follow
the steps—ensure that you’ve followed the instructions exactly as written by connecting things
correctly and entering text correctly, noting spaces if present.3. Consult the picture and
reference patch—as mentioned, a working example of each activity is available from the
companion website.4. Restart the program—if you are still running into problems, save your
work, restart the program completely and re-open your work.5. Restart the computer—if your



computer is being unresponsive, it is a good idea to shut it down, wait for a minute or so, and
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changes to the program documentation, layout, and functionality may occur that are different
from how they appear in this text. Simply consult the Help files and revision history documents
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may have to reread something a few times before it sinks in. All in all, Max/MSP/Jitter is not hard
to learn, but be patient. We’ll create software with Max in a way that exposes you to the
language, but keep in mind: there’s more than one way to write the same program. Soon, you’ll
get the hang of it and will be writing your own programs in no time. Enjoy!AcknowledgmentsThis
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Technology in Music Instruction (ATMI): thank you for your continued support and input about my
work. Thank you Will Kuhn, my co-author for Interactive Composition (2015). Thank you Rick
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technology to reach the 80% of students who aren’t part of their school’s band, choir, or
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for making me reconsider my ranking for favorite Queen album on a regular basis: currently,
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WebsiteOxford has created a password-protected website to accompany Max/MSP/ Jitter for
Music. The site features documented source code for each example in the book. Throughout the
text, the caption for each figure pictured includes the file name of a patch that you can open as a
reference example. Simply follow along in the book while developing your own software or using
the example code in case you get stuck.The site also features numerous examples of larger
projects written in Max/MSP/Jitter, third-party external objects and patches addressed in the
text, and other media data, which you can modify and use for your own projects.You may access
the site using username Music4 and password Book2497.About the Companion WebsiteOxford
has created a password-protected website to accompany Max/MSP/ Jitter for Music. The site
features documented source code for each example in the book. Throughout the text, the
caption for each figure pictured includes the file name of a patch that you can open as a
reference example. Simply follow along in the book while developing your own software or using
the example code in case you get stuck.The site also features numerous examples of larger
projects written in Max/MSP/Jitter, third-party external objects and patches addressed in the
text, and other media data, which you can modify and use for your own projects.You may access
the site using username Music4 and password Book2497.Max/MSP/Jitter for MusicMax/MSP/
Jitter for Music1Introduction to ProgrammingA programming language is a means to specify
processes performed by a computer. A programming language is somewhat similar to the
language we speak. Each word in the language serves some function and the ordering of each
word follows a syntax from which we derive meaning.In a programming language, these words
are commonly referred to as functions or objects. Each object has some purpose germane to the



programming language. For example, an object called number might allow a user to specify a
number. Another object called + might be used to add that number to another number. The
objects, each with a specific purpose, work together to create some intended outcome; this is
how a program works. In this case, the program we defined added two numbers together.In a
typical programming language, there are numerous objects, each with a specific function. One
difficulty in the beginning stages of learning to program is that you do not know the fundamental
objects that form the basic vocabulary of that programming language. In this book, we will begin
by developing small music programs that use only a few objects. As we progress in chapters,
more objects will be introduced and your programs will become more sophisticated as you
incorporate more objects into them.Another difficulty lies in thinking about the steps involved in
creating a program. There are different ways to write programs that achieve the same result, but
they all require that precise activity to be specified in order to produce that result.In an early
experience as a kindergarten music teacher, the teacher stood at the door of my classroom and
greeted the students as they entered the room. “Good morning, let’s take out our books and
begin class.” At that moment, the students hadn’t yet put their backpacks down, walked to their
seats, or sat in their chairs. It was obvious that they were not ready to begin class. Some
students scrambled to find any book anywhere in the room. Some took all of their books out of
their backpacks. One student began crying. It was a disaster.The problem was that the teacher
didn’t clearly describe the individual, sequential processes that needed to take place. Instead of
using a number of small processes in conjunction with one another, the teacher attempted to
use one “high-level” command that would do it all. It is important to think of the overall flow of
actions before you begin to program; break down the objective into smaller, “low-level” tasks and
create a procedure for accomplishing the objective.In this book, we will be using a programming
language called Max/MSP/Jitter, commonly referred to as simply Max. Max is different from
most programming languages in that it uses a graphical interface to display each object as a
small rectangle on the screen. This rectangle is called an object and is the basic unit of function
in Max.Objects typically have inlets on the top of the rectangle for receiving data from other
objects, and outlets on the bottom for sending data to other objects. Data are sent from one
object to another by drawing a small line, called a patch cord, from the outlet of one object to the
inlet of another object. With the objects connected via patch cords, it is easy to see the dataflow
between each object in your program. In many ways, the process is not unlike connecting guitar
pedals together.There is an unlimited number of programs you can write using Max. For the
purpose of this book, we will focus on the necessary skills to write programs for composition,
performance, and music instruction. Those who may find this book particularly useful are music
educators who want to supplement their lessons with interactive instructional tools, develop
adaptive instruments to aid in student composition and performance activities, and create
measurement tools with which to conduct music education research. There are no prerequisite
programming skills required at all and the programs we will write can be useful for children as
well as adults.It would be beneficial to read this book while working through the tutorials



included in the Max software application. At the end of each chapter, a few related tutorials are
given as supplemental reading materials. As you begin to learn this language and grasp the
concepts of programming, you will quickly see how easily you can develop software applications
to accomplish your objectives.Example files for each chapter are available from the Oxford
University Press companion website for this book. Portions of these files are pictured in figures
throughout each chapter. For your reference, in the description beneath each picture is the file
name from which the picture was taken.The steps involved in creating these patches are listed in
a “cookbook” style numbered list. If you get stuck or if something doesn’t work correctly, go back
and ensure that you have completed each step exactly as described, and you’ll find yourself
back on track.If you have not already done so, download and install the latest version of Max
from This book, now in its second edition, has been updated for use with Max 7. You will also
need to download the demonstration files that accompany this book from the companion Oxford
University Press website at for this book or from The demonstration files also contain a zip file
called EAMIR SDK that you should install prior to reading Chapter 6.Introduction to MaxAs we
begin building some programs together, be brave. At times, you may not understand the
programming concepts at first and it may feel as if you were just blindly following instructions.
Continue to follow each step in the programming process and these concepts will soon become
clear.In this chapter, we will look at the basic tools of operation and navigation in the Max
programming environment. As we spend time discussing these tools, don’t expect to make any
music until the next chapter. An understanding of these tools is necessary to use the Max
program.A document in Max is referred to as a patcher or, simply, a patch. A patch is a blank
canvas on which programmers to put objects. When launching Max, you are greeted with a
Welcome Screen, but for now, close this window leaving only the Max window behind it open.
From within the Max application, click the menu item marked File at the top of the screen and
select New Patcher or use the key command  +n (Mac) or ctrl+n (Windows).1 To create a new
object, press the n key. When you do so, a small rectangle appears on the screen allowing you to
type in the name of an object in the Max language. You can also add an object by clicking the
Object icon located at the top left of the patch window.It’s time to learn our first object called
button. Note that the object names are case-sensitive.1. Create a new object box by pressing
the n key on your computer keyboard2. Type the word button in the new object box3. Hit the
enter/return keyFIGURE 1.1an inlet atop a button (left) alongside an outlet under a button
(right)If you’ve accidentally clicked away from the new object box without typing in the word
button, you can double click the object box to allow text to be entered once again. Once the
word button has been entered, the button object appears on the screen as a small circle.The top
of the button object has one inlet for receiving data. If you hold your mouse over the inlet on top
of the button object, a red circle appears around the inlet as well as a message window giving
you some description about the data that the inlet can receive. Now, hold your mouse over the
outlet on the bottom of the object. A button sends out a message called a bang from its outlet.If
you are having trouble viewing the inlet, you can Zoom In and Zoom Out on a patch by clicking



View from the top menu, or by using the key commands  += (Mac) or ctrl+= (Windows) and  +-
(Mac) or ctrl+- (Windows).A bang is an event in Max that triggers an object to perform some
task. The only task the button object performs is to send and receive bangs. The button is such a
common object in Max that it has its own key command shortcut, the b key, for putting the object
in your patch.4. Add 5 more buttons to your patch by pressing the b key or by highlighting an
existing button and copying and pasting it. Copying and pasting is accomplished in Max by
going to the Edit menu or by using the key commands  +c (Mac) or ctrl+c (Windows) and  +v
(Mac) or ctrl+v (Windows). You can also copy an object by holding the alt/option key and
dragging an objectTo move buttons to different locations in your patch, simply click the center of
the object and drag it to the desired location. You can also resize the button by holding your
mouse over the bottom right of the object until your mouse shows two arrows at an angle and
dragging while holding the mouse button down.FIGURE 1.2a group of buttons |
button_tree.maxpatWe’ve been working in what Max calls the Patching Mode or Patching View.
In Patching Mode, you can create new objects, move them around, resize them, and connect
them to each other. By going to the View menu at the top of the screen and unchecking the item
marked Edit, the patch will become Locked; that is, the patcher will function as a program and
cannot be edited in any way until the patch is unlocked again. You can lock and unlock a patch
by clicking the small Lock icon at the bottom of the patcher window or by using the key
command  +e (Mac) or ctrl+e (Windows). You can also  +click (Mac) or ctrl+click (Windows) on
any blank space in the patch to toggle lock modes.5. With your patcher locked, click on the
button objects you’ve madeNotice that they blink when clicked. This is a graphical display of a
bang message being sent or received from the button object. Unlock the patch and you can
once again make edits in Patching Mode.Now let’s send data from one button to another via
patch cords. A patch cord will be created when you click on the outlet of an object. The cord will
travel wherever your mouse does and will not disappear until you click on the inlet of another
object or press the esc key.Unlock your patch and6. Click on the outlet of one of your top level
buttons and move your mouse to the inlet of another button beneath it until a red circle appears
above the second buttonPatch cords can connect from object outlets to inlets and the other way
around, though it is advised that you begin by connecting outlets only to inlets. Once again, keep
in mind that if you click on an object’s outlet, the patch cord will follow your mouse until you
connect it to another object’s inlet or press the esc key.FIGURE 1.3a button tree |
button_tree.maxpat7. When your mouse pointer hovers over the inlet of the second button, click
your mouse and the two objects will be connectedIn this book, when we reference connecting
one object’s outlet to another object’s inlet, this is the process. Please note that Max 7 will
display a more curved patch cable than in previous versions of Max. This can be changed via
the Preferences menu item beneath the top menu Max (Mac), or Options (Windows).8. Lock
your patch and click on the top button in your button treeThe bang flows from the top button and
triggers a bang to all of the connected buttons. If you click on a button beneath the top one, the
top button does not turn yellow because it did not receive any data to its inlet. This illustrates the



dataflow within Max. To save this patch, click File>Save from the top menu or use the key
command  +s (Mac) or ctrl+s (Windows). When asked for a file-name, name the file
“button_tree.” Notice that the Max file name extension “.maxpat” is given to your file. After you
have saved the patch, close it.Look at the following illustration and try to determine what will
happen when you click on one of the buttons:When you click a button, a bang will flow from one
button to another without any way to stop the data. The bang will continue to flow forever without
any way of ever stopping. This causes an error called stack overflow. It’s a concept similar to the
way that feedback is heard when a microphone is too close to a public address speaker. Make
sure that objects are not feeding data back into themselves. Errors like this one will cause an
error message to appear at the top of the patch describing the problem and listing the culprit
object. Clicking the error message will highlight the problem object in the patch. The error
message may be cleared by clicking the small “x” on the right of the message. In some cases,
you may be instructed to go to the Edit menu and click Resume.FIGURE 1.4a button loopThe
Max WindowCreate a new patcher, and1. Create a new object called printThe print object is
used to display some information in what is called the Max Console, or the Max window. Open
the Max Console by choosing Window>Max Console from the top menu or by using the key
command  +m (Mac) or ctrl+m (Windows). Important messages, like errors, for instance, will
appear in the Max Console. If an error occurs somewhere in your patch, you can locate where
the error occurred by double clicking on the error message (highlighted) in the Max window. This
will cause the troublesome object or objects to become temporarily highlighted.2. Create a
button object3. Connect the outlet of the button to the inlet of the print object4. Lock the patch
and click the buttonYou will notice that the message “bang” appears in the Max Console. The
print object will print to the Max Console any message you send it. Since a button sends out a
bang message, the print object will print the message “bang.” Unlock your patch and5. Create a
new object called messageA message object, also called a message box, allows you to enter a
message as text by typing into it. The message you type can contain just about anything: words,
numbers, words and numbers. Unlike number objects whose values are temporarily visible in the
object but disappear when the patch is closed and reopened later, message boxes will retain the
messages entered in them. Objects will receive the data in messages and interpret it in some
way. The message is such a common object in Max that it has its own key command shortcut,
the m key, for putting the object in your patch.Be careful that you do not accidentally use a
message box in place of an object box and vice versa. Take a moment to notice the visual
difference between the message objects and new objects.6. Enter the text Hello World into the
message boxIf you’ve already clicked away from the message box, double click the object to
allow text to be entered once again.7. Connect the outlet of the message box to the inlet of the
print object8. Lock the patch and click the message boxFIGURE 1.5a print object receiving data
from a message box | hello_world.maxpatWhen the message box is clicked, the message Hello
World will appear in the Max window. You can bring the Max window to the front of the screen by
double clicking on the print object.Help PatchersIf you want help seeing how an object works,



you can open up the Help file for each object in an unlocked patch by ctrl+clicking2 (Mac) or
right clicking (Windows) on the object and selecting Open Help from the contextual menu. You
may also open Help by holding the alt/option key down and clicking on an object in an unlocked
patcher. Unlock the patch and9. Open the Help file for the print objectIn the Help file for an
object, a description of the object is given along with fully working examples of how the object
may function within a patch.The interesting thing about Max Help files is that they too can be
unlocked and edited just like patches.10. Unlock the print Help file11. Highlight all of the objects
in the Help patch and copy them using the commands  +c (Mac) or ctrl+c (Windows)You can
construct entire Max patches by copying working code from the Help files. To find out more
information about an object including all of the available messages you can send to it, click on
the Open Reference link within the top right corner of an object’s Help file.On the top menu of
each Help file is a menu item labeled “?”. This menu shows objects that are somehow related to
the object whose Help file you are currently reading. If you select one of these objects from the
menu, its Help file will open up. Looking through these related objects is a great way to learn the
Max language fast. Also, if you are trying to find an object that operates similarly, but not exactly
the same, to an object you know, you may find that object via this menu. You can also create a
new object and type in the desired function you’re looking for as if the new object box were a
search engine!An additional option in Max is to enable Help in Locked Patchers. This allows you
to open the Help file for an object in a locked patch by holding the alt/option key down and
clicking on an object. To enable Help in Locked Patchers, go to the Options menu item at the top
of the screen. In this book, we will not open Help in any locked patchers, so there is no need to
enable it, though you may find it useful for your personal projects.12. Close the Help file for
print13. Paste the contents copied from the print Help file into your patch using the commands 
+v (Mac) or ctrl+v (Windows)ArgumentsIn your patch, notice that some of the print objects in the
Help file contents you just copied contain extra words to the right of the “print” object name.
These are called arguments. Arguments are used to set or change variables for an object and
are related to the types of data and messages the object deals with. In most cases, specifying
an argument replaces some default value, if the object had one, with a new one. In the case of
the print object, an argument will replace the default word “print” in the Max Console.14. Change
or add the print argument to a single word of your choosing15. Lock the patch and click the
message box16. Open the Max window to reveal that the word you chose has replaced the word
“print”Look at Figure 1.6 and try to determine what will happen when you click on the message
box:FIGURE 1.6a print object with an argument | hello_world2.maxpatThe supplied argument is
two words: this and argument. However, the print object only takes one argument so the second
argument, argument, is dropped. The message in the Max window readsObject: this
Message: Hello WorldSeparating Items in a MessageNow, unlock your patch and17. Double
click the message box containing the text Hello World and put a comma after the word
HelloFIGURE 1.7printing a list to the Max Window | hello_world3.maxpatThe comma is used to
separate items in a message box. The message box now contains two separate items. Each



item in the message will be printed to the Max window on a separate line.18. Lock your patch
and click the same message boxTake a moment to save your patch as hello_world.maxpat.
Close the patch.Numbers: Integers and Floating PointsCreate a new patcher, and1. Create new
object called numberThe number object, also called a number box, is such a common object in
Max that it has its own key command shortcut, the i key, for putting the object in your patch.
Think of the i as short for integer as opposed to the other type of number box we’ll deal with in
Max: the floating-point numbers; numbers with a decimal point.A number object simply holds a
number.2. Lock your patch, and click on the number objectNow, type the number 34 into that
object. The number 34 will stay in that number box until you change it or close the patch. When
the patch is closed, the number box will return to its default value of 0.3. Click on the number in
the number box and drag the number up or down to increase or decrease the value. You may
also use the arrow keys to increase or decrease the value once you have clicked in the number
boxUnlock your patch and4. Create 3 new message boxes containing the values 44, 55, and
42.85, respectively5. Connect the outlet of each message box to the inlet of the number box6.
Lock your patch and click each message boxFIGURE 1.8connecting message boxes to number
boxes | number_boxes.maxpatNotice that the value of the number box changes for each value
you send to it by clicking a message box. Note that when you send the number box the floating
point value 42.85, it drops the decimal point values completely. The number object only takes
the integer part of a floating point number. It does not round the number up or down; it simply
truncates it.Unlock your patch and7. Create a new object called a flonumA flonum object is a
floating-point number box. Floating-point number boxes can be used to show more precise
numbers than integer numbers. Is the singer singing exactly at A 440 or is she singing at A
440.91? A flonum will represent this value more accurately than a number box since, unlike the
number box, it can contain the numbers after the decimal point. The flonum object, sometimes
called a float, is such a common object in Max that it has its own key command shortcut, the f
key, for putting the object in your patch.8. Create 3 new message boxes with the values 55.72,
44.35, and 55, respectively9. Connect the outlet of each message box to the first inlet of the
flonum box10. Lock your patch and click on each message boxThe first two message boxes
send the floating-point number to the flonum object. If you send a floating-point number with
more than two decimal places, you will need to resize the flonum object to see these places by
clicking on the button right corner of the object and dragging to the right. The third message box,
55, is still received by the flonum even though it is not a floating-point number.FIGURE
1.9connecting message boxes to flonum boxes | number_boxes.maxpatAligningYou may have
noticed that the patch cords in the chapter examples may look more segmented than yours. With
Segmented Patch Cords selected from the Options menu, you are able to click at multiple points
along the path between objects controlling the shape of the cable. You can also align patch
cords by highlighting them (ctrl+clicking [Mac] or right clicking [Windows]) it after they’re
connected to some objects and selecting Align, or by using the key command  +y (Mac) or ctrl
+shift+a (Windows).You can also align highlighted objects using the same key command.3 You



can highlight multiple objects, either by holding the shift key and clicking the desired objects, or
by drawing a marquee rectangle around them with the mouse. To highlight patch cords while you
are drawing a marquee, hold the alt/option key. The Arrange menu also provides the option to
snap objects in place according to a grid or even to snap objects in place relative to each
other.CommentingIt is a good idea to make comments within a patch while you are writing it. As
patches become larger, they can become difficult to read, and if you haven’t opened the patch
up in a while, it is easy to forget what you did and how certain parts of it function.11. Create a
new object called commentThe comment object, also called a comment box, allows you to type
directly into your patch and document it. The comment object is such a common object in Max
that it has its own key command shortcut, the c key, for putting the object in your patch.12.
Create 2 new objects called comment containing the text integers and floating point numbers,
respectively13. Label the number objects as integers and the flonum objects as floating-point
numbers by moving the comments near these objectsFIGURE 1.10commenting your patch |
number_boxes.maxpatIn general practice, it is important to be descriptive when documenting
your patch.14. Create a third comment object, which we will use for the title, and enter the text
ints and floatsFIGURE 1.11the arrow icon over a comment objectInspectorIt would be nice to
see our title comment “ints and floats” in a somewhat larger font. To change properties about this
or any object, go to the Inspector by Ctrl+clicking (Mac) or right clicking (Windows) an object
and selecting Inspector from the contextual menu while the patch is unlocked. With an object
highlighted, you can also use the key command  +i (Mac) or ctrl+i (Windows), or click the
Inspector icon located on the right side of the patch window. Another method of getting to the
Inspector is to hold your mouse in the middle of the left side of the object, click the arrow icon
that appears, and choose the Inspector label.15. Open the Inspector for the comment box
containing the title “ints and floats”From the Inspector menu, you can select tabs for which to
edit the object’s properties. The tab All is selected by default and contains all of the property
options of the other tabs. Please note: in other Max menus similar to this one, the Basic tab is
shown by default, so switch to the All tab if necessary.FIGURE 1.12changing an object’s
properties through the Inspector | number_boxes.maxpat16. In the Inspector, scroll down to the
line marked Font Size and increase the font to 30 by double clicking the default number and
typing in the number 30Take a moment to save your patch as number_boxes. Close the
patch.Key Commands:• New Patcher:  +n (Mac) or ctrl+n (Windows)• Save Patcher:  +s (Mac)
or ctrl+s (Windows)• Zoom In:  += (Mac) or ctrl+= (Windows)• Zoom Out:  +- (Mac) or ctrl+-
(Windows)• Copy:  +c (Mac) or ctrl+c (Windows)• Paste:  +v (Mac) or ctrl+v (Windows)• New
Object Box: n• Button object: b• Toggle Lock & Edit Modes:  +e (Mac) or ctrl+e (Windows)•
Message object: m• Max window:  +m (Mac) or ctrl+m (Windows)• Help: alt/option then click an
object• Number (integer) object: i• Flonum (floating-point number) object: f• Align:  +y (Mac) or
ctrl+shift+a (Windows)• Comment: c• Inspector:  +i (Mac) or ctrl+e (Windows) with the object
highlightedNew Objects Learned:• button• print• message• number• flonum•
commentRemember:• A document in Max is referred to as a patcher or a patch.• You can copy



an object by holding the alt/option key and dragging an object.• You can resize an object by
holding your mouse over the bottom right of the object until your mouse shows two arrows at an
angle, and dragging while holding the mouse button down.• Segmented Patch Cords is an
option that causes a patch cord to be created when you click on the outlet of an object.• With
Segmented Patch Cords selected, if you click on an object’s outlet, the patch cord will follow
your mouse until you connect it to another object’s inlet or press the esc key.• Patch cords
always connect from outlets to inlets and never the other way around.• The file-name extension
“.maxpat” is given to all Max patches.• To avoid a Stack Overflow, make sure objects are not
feeding data back into themselves.• The Max window shows important messages and useful
debugging information in case of errors.• Open Help by holding the alt/option key down and
clicking on an object.• To find out more information about an object, click on the Open Reference
link within the object’s Help file.• Arguments are parameters that can be set for an object that
relate somehow to the types of data that object handles.• The number box truncates decimal
point values completely. It does not round numbers up or down at all.• It is important to be as
descriptive as possible when commenting your patch.• To change properties about an object, go
to the Inspector.Additional Tutorials:Tutorials are available from within the Max application by
clicking Help from the top menu and selecting Reference.Under the Max heading, click and
read• The Basic Activities of Making Patches• Tips and ShortcutsSelect Max Tutorials and read•
Hello—Creating objects and connections• Bang!—The bang message• Numbers and Lists—
Types of data in MaxOn Your Own:• Read the Help file for each of the new objects introduced in
this chapter.• Write a patch that allows a user to click on a single button to send 3 different
message boxes with numerical values (integer or floating-point) to 3 separate objects: the print
object, the number box, and the flonum box. Specify an argument for the print object. Comment
the patch with a title in size 30 font. Use your knowledge of key commands to speed up the
process.1 Throughout this book, key commands are noted for both Mac and Windows by using,
for example, the following syntax:  +n (Mac) or ctrl+n (Windows), which indicates that a user
should press the command key  plus the n key on Mac, or the control key ctrl plus the n key on
Windows. Though a plus sign (+) is indicated, it is not an additional key to be held during these
functions unless specifically noted.2 Mac users will have to use ctrl+click if right clicking has not
been enabled in System Preferences or if their mouse or touchpad does not support right
clicking capabilities.3 This option is best used for objects positioned along the same plane.
Highlighting everything in the patch and clicking align could make a mess.1Introduction to
ProgrammingA programming language is a means to specify processes performed by a
computer. A programming language is somewhat similar to the language we speak. Each word
in the language serves some function and the ordering of each word follows a syntax from which
we derive meaning.In a programming language, these words are commonly referred to as
functions or objects. Each object has some purpose germane to the programming language. For
example, an object called number might allow a user to specify a number. Another object called
+ might be used to add that number to another number. The objects, each with a specific



purpose, work together to create some intended outcome; this is how a program works. In this
case, the program we defined added two numbers together.In a typical programming language,
there are numerous objects, each with a specific function. One difficulty in the beginning stages
of learning to program is that you do not know the fundamental objects that form the basic
vocabulary of that programming language. In this book, we will begin by developing small music
programs that use only a few objects. As we progress in chapters, more objects will be
introduced and your programs will become more sophisticated as you incorporate more objects
into them.Another difficulty lies in thinking about the steps involved in creating a program. There
are different ways to write programs that achieve the same result, but they all require that precise
activity to be specified in order to produce that result.In an early experience as a kindergarten
music teacher, the teacher stood at the door of my classroom and greeted the students as they
entered the room. “Good morning, let’s take out our books and begin class.” At that moment, the
students hadn’t yet put their backpacks down, walked to their seats, or sat in their chairs. It was
obvious that they were not ready to begin class. Some students scrambled to find any book
anywhere in the room. Some took all of their books out of their backpacks. One student began
crying. It was a disaster.The problem was that the teacher didn’t clearly describe the individual,
sequential processes that needed to take place. Instead of using a number of small processes in
conjunction with one another, the teacher attempted to use one “high-level” command that
would do it all. It is important to think of the overall flow of actions before you begin to program;
break down the objective into smaller, “low-level” tasks and create a procedure for
accomplishing the objective.In this book, we will be using a programming language called Max/
MSP/Jitter, commonly referred to as simply Max. Max is different from most programming
languages in that it uses a graphical interface to display each object as a small rectangle on the
screen. This rectangle is called an object and is the basic unit of function in Max.Objects
typically have inlets on the top of the rectangle for receiving data from other objects, and outlets
on the bottom for sending data to other objects. Data are sent from one object to another by
drawing a small line, called a patch cord, from the outlet of one object to the inlet of another
object. With the objects connected via patch cords, it is easy to see the dataflow between each
object in your program. In many ways, the process is not unlike connecting guitar pedals
together.There is an unlimited number of programs you can write using Max. For the purpose of
this book, we will focus on the necessary skills to write programs for composition, performance,
and music instruction. Those who may find this book particularly useful are music educators who
want to supplement their lessons with interactive instructional tools, develop adaptive
instruments to aid in student composition and performance activities, and create measurement
tools with which to conduct music education research. There are no prerequisite programming
skills required at all and the programs we will write can be useful for children as well as adults.It
would be beneficial to read this book while working through the tutorials included in the Max
software application. At the end of each chapter, a few related tutorials are given as
supplemental reading materials. As you begin to learn this language and grasp the concepts of



programming, you will quickly see how easily you can develop software applications to
accomplish your objectives.Example files for each chapter are available from the Oxford
University Press companion website for this book. Portions of these files are pictured in figures
throughout each chapter. For your reference, in the description beneath each picture is the file
name from which the picture was taken.The steps involved in creating these patches are listed in
a “cookbook” style numbered list. If you get stuck or if something doesn’t work correctly, go back
and ensure that you have completed each step exactly as described, and you’ll find yourself
back on track.If you have not already done so, download and install the latest version of Max
from This book, now in its second edition, has been updated for use with Max 7. You will also
need to download the demonstration files that accompany this book from the companion Oxford
University Press website at for this book or from The demonstration files also contain a zip file
called EAMIR SDK that you should install prior to reading Chapter 6.Introduction to MaxAs we
begin building some programs together, be brave. At times, you may not understand the
programming concepts at first and it may feel as if you were just blindly following instructions.
Continue to follow each step in the programming process and these concepts will soon become
clear.In this chapter, we will look at the basic tools of operation and navigation in the Max
programming environment. As we spend time discussing these tools, don’t expect to make any
music until the next chapter. An understanding of these tools is necessary to use the Max
program.A document in Max is referred to as a patcher or, simply, a patch. A patch is a blank
canvas on which programmers to put objects. When launching Max, you are greeted with a
Welcome Screen, but for now, close this window leaving only the Max window behind it open.
From within the Max application, click the menu item marked File at the top of the screen and
select New Patcher or use the key command  +n (Mac) or ctrl+n (Windows).1 To create a new
object, press the n key. When you do so, a small rectangle appears on the screen allowing you to
type in the name of an object in the Max language. You can also add an object by clicking the
Object icon located at the top left of the patch window.It’s time to learn our first object called
button. Note that the object names are case-sensitive.1. Create a new object box by pressing
the n key on your computer keyboard2. Type the word button in the new object box3. Hit the
enter/return key1. Create a new object box by pressing the n key on your computer keyboard2.
Type the word button in the new object box3. Hit the enter/return keyFIGURE 1.1an inlet atop a
button (left) alongside an outlet under a button (right)FIGURE 1.1an inlet atop a button (left)
alongside an outlet under a button (right)If you’ve accidentally clicked away from the new object
box without typing in the word button, you can double click the object box to allow text to be
entered once again. Once the word button has been entered, the button object appears on the
screen as a small circle.The top of the button object has one inlet for receiving data. If you hold
your mouse over the inlet on top of the button object, a red circle appears around the inlet as
well as a message window giving you some description about the data that the inlet can receive.
Now, hold your mouse over the outlet on the bottom of the object. A button sends out a message
called a bang from its outlet.If you are having trouble viewing the inlet, you can Zoom In and



Zoom Out on a patch by clicking View from the top menu, or by using the key commands  +=
(Mac) or ctrl+= (Windows) and  +- (Mac) or ctrl+- (Windows).A bang is an event in Max that
triggers an object to perform some task. The only task the button object performs is to send and
receive bangs. The button is such a common object in Max that it has its own key command
shortcut, the b key, for putting the object in your patch.4. Add 5 more buttons to your patch by
pressing the b key or by highlighting an existing button and copying and pasting it. Copying and
pasting is accomplished in Max by going to the Edit menu or by using the key commands  +c
(Mac) or ctrl+c (Windows) and  +v (Mac) or ctrl+v (Windows). You can also copy an object by
holding the alt/option key and dragging an object4. Add 5 more buttons to your patch by
pressing the b key or by highlighting an existing button and copying and pasting it. Copying and
pasting is accomplished in Max by going to the Edit menu or by using the key commands  +c
(Mac) or ctrl+c (Windows) and  +v (Mac) or ctrl+v (Windows). You can also copy an object by
holding the alt/option key and dragging an objectTo move buttons to different locations in your
patch, simply click the center of the object and drag it to the desired location. You can also resize
the button by holding your mouse over the bottom right of the object until your mouse shows two
arrows at an angle and dragging while holding the mouse button down.FIGURE 1.2a group of
buttons | button_tree.maxpatFIGURE 1.2a group of buttons | button_tree.maxpatWe’ve been
working in what Max calls the Patching Mode or Patching View. In Patching Mode, you can
create new objects, move them around, resize them, and connect them to each other. By going
to the View menu at the top of the screen and unchecking the item marked Edit, the patch will
become Locked; that is, the patcher will function as a program and cannot be edited in any way
until the patch is unlocked again. You can lock and unlock a patch by clicking the small Lock icon
at the bottom of the patcher window or by using the key command  +e (Mac) or ctrl+e
(Windows). You can also  +click (Mac) or ctrl+click (Windows) on any blank space in the patch
to toggle lock modes.5. With your patcher locked, click on the button objects you’ve made5. With
your patcher locked, click on the button objects you’ve madeNotice that they blink when clicked.
This is a graphical display of a bang message being sent or received from the button object.
Unlock the patch and you can once again make edits in Patching Mode.Now let’s send data
from one button to another via patch cords. A patch cord will be created when you click on the
outlet of an object. The cord will travel wherever your mouse does and will not disappear until
you click on the inlet of another object or press the esc key.Unlock your patch and6. Click on the
outlet of one of your top level buttons and move your mouse to the inlet of another button
beneath it until a red circle appears above the second button6. Click on the outlet of one of your
top level buttons and move your mouse to the inlet of another button beneath it until a red circle
appears above the second buttonPatch cords can connect from object outlets to inlets and the
other way around, though it is advised that you begin by connecting outlets only to inlets. Once
again, keep in mind that if you click on an object’s outlet, the patch cord will follow your mouse
until you connect it to another object’s inlet or press the esc key.FIGURE 1.3a button tree |
button_tree.maxpatFIGURE 1.3a button tree | button_tree.maxpat7. When your mouse pointer



hovers over the inlet of the second button, click your mouse and the two objects will be
connected7. When your mouse pointer hovers over the inlet of the second button, click your
mouse and the two objects will be connectedIn this book, when we reference connecting one
object’s outlet to another object’s inlet, this is the process. Please note that Max 7 will display a
more curved patch cable than in previous versions of Max. This can be changed via the
Preferences menu item beneath the top menu Max (Mac), or Options (Windows).8. Lock your
patch and click on the top button in your button tree8. Lock your patch and click on the top
button in your button treeThe bang flows from the top button and triggers a bang to all of the
connected buttons. If you click on a button beneath the top one, the top button does not turn
yellow because it did not receive any data to its inlet. This illustrates the dataflow within Max. To
save this patch, click File>Save from the top menu or use the key command  +s (Mac) or ctrl+s
(Windows). When asked for a file-name, name the file “button_tree.” Notice that the Max file
name extension “.maxpat” is given to your file. After you have saved the patch, close it.Look at
the following illustration and try to determine what will happen when you click on one of the
buttons:When you click a button, a bang will flow from one button to another without any way to
stop the data. The bang will continue to flow forever without any way of ever stopping. This
causes an error called stack overflow. It’s a concept similar to the way that feedback is heard
when a microphone is too close to a public address speaker. Make sure that objects are not
feeding data back into themselves. Errors like this one will cause an error message to appear at
the top of the patch describing the problem and listing the culprit object. Clicking the error
message will highlight the problem object in the patch. The error message may be cleared by
clicking the small “x” on the right of the message. In some cases, you may be instructed to go to
the Edit menu and click Resume.FIGURE 1.4a button loopFIGURE 1.4a button loopThe Max
WindowCreate a new patcher, and1. Create a new object called print1. Create a new object
called printThe print object is used to display some information in what is called the Max
Console, or the Max window. Open the Max Console by choosing Window>Max Console from
the top menu or by using the key command  +m (Mac) or ctrl+m (Windows). Important
messages, like errors, for instance, will appear in the Max Console. If an error occurs
somewhere in your patch, you can locate where the error occurred by double clicking on the
error message (highlighted) in the Max window. This will cause the troublesome object or
objects to become temporarily highlighted.2. Create a button object3. Connect the outlet of the
button to the inlet of the print object4. Lock the patch and click the button2. Create a button
object3. Connect the outlet of the button to the inlet of the print object4. Lock the patch and click
the buttonYou will notice that the message “bang” appears in the Max Console. The print object
will print to the Max Console any message you send it. Since a button sends out a bang
message, the print object will print the message “bang.” Unlock your patch and5. Create a new
object called message5. Create a new object called messageA message object, also called a
message box, allows you to enter a message as text by typing into it. The message you type can
contain just about anything: words, numbers, words and numbers. Unlike number objects whose



values are temporarily visible in the object but disappear when the patch is closed and reopened
later, message boxes will retain the messages entered in them. Objects will receive the data in
messages and interpret it in some way. The message is such a common object in Max that it has
its own key command shortcut, the m key, for putting the object in your patch.Be careful that you
do not accidentally use a message box in place of an object box and vice versa. Take a moment
to notice the visual difference between the message objects and new objects.6. Enter the text
Hello World into the message box6. Enter the text Hello World into the message boxIf you’ve
already clicked away from the message box, double click the object to allow text to be entered
once again.7. Connect the outlet of the message box to the inlet of the print object8. Lock the
patch and click the message box7. Connect the outlet of the message box to the inlet of the print
object8. Lock the patch and click the message boxFIGURE 1.5a print object receiving data from
a message box | hello_world.maxpatFIGURE 1.5a print object receiving data from a message
box | hello_world.maxpatWhen the message box is clicked, the message Hello World will
appear in the Max window. You can bring the Max window to the front of the screen by double
clicking on the print object.Help PatchersIf you want help seeing how an object works, you can
open up the Help file for each object in an unlocked patch by ctrl+clicking2 (Mac) or right
clicking (Windows) on the object and selecting Open Help from the contextual menu. You may
also open Help by holding the alt/option key down and clicking on an object in an unlocked
patcher. Unlock the patch and9. Open the Help file for the print object9. Open the Help file for
the print objectIn the Help file for an object, a description of the object is given along with fully
working examples of how the object may function within a patch.The interesting thing about Max
Help files is that they too can be unlocked and edited just like patches.10. Unlock the print Help
file11. Highlight all of the objects in the Help patch and copy them using the commands  +c
(Mac) or ctrl+c (Windows)10. Unlock the print Help file11. Highlight all of the objects in the Help
patch and copy them using the commands  +c (Mac) or ctrl+c (Windows)You can construct
entire Max patches by copying working code from the Help files. To find out more information
about an object including all of the available messages you can send to it, click on the Open
Reference link within the top right corner of an object’s Help file.On the top menu of each Help
file is a menu item labeled “?”. This menu shows objects that are somehow related to the object
whose Help file you are currently reading. If you select one of these objects from the menu, its
Help file will open up. Looking through these related objects is a great way to learn the Max
language fast. Also, if you are trying to find an object that operates similarly, but not exactly the
same, to an object you know, you may find that object via this menu. You can also create a new
object and type in the desired function you’re looking for as if the new object box were a search
engine!An additional option in Max is to enable Help in Locked Patchers. This allows you to
open the Help file for an object in a locked patch by holding the alt/option key down and clicking
on an object. To enable Help in Locked Patchers, go to the Options menu item at the top of the
screen. In this book, we will not open Help in any locked patchers, so there is no need to enable
it, though you may find it useful for your personal projects.12. Close the Help file for print13.



Paste the contents copied from the print Help file into your patch using the commands  +v (Mac)
or ctrl+v (Windows)12. Close the Help file for print13. Paste the contents copied from the print
Help file into your patch using the commands  +v (Mac) or ctrl+v (Windows)ArgumentsIn your
patch, notice that some of the print objects in the Help file contents you just copied contain extra
words to the right of the “print” object name. These are called arguments. Arguments are used to
set or change variables for an object and are related to the types of data and messages the
object deals with. In most cases, specifying an argument replaces some default value, if the
object had one, with a new one. In the case of the print object, an argument will replace the
default word “print” in the Max Console.14. Change or add the print argument to a single word of
your choosing15. Lock the patch and click the message box16. Open the Max window to reveal
that the word you chose has replaced the word “print”14. Change or add the print argument to a
single word of your choosing15. Lock the patch and click the message box16. Open the Max
window to reveal that the word you chose has replaced the word “print”Look at Figure 1.6 and try
to determine what will happen when you click on the message box:FIGURE 1.6a print object
with an argument | hello_world2.maxpatFIGURE 1.6a print object with an argument |
hello_world2.maxpatThe supplied argument is two words: this and argument. However, the print
object only takes one argument so the second argument, argument, is dropped. The message in
the Max window readsObject: this Message: Hello WorldObject: this Message: Hello
WorldSeparating Items in a MessageNow, unlock your patch and17. Double click the message
box containing the text Hello World and put a comma after the word Hello17. Double click the
message box containing the text Hello World and put a comma after the word HelloFIGURE
1.7printing a list to the Max Window | hello_world3.maxpatFIGURE 1.7printing a list to the Max
Window | hello_world3.maxpatThe comma is used to separate items in a message box. The
message box now contains two separate items. Each item in the message will be printed to the
Max window on a separate line.18. Lock your patch and click the same message box18. Lock
your patch and click the same message boxTake a moment to save your patch as
hello_world.maxpat. Close the patch.Numbers: Integers and Floating PointsCreate a new
patcher, and1. Create new object called number1. Create new object called numberThe number
object, also called a number box, is such a common object in Max that it has its own key
command shortcut, the i key, for putting the object in your patch. Think of the i as short for
integer as opposed to the other type of number box we’ll deal with in Max: the floating-point
numbers; numbers with a decimal point.A number object simply holds a number.2. Lock your
patch, and click on the number object2. Lock your patch, and click on the number objectNow,
type the number 34 into that object. The number 34 will stay in that number box until you change
it or close the patch. When the patch is closed, the number box will return to its default value of
0.3. Click on the number in the number box and drag the number up or down to increase or
decrease the value. You may also use the arrow keys to increase or decrease the value once you
have clicked in the number box3. Click on the number in the number box and drag the number
up or down to increase or decrease the value. You may also use the arrow keys to increase or



decrease the value once you have clicked in the number boxUnlock your patch and4. Create 3
new message boxes containing the values 44, 55, and 42.85, respectively5. Connect the outlet
of each message box to the inlet of the number box6. Lock your patch and click each message
box4. Create 3 new message boxes containing the values 44, 55, and 42.85, respectively5.
Connect the outlet of each message box to the inlet of the number box6. Lock your patch and
click each message boxFIGURE 1.8connecting message boxes to number boxes |
number_boxes.maxpatFIGURE 1.8connecting message boxes to number boxes |
number_boxes.maxpatNotice that the value of the number box changes for each value you send
to it by clicking a message box. Note that when you send the number box the floating point value
42.85, it drops the decimal point values completely. The number object only takes the integer
part of a floating point number. It does not round the number up or down; it simply truncates
it.Unlock your patch and7. Create a new object called a flonum7. Create a new object called a
flonumA flonum object is a floating-point number box. Floating-point number boxes can be used
to show more precise numbers than integer numbers. Is the singer singing exactly at A 440 or is
she singing at A 440.91? A flonum will represent this value more accurately than a number box
since, unlike the number box, it can contain the numbers after the decimal point. The flonum
object, sometimes called a float, is such a common object in Max that it has its own key
command shortcut, the f key, for putting the object in your patch.8. Create 3 new message boxes
with the values 55.72, 44.35, and 55, respectively9. Connect the outlet of each message box to
the first inlet of the flonum box10. Lock your patch and click on each message box8. Create 3
new message boxes with the values 55.72, 44.35, and 55, respectively9. Connect the outlet of
each message box to the first inlet of the flonum box10. Lock your patch and click on each
message boxThe first two message boxes send the floating-point number to the flonum object. If
you send a floating-point number with more than two decimal places, you will need to resize the
flonum object to see these places by clicking on the button right corner of the object and
dragging to the right. The third message box, 55, is still received by the flonum even though it is
not a floating-point number.FIGURE 1.9connecting message boxes to flonum boxes |
number_boxes.maxpatFIGURE 1.9connecting message boxes to flonum boxes |
number_boxes.maxpatAligningYou may have noticed that the patch cords in the chapter
examples may look more segmented than yours. With Segmented Patch Cords selected from
the Options menu, you are able to click at multiple points along the path between objects
controlling the shape of the cable. You can also align patch cords by highlighting them (ctrl
+clicking [Mac] or right clicking [Windows]) it after they’re connected to some objects and
selecting Align, or by using the key command  +y (Mac) or ctrl+shift+a (Windows).You can also
align highlighted objects using the same key command.3 You can highlight multiple objects,
either by holding the shift key and clicking the desired objects, or by drawing a marquee
rectangle around them with the mouse. To highlight patch cords while you are drawing a
marquee, hold the alt/option key. The Arrange menu also provides the option to snap objects in
place according to a grid or even to snap objects in place relative to each other.CommentingIt is



a good idea to make comments within a patch while you are writing it. As patches become
larger, they can become difficult to read, and if you haven’t opened the patch up in a while, it is
easy to forget what you did and how certain parts of it function.11. Create a new object called
comment11. Create a new object called commentThe comment object, also called a comment
box, allows you to type directly into your patch and document it. The comment object is such a
common object in Max that it has its own key command shortcut, the c key, for putting the object
in your patch.12. Create 2 new objects called comment containing the text integers and floating
point numbers, respectively13. Label the number objects as integers and the flonum objects as
floating-point numbers by moving the comments near these objects12. Create 2 new objects
called comment containing the text integers and floating point numbers, respectively13. Label
the number objects as integers and the flonum objects as floating-point numbers by moving the
comments near these objectsFIGURE 1.10commenting your patch |
number_boxes.maxpatFIGURE 1.10commenting your patch | number_boxes.maxpatIn general
practice, it is important to be descriptive when documenting your patch.14. Create a third
comment object, which we will use for the title, and enter the text ints and floats14. Create a third
comment object, which we will use for the title, and enter the text ints and floatsFIGURE 1.11the
arrow icon over a comment objectFIGURE 1.11the arrow icon over a comment objectInspectorIt
would be nice to see our title comment “ints and floats” in a somewhat larger font. To change
properties about this or any object, go to the Inspector by Ctrl+clicking (Mac) or right clicking
(Windows) an object and selecting Inspector from the contextual menu while the patch is
unlocked. With an object highlighted, you can also use the key command  +i (Mac) or ctrl+i
(Windows), or click the Inspector icon located on the right side of the patch window. Another
method of getting to the Inspector is to hold your mouse in the middle of the left side of the
object, click the arrow icon that appears, and choose the Inspector label.15. Open the Inspector
for the comment box containing the title “ints and floats”15. Open the Inspector for the comment
box containing the title “ints and floats”From the Inspector menu, you can select tabs for which to
edit the object’s properties. The tab All is selected by default and contains all of the property
options of the other tabs. Please note: in other Max menus similar to this one, the Basic tab is
shown by default, so switch to the All tab if necessary.FIGURE 1.12changing an object’s
properties through the Inspector | number_boxes.maxpatFIGURE 1.12changing an object’s
properties through the Inspector | number_boxes.maxpat16. In the Inspector, scroll down to the
line marked Font Size and increase the font to 30 by double clicking the default number and
typing in the number 3016. In the Inspector, scroll down to the line marked Font Size and
increase the font to 30 by double clicking the default number and typing in the number 30Take a
moment to save your patch as number_boxes. Close the patch.Key Commands:• New Patcher: 
+n (Mac) or ctrl+n (Windows)• Save Patcher:  +s (Mac) or ctrl+s (Windows)• Zoom In:  +=
(Mac) or ctrl+= (Windows)• Zoom Out:  +- (Mac) or ctrl+- (Windows)• Copy:  +c (Mac) or ctrl+c
(Windows)• Paste:  +v (Mac) or ctrl+v (Windows)• New Object Box: n• Button object: b• Toggle
Lock & Edit Modes:  +e (Mac) or ctrl+e (Windows)• Message object: m• Max window:  +m



(Mac) or ctrl+m (Windows)• Help: alt/option then click an object• Number (integer) object: i•
Flonum (floating-point number) object: f• Align:  +y (Mac) or ctrl+shift+a (Windows)• Comment:
c• Inspector:  +i (Mac) or ctrl+e (Windows) with the object highlighted• New Patcher:  +n (Mac)
or ctrl+n (Windows)• Save Patcher:  +s (Mac) or ctrl+s (Windows)• Zoom In:  += (Mac) or ctrl+=
(Windows)• Zoom Out:  +- (Mac) or ctrl+- (Windows)• Copy:  +c (Mac) or ctrl+c (Windows)•
Paste:  +v (Mac) or ctrl+v (Windows)• New Object Box: n• Button object: b• Toggle Lock & Edit
Modes:  +e (Mac) or ctrl+e (Windows)• Message object: m• Max window:  +m (Mac) or ctrl+m
(Windows)• Help: alt/option then click an object• Number (integer) object: i• Flonum (floating-
point number) object: f• Align:  +y (Mac) or ctrl+shift+a (Windows)• Comment: c• Inspector:  +i
(Mac) or ctrl+e (Windows) with the object highlightedNew Objects Learned:• button• print•
message• number• flonum• comment• button• print• message• number• flonum•
commentRemember:• A document in Max is referred to as a patcher or a patch.• You can copy
an object by holding the alt/option key and dragging an object.• You can resize an object by
holding your mouse over the bottom right of the object until your mouse shows two arrows at an
angle, and dragging while holding the mouse button down.• Segmented Patch Cords is an
option that causes a patch cord to be created when you click on the outlet of an object.• With
Segmented Patch Cords selected, if you click on an object’s outlet, the patch cord will follow
your mouse until you connect it to another object’s inlet or press the esc key.• Patch cords
always connect from outlets to inlets and never the other way around.• The file-name extension
“.maxpat” is given to all Max patches.• To avoid a Stack Overflow, make sure objects are not
feeding data back into themselves.• The Max window shows important messages and useful
debugging information in case of errors.• Open Help by holding the alt/option key down and
clicking on an object.• To find out more information about an object, click on the Open Reference
link within the object’s Help file.• Arguments are parameters that can be set for an object that
relate somehow to the types of data that object handles.• The number box truncates decimal
point values completely. It does not round numbers up or down at all.• It is important to be as
descriptive as possible when commenting your patch.• To change properties about an object, go
to the Inspector.• A document in Max is referred to as a patcher or a patch.• You can copy an
object by holding the alt/option key and dragging an object.• You can resize an object by holding
your mouse over the bottom right of the object until your mouse shows two arrows at an angle,
and dragging while holding the mouse button down.• Segmented Patch Cords is an option that
causes a patch cord to be created when you click on the outlet of an object.• With Segmented
Patch Cords selected, if you click on an object’s outlet, the patch cord will follow your mouse
until you connect it to another object’s inlet or press the esc key.• Patch cords always connect
from outlets to inlets and never the other way around.• The file-name extension “.maxpat” is
given to all Max patches.• To avoid a Stack Overflow, make sure objects are not feeding data
back into themselves.• The Max window shows important messages and useful debugging
information in case of errors.• Open Help by holding the alt/option key down and clicking on an
object.• To find out more information about an object, click on the Open Reference link within the



object’s Help file.• Arguments are parameters that can be set for an object that relate somehow
to the types of data that object handles.• The number box truncates decimal point values
completely. It does not round numbers up or down at all.• It is important to be as descriptive as
possible when commenting your patch.• To change properties about an object, go to the
Inspector.Additional Tutorials:Tutorials are available from within the Max application by clicking
Help from the top menu and selecting Reference.Under the Max heading, click and read• The
Basic Activities of Making Patches• Tips and Shortcuts• The Basic Activities of Making Patches•
Tips and ShortcutsSelect Max Tutorials and read• Hello—Creating objects and connections•
Bang!—The bang message• Numbers and Lists—Types of data in Max• Hello—Creating
objects and connections• Bang!—The bang message• Numbers and Lists—Types of data in
MaxOn Your Own:• Read the Help file for each of the new objects introduced in this chapter.•
Write a patch that allows a user to click on a single button to send 3 different message boxes
with numerical values (integer or floating-point) to 3 separate objects: the print object, the
number box, and the flonum box. Specify an argument for the print object. Comment the patch
with a title in size 30 font. Use your knowledge of key commands to speed up the process.•
Read the Help file for each of the new objects introduced in this chapter.• Write a patch that
allows a user to click on a single button to send 3 different message boxes with numerical values
(integer or floating-point) to 3 separate objects: the print object, the number box, and the flonum
box. Specify an argument for the print object. Comment the patch with a title in size 30 font. Use
your knowledge of key commands to speed up the process.1 Throughout this book, key
commands are noted for both Mac and Windows by using, for example, the following syntax:  +n
(Mac) or ctrl+n (Windows), which indicates that a user should press the command key  plus the
n key on Mac, or the control key ctrl plus the n key on Windows. Though a plus sign (+) is
indicated, it is not an additional key to be held during these functions unless specifically noted.2
Mac users will have to use ctrl+click if right clicking has not been enabled in System Preferences
or if their mouse or touchpad does not support right clicking capabilities.3 This option is best
used for objects positioned along the same plane. Highlighting everything in the patch and
clicking align could make a mess.1 Throughout this book, key commands are noted for both
Mac and Windows by using, for example, the following syntax:  +n (Mac) or ctrl+n (Windows),
which indicates that a user should press the command key  plus the n key on Mac, or the
control key ctrl plus the n key on Windows. Though a plus sign (+) is indicated, it is not an
additional key to be held during these functions unless specifically noted.2 Mac users will have
to use ctrl+click if right clicking has not been enabled in System Preferences or if their mouse or
touchpad does not support right clicking capabilities.3 This option is best used for objects
positioned along the same plane. Highlighting everything in the patch and clicking align could
make a mess.2Generating MusicIn this chapter, we will create a program that randomly
generates pitches at a specified tempo. The program will have the ability to change a number of
musical variables including timbre, velocity, and tempo. We will also write a program that allows
your MIDI keyboard to function as a synthesizer. These two programs will be the basis of future



projects related to composition and performance.Going forward in this book, since you’ve
already learned a number of objects in the previous chapter, let’s agree that when you’re asked
to create an object that you already know, like button, for example, it will be sufficient for me to
say “create a button” instead of repeating the process of creating a new object box and typing in
the word button. Combining steps in this way will help us to get through the instructions with
greater speed while reinforcing your understanding of how certain objects work. In this way, the
instruction, for example, “create a message box containing the numbers 41 and 38” actually
combines several smaller, and hopefully intuitive, instructions into a single step. I will slowly stop
mentioning key commands and other shortcuts for objects and tasks that I’ve already
introduced.The RAT PatchCreate a new patch and1. Create a new object (press n) called
randomThe random object takes a number as its only argument and randomly generates a
number between 0 and one less than the argument when it receives a bang in its inlet.2. Give
this random object the argument 128 (Note: if you already clicked away from the object, double
click it in order to, once again, enable typing within the object box)Be sure to put a space
between the word random and the argument 128 or else Max will look for an object called
random 128 that does not exist.3. Create a new button (press b)4. Connect the outlet of button
to the first inlet of random 1285. Create a number box (press i)6. Connect the outlet of random
128 to the inlet of the number boxFIGURE 2.1outputs random numbers from 0 to 127 when a
bang is received | the _RAT_patch.maxpatDo you remember that kid that you went to grammar
school with who asked you to count to 10 and when you started counting “1, 2, 3 . . .” he
stopped you and laughed as he declared “No! You forgot the number zero!!!” I’m sure you
remember that kid, or maybe you were that kid. Well, in Max, we almost always start counting at
the number 0, not the number 1. With the argument 128, the random object will randomly output
a total of 128 possible numbers starting at 0, which means that the range of numbers being
randomly generated from random will be between 0 and 127.7. Lock your patch and click the
button to see random numbers between 0 and 127MIDI (Musical Instrument Digital
Interface)The MIDI protocol is a language that computers use to convey musical messages.
Synthesizers as well as nearly all computer music software applications deal with MIDI in some
way. What are these MIDI messages?In essence, MIDI is a bunch of messages in which a total
of 128 numbers, the numbers 0–127, are used to represent musical elements like pitch and
velocity. The lowest MIDI note, 0, is the pitch C at 5 octaves below middle C. The number 1 is the
C /D directly above that C, and so on. The MIDI note 12 is the C above the lowest C.Velocity is a
measure of MIDI volume represented by the same number numbers 0–127. The value 0 means
that the note is off whereas the value 127 is the loudest volume that MIDI can produce.
Therefore, the note 60 with a velocity of 127 could be described as middle C at a very loud
volume.FIGURE 2.2MIDI Note C as it relates to the grand staffSynthesizing MIDI NumbersWith
the objects described earlier, we are able to generate random numbers, which is not a very
musical task. However, since MIDI uses numbers to represent pitches, there’s no reason we
can’t use those random numbers as pitches. We would then hear each random number as a



random pitch. To accomplish this, we need to format those pitches into a MIDI message that
includes some information about the velocity of the random pitch and how long the note will
sound. An easy way to do this formatting is with the makenote object. The makenote object
takes two numbers as arguments to specify a default velocity (first argument) and default
duration (second argument) which will be associated with the random pitch value. The duration
value is how long, in milliseconds, the note will last until makenote sends out a velocity 0 value to
turn the note off. Unlock your patch and8. Create a new object called makenote with the
arguments 100 and 5009. Connect the first outlet of the number box to the first inlet of makenote
100 50010. Create 2 number boxes11. Connect each outlet of makenote 100 500 to the inlet of
the 2 newly created number boxes, respectively12. Lock your patch and click the buttonYou’ve
likely noticed that although we see the numbers change, there is no sound. Remember, we’ve
only now organized a bunch of messages; we haven’t included an object to allow us to hear the
note through our computer’s sound-card. With the objects we’ve assembled this far, clicking on
the button will generate a random number between 0 and 127, the full range of MIDI pitches.
The random number will be treated as the pitch in a MIDI message and partnered with a default
velocity value, which we have supplied as 100. The note will last for 500 milliseconds, after
which the makenote object will output a velocity value of 0 for that pitch turning the note
off.FIGURE 2.3formats a MIDI message using the random number as pitch. |
the_RAT_patch.maxpatLook at the number box connected to makenote’s last outlet as you click
the button. It outputs the velocity value of 100 for half a second and then sends the “note off”
message: velocity 0. The makenote object keeps track of what numbers it receives and ensures
that all notes are given a “note off”/velocity 0 message after the duration value, in this case, 500
milliseconds.Now, let’s actually hear what this sounds like by adding the object noteout so that
makenote can communicate with our soundcard.If you unlock your patch and hold your mouse
over the two outlets of the makenote object, you will see that it sends MIDI pitch numbers out of
the left outlet and MIDI velocity numbers out of the right outlet. The noteout object takes pitch
numbers in its leftmost inlet and velocity numbers in its middle inlet. With your patch unlocked13.
Create a new object called noteout14. Connect the outlets of makenote 100 500 to the first 2
inlets of noteoutThe noteout object takes a number in its third inlet to specify the MIDI channel
number. You can also specify a default argument for the MIDI channel by supplying a number in
the object box after the word noteout. For now, we’ll use the object’s default MIDI channel,
channel 1.15. Lock your patch and click the button to generate a random number, which will be
synthesized as a MIDI pitch with a velocity of 100 and a duration of 500 millisecondsSince the
duration of each note lasts one half of a second, it would be nice to have the patch automatically
generate a new random note each half a second.FIGURE 2.4sends a random number out |
the_RAT_patch .maxpatAdding TimingThe metro object functions like a metronome sending out
bangs at a specified interval of time. The time, in milliseconds, is specified as an argument for
metro. In the same patch, unlock your patch and16. Create a new object called metro and give it
the argument 50017. Create a button18. Connect the outlet of metro 500 to the inlet of the



buttonWhen the metro object is “on,” it will cause the button to blink (send bangs) every 500
milliseconds. To turn the metro on, we will use the toggle object.The toggle object is an on/off
switch for Max objects. Like a light switch, toggle has two states: on or off. The toggle is such a
common object in Max that it has its own key command shortcut for putting the object in your
patch by pressing the t key.19. Create a new object called toggle20. Connect the outlet of the
toggle to the first inlet of metro 500FIGURE 2.5sends a random number out |
the_RAT_patch.maxpat21. Lock the patch and click on the toggle to turn it onAn X means the
toggle is on and that the metro object will begin sending out bang messages to the button every
500 milliseconds.22. Click on the toggle again to turn it offThe toggle actually only outputs the
numbers 0 and 1 where a 0 indicates that something is off and 1 indicates that something is on.
We could have also sent the metro object a message box containing a 1 to turn it on, and
another message box with a 0 in it to turn it off, but toggle provides a more graphical way of
doing it.Since our metro 500 is outputting bangs, it seems we have an extra button in our patch.
Unlock your patch and23. Delete the button connected to metro 500’s outlet by highlighting the
button and pressing delete24. Connect the outlet of metro 500 to the inlet of the button above
the random 128 objectWith the toggle turned on, the metro will trigger a random number to
become synthesized every 500 milliseconds.25. Lock the patch and click on the toggle to turn it
on26. Click on the toggle again to turn it offThis patch creates what my students and I
affectionately call Random Atonal Trash or the RAT patch.FIGURE 2.6creates random atonal
trash | the_RAT_patch .maxpatNow that we’ve made our first RAT patch, we will discuss some
of the ways that you can control this patch. Currently, the patch has only one control: the toggle
to turn the patch on and off, which generates random pitches. However, there are many
variables within the patch that could conceivably have controls. For instance, if you want to
change the speed of the metro, you can send a number, either as a message box or a number
box, to metro’s right inlet to replace metro’s default argument of 500. Unlock your patch and27.
Create a number box to the upper right of metro 50028. Connect the first outlet of the number
box to metro 500’s second inletIf you change the number inside the newly created number box
by clicking in it (locked) and typing a new number,1 the number of milliseconds metro will wait
until it sends out another bang will change from being every 500 milliseconds to whatever
number you specify. This is how you replace arguments for objects. Arguments don’t change
visually within objects just internally, so even though the 500 remains in the object box, metro’s
argument will change to whatever you enter in the number box. Since we’ve “hard-coded” the
number 500 as metro’s default argument, when you open the patch, the metro object’s default
time interval will be 500 milliseconds and, thus, will send out bangs every 500 milliseconds until
a new number is supplied to metro’s second inlet.Since metro’s speed and makenote’s duration
are both 500 milliseconds, it makes sense that if we change the argument for one, we should
change it for the other or else we’d have either overlapping or staccato notes. If you hold your
mouse over makenote’s third inlet, you will see that it receives a duration value.29. Create a new
number box near makenote 100 50030. Connect the first outlet of this number box to the last



inlet of makenote 100 500If you specify the same argument for both the metro and the
makenote, you will ensure that generated notes are legato and not staccato or
overlapping.FIGURE 2.7control your RAT patch by changing the default arguments |
the_RAT_patch.maxpat31. Lock the patch and click on the toggle to turn it on32. Change the
arguments for metro and makenote by clicking in the newly created number boxes33. Turn the
toggle offThis patch functions fine as it is, but what would really be useful for those who will use
this patch (your users) would be some sort of graphical object that allows you to control numbers
more easily than the number boxes alone. One such object is the slider object. Unlock your
patch and34. Create a new object called sliderWhen you create a new object call slider, the
object turns into a vertical control resembling a fader on a mixing board. By default, slider
outputs the numbers 0–127 depending on where the horizontal knob in the slider is positioned. If
you connect the slider to the two number boxes that control metro speed and make-note
duration, you can control both numbers simultaneously with one control.35. Connect the outlet
of slider to the inlet of the number boxes connected to the last inlet of metro and makenote36.
Lock the patch on click on the toggle to turn it onFIGURE 2.8control your RAT patch with UI
objects like slider | the_RAT_patch.maxpatAlgorithmic CompositionThe term algorithmic
composition is used to describe music that is composed by using some sort of process. It
commonly refers to music composed with the use of computer algorithms or processes.
However, algorithmic composition is as old as composition itself.One of the earliest examples is
found in Guido D’Arezzo’s treatise on medieval music Micrologus, written around 1026. Guido
notated a scale on the staff and wrote a different vowel beneath each pitch. Then, using some
Latin text, he matched the vowel sound of each syllable in the text to the pitch in his scale that
used the similar-sounding vowel. In effect, the word alleluia might be used to yield the pitches C
for syllable a, D for syllable e (from “lle”), G for syllable u (from “lu”), and A for syllable a (from
“ia”). Imagine creating a similar compositional activity by using the patch you just made as a tool
where, instead of using the vowels a, e, i, o, and u, you used the numbers 1 through 8.FIGURE
AGuido D’Arezzo-style algorithmic compositionAnother type of algorithmic technique, often
credited to Mozart, was used to compose a minuet by reordering precomposed measures of
music through controlled chance. In one such technique, a number of 2-bar “opening” phrases
were composed along with an equal number of 2-bar “closing” phrases that end in some form of
cadence. Each opening and closing phrase was given a letter as an identifier and placed in 1 of
2 hats. As guests entered the party, each drew a slip of paper with a one-letter identifier written
on it from 1 of 2 hats that referred to one of the opening or closing phrases. The order of the
letters, then, indicated the order in which the phrases should be played. When all the guests had
arrived, a musician would then perform the new piece composed algorithmically through
recombination of the precomposed phrases. Mozart’s so-called Musikalisches Würfelspiel (K.
516f), or “music dice game,” used a similar controlled-randomness approach by rolling dice.This
technique of recombinance is similar to the Experiments in Musical Intelligence (EMI) described
by David Cope (1991; 1996; 2000) in which new compositions were created in the style of



composers such as J. S. Bach, Chopin, and Beethoven through an algorithmic process data-
driven by the works of these composers.In Interactive Music Systems, Robert Rowe (1993)
describes 3 methods of algorithmic composition:Generative methods use sets of rules to
produce complete musical output from the stored fundamental material.Sequenced techniques
use prerecorded music fragments in response to some real-time input. Some aspects of these
fragments may be varied in performance, such as tempo playback, dynamic shape, slight
rhythmic variations, etc.Transformative methods take some existing musical material and apply
transformation to it to produce variants. According to the technique, these variants may or may
not be recognizable related to the original. For transformative algorithms, the source material is
complete musical input.All compositions are generally in some nature algorithmic even if they do
not use a computer; a computer, however, can help to make the composition process much
more efficient. Estonian composer Arvo Pärt’s Cantus in Memoriam Benjamin Britten (1977) is a
prolation canon in which each instrument plays the descending notes of the a minor scale at
different harmonic speeds. In this composition, once the composer decided on this process, the
nature of composing the piece on staff paper was largely a matter of adhering to the process
and putting the notes into the right place. Of course, there are numerous musical judgments that
the composer also made in addition to carrying out the process. The point of this illustration is
that when the composer decided on a process, he had at least two choices: do it by hand, which
he did, or, if he had known a programming language, use a computer to carry out the task. The
latter would have been much more efficient and would have yielded the same piece.Though you
may not be interested in composing in the style of Pärt or Cope, we can certainly gather the
notion that technology-assisted composition can make traditional compositional processes
more efficient. Technology, and Max in particular, can also be used to develop compositional
processes that are both anchored in tradition and radically new.In future chapters, we will
continue to look at the ways that Max can be used to allow individuals to compose and perform
music, as well as the many ways that Max can help educators to teach composition and
theory.37. Click on the slider and increase or decrease the horizontal knob to send the numbers
0–127 to the argument inlets of metro and makenote38. Turn the toggle offAs I mentioned, by
default, slider outputs numbers from 0 to 127. To increase or decrease the range of numbers
slider outputs, open up slider’s Inspector menu. Note that the “output minimum” will offset the
starting number. For example, if your slider range is 200 and your minimum number is 50, the
slider will output the numbers 50–249, a range of 200 numbers. Unlock your patch and39. Open
the Inspector for slider and change the range of this slider to 1000 and leave its output minimum
at the default value 0You may feel that the notes come out too fast when the slider value is set
too low. In fact, on some slower computers, if the metro object tries to send out bangs at a rate
faster than around 20 milliseconds, it isn’t always stable. There is a way to help the latter with
something called Overdrive which we’ll discuss in Chapter 10. To address the former concern,
we can specify a minimum value for slider to output.40. In the Inspector for slider, set the output
minimum to 20Because we want to make our patches foolproof, it’s a good idea to put in default



arguments and limits to restrict the range of numbers to known or desired values. To do this,41.
Open the Inspector for the number box connected to metro’s last inlet and set the minimum
value to 2042. Do the same as the previous step for the number box connected to makenote’s
last inletSave this patch as a “the_RAT_patch.maxpat.” Before you close the RAT patch,
highlight and copy the makenote and noteout objects, as we’ll paste them into a new patch. This
brings up a good technique: reuse working parts of patches whenever possible.Slider
PatchClose the old patch and create a new patch.1. Paste makenote 100 500 and noteout into
the new patch or simply create these 2 objects2. Connect the 2 outlets of makenote 100 500 to
the first 2 inlets of noteout3. Create a new object called slider4. Connect the outlet of slider
directly to makenote 100 500’s left inlet5. Lock the patch and increase or decrease the slider
positionIn this patch, the numbers 0–127 flow directly from slider to makenote to note-out
without the need for any number boxes. Though this may save a few seconds in the creation of a
new patch, it is good practice to use number boxes after every user interface (UI) object and
other objects where the actual numbers you are working with are unclear. If something in your
patch is not working right, it’s much easier to locate the problem if you can see where numbers
are, or are not, going. Save the patch as the_RAT_reused.maxpat and close the patch.FIGURE
2.9parts of the RAT patch reused | the_RAT_reused .maxpatRat Patch 2Re-open the RAT patch
you created earlier or, for good practice, rebuild the RAT patch from memory and select Save As
from the File menu at the top. Name the file the_RAT_patch_2.maxpat.As musicians, we are not
used to thinking about musical time in terms of milliseconds; the tempo object would be more
appropriate as it allows us to discuss time in beats per minute, multiples of the beat, and division
of the beat into notes (quarters, eighths, sixteenths, etc.). Unlock the patch and1. Delete the
slider from this patch2. Double click the metro 500 object and highlight and replace the metro
500 with the word tempo with the arguments 120 for initial tempo in beats per minute (BPM), 1
for beat multiplier, and 8 for beat division, in this case, the eighth note.Our new patch with the
tempo object functions similarly to the original RAT patch, but we now have the ability to work
with timing in terms of beat values, values that musicians are typically more accustomed to
working with. Currently, the tempo will send a bang on every eighth note at 120 beats per minute.
The number box that formerly controlled the metro time interval can now be used to control the
BPM value for tempo. We know, from our discussion of changing default arguments, that the 8
indicating eighth notes can be changed, so let’s give our patch the ability to beat whole, half,
quarter, eighth and sixteenth notes.FIGURE 2.10the RAT patch controlled in BPM instead of
milliseconds | the_RAT_patch_2.maxpat3. Create 5 message boxes (press m) containing the
number 1 for whole notes, 2 for half notes, 4 for quarter notes, 8 for eighth notes, and 16 for
sixteenth notes, respectively4. Connect the outlet of each of these 5 message boxes to the
fourth inlet of the tempo object (the inlet that corresponds to the beat division value)Other beat
division values are possible, but let’s start with these numbers.5. Lock the patch and turn the
tempo object on via the toggle6. Change the beat division of tempo by clicking the different
message boxes you created7. Turn off the toggleAlthough we know what will happen to the



tempo when you click the message 8, the average user of your patch may not understand how
to use the control. Let’s take a moment to make some more articulate controls to our patch.
Unlock your patch and8. Create 5 new message boxes containing the text Whole Note, Half
Note, Quarter Note, 8th Note, and 16th Note, respectivelyThe tempo object will not understand
these much more descriptive message boxes, so we will connect these message boxes to the
first inlet of the numerical message boxes you created earlier. When we do so, clicking on the
descriptive message box will send a bang to the numerical message box that tempo can
interpret.9. Connect the outlet of the message box containing the text Whole Note to the first
inlet of the message box containing the number 110. Connect the outlet of the message box
containing the text Half Note to the first inlet of the message box containing the number 211.
Connect the outlet of the message box containing the text Quarter Note to the first inlet of the
message box containing the number 412. Connect the outlet of the message box containing the
text Eighth Note to the first inlet of the message box containing the number 813. Connect the
outlet of the message box containing the text 16th Note to the first inlet of the message box
containing the number 1614. Lock the patch and turn the toggle on15. Change the beat division
of tempo by clicking the descriptive message boxes you created16. Turn off the toggleWe can
create an even more descriptive message box that triggers both a tempo change and a beat
division change by connecting its outlet to other message boxes containing the desired
arguments. Unlock your patch and17. Create a message box containing the text 8th Notes at
Largo18. Create 2 message boxes containing the text 50 and 8, respectively19. Connect the
outlet of the message 8th Notes at Largo to the first inlet of the message boxes 50 and 8,
respectively20. Connect the outlet of message 50 to the number box connected to tempo’s
second inlet21. Connect the outlet of message 8 to tempo’s last inlet1. Lock the patch and turn
the toggle on2. Click on the message 8th Notes at Largo to trigger the value 50 to be sent as an
argument for the tempo and 8 to be sent as an argument for the beat division3. Turn off the
toggleNote that instead of a descriptive message box, a single button could also have been
used to trigger the change of multiple values. In principle, the multiple message boxes are acting
like dominoes, hitting into each other in order to trigger the numerical message to the object.4.
Save and close this patchFIGURE 2.11message boxes trigger beat divisions of the tempo object
| the_RAT_patch_2.maxpatFIGURE 2.12message boxes trigger multiple argument changes to
tempo | the_RAT_patch_2.maxpatMIDI InputThe next section involves getting MIDI data into
Max using a MIDI controller of some kind. If you have a MIDI keyboard or other device, take this
time to connect it to your computer. You will need to close and restart Max if your device was not
connected or powered up when you opened Max.We know how to get MIDI data out of Max
using the noteout object. We can get MIDI data into Max using the notein object. Create a new
patch and1. Create a new object called notein2. Create 3 number boxes3. Connect each of the 3
outlets of notein to the inlet of each number box, respectively4. Create a new object called
noteout5. Connect the first outlet of each of the 3 number boxes to the 3 inlets of noteout,
respectivelyFIGURE 2.13basic MIDI device input | MIDI_IO.maxpatAs you play notes on your



MIDI device, you can see the numerical MIDI values for pitch, velocity, and MIDI channel
displayed in the 3 number boxes. On your MIDI device, play middle C softly. The first number box
will read 60 and the second number box will read some value between 0 and 127 depending on
how softly you played the note. Notice that when you take your hand off the keyboard, you send
out a velocity value of zero for whatever pitch(es) you were playing. These velocity zero
messages are commonly referred to as “note off” messages. Even if you play just one key on
your keyboard, there are multiple numbers that are expressed as part of the MIDI message for
that note.The notein and noteout objects communicate with your computer’s sound-card and
any available MIDI devices. When the patch is locked, you can double click on one of these
objects to see a list of all MIDI devices currently connected to your computer.MIDI data are sent
on streams called channels. This allows a user to send musical data-like pitches and velocity for
separate instruments through a single cable without all of the separate MIDI data being merged
into one instrument. Data on each MIDI channel can then be assigned to use different timbres
and can even be routed to other synthesizers.In MIDI, a program refers to the type of timbre
used in the synthesis of MIDI pitches and velocities. Before synthesizer manufacturers agreed
on certain standards, later known as General MIDI, there were inconsistencies among the ways
these manufacturers organized their MIDI programs. If your favorite piano sound was located at
program number 001 on one keyboard, that same program number on another keyboard might
be a trumpet sound.When the General MIDI (GM) specification was created, the 128 MIDI
programs were standardized so that synthesizer manufactures had the same timbres in the
same locations. For example, GM program 0 is always “acoustic grand piano” while program 127
is always “gunshot.”2To change the MIDI program value in Max, use the pgmout object. This
object allows you to send the numbers 0–127 to change the MIDI timbre.6. Create a new object
called slider7. Create a number box8. Connect the outlet of slider to the inlet of the number box9.
Create a new object called pgmout10. Connect the first outlet of the number box to the first inlet
of the pgmout objectThe pgmout object does not need to be connected to any further objects.
Like noteout, it communicates with your computer’s MIDI output devices.11. Lock the patch and
increase/decrease the slider to change the MIDI program while playing notes on your MIDI
keyboardFIGURE 2.14send MIDI program changes through pmout | MIDI_IO.maxpatAs you
know, the default slider range is 0–127 which works perfectly with the range of numbers that
pgmout can receive. You have now programmed a fully functional MIDI keyboard synthesizer
capable of changing timbre.Your MIDI keyboard sends other types of MIDI data besides pitch,
velocity, program, and channel. Your controller likely has two wheels on the left-hand side: one
marked modulation and one marked pitch bend. These wheels send data into Max using the
ctlin object and the bendin3 object.Let’s make an instrument in which pitch is controlled by the
modulation wheel and velocity is controlled by the pitch bend wheel. Unlock your patch and12.
Create a new object called ctlin13. Create a number box14. Connect the first outlet of ctlin to the
inlet of the number box15. Create a new object called bendin16. Create a number box17.
Connect the first outlet of bendin to the inlet of the number box18. Create a makenote object



with the arguments 100 and 30019. Connect the first outlet of the number box receiving from
ctlin to the first inlet of makenote 100 30020. Connect the first outlet of the number box receiving
from bendin to the second inlet of makenote 100 30021. Create a new object called noteout22.
Connect both outlets of makenote 100 300 to the first two inlets of noteoutFIGURE 2.15mapping
wheel data to pitch and velocity | MIDI_IO.maxpatYou will now be able to control notes and
velocity just by moving the two wheels. Give it a shot.Since this “wheel” synthesizer is going to
exist in the same patch as the functional keyboard synthesizer we made earlier, we should
specify its noteout object to exist on MIDI channel 2 by supplying the argument 2 to noteout. To
be consistent, let’s go back and supply an argument of 1 for our keyboard synthesizer. With your
patch unlocked23. Double click the noteout object receiving from the ctlin and bendin and type
the number 2 next to it24. Double click the noteout object receiving from the notein and type the
number 1 next to itNow that our MIDI data are operating on two different channels, we can
change aspects of the instrument, such as timbre, on one channel without changing the
other.25. Highlight the slider, number box, and pgmout entity and copy/paste it to the right of the
ctlin and bendin entity26. Double click the newly copied pgmout object on the right and type the
number 2 next to it27. Double click the pgmout object you made earlier (Step 9) and type the
number 1 next to itSpecifying MIDI channel arguments for the noteout and pgmout objects will
allow the “keyboard” synth and the “wheel” synth to use different MIDI programs simultaneously
without interfering with each other because they are on separate MIDI channels, 1 and 2.28.
Lock the patch and set both sliders to different values, then use the MIDI keyboard and mod
wheels to produce notes in some way2Generating MusicIn this chapter, we will create a
program that randomly generates pitches at a specified tempo. The program will have the ability
to change a number of musical variables including timbre, velocity, and tempo. We will also write
a program that allows your MIDI keyboard to function as a synthesizer. These two programs will
be the basis of future projects related to composition and performance.Going forward in this
book, since you’ve already learned a number of objects in the previous chapter, let’s agree that
when you’re asked to create an object that you already know, like button, for example, it will be
sufficient for me to say “create a button” instead of repeating the process of creating a new
object box and typing in the word button. Combining steps in this way will help us to get through
the instructions with greater speed while reinforcing your understanding of how certain objects
work. In this way, the instruction, for example, “create a message box containing the numbers 41
and 38” actually combines several smaller, and hopefully intuitive, instructions into a single step.
I will slowly stop mentioning key commands and other shortcuts for objects and tasks that I’ve
already introduced.The RAT PatchCreate a new patch and1. Create a new object (press n)
called random1. Create a new object (press n) called randomThe random object takes a number
as its only argument and randomly generates a number between 0 and one less than the
argument when it receives a bang in its inlet.2. Give this random object the argument 128 (Note:
if you already clicked away from the object, double click it in order to, once again, enable typing
within the object box)2. Give this random object the argument 128 (Note: if you already clicked



away from the object, double click it in order to, once again, enable typing within the object
box)Be sure to put a space between the word random and the argument 128 or else Max will
look for an object called random 128 that does not exist.3. Create a new button (press b)4.
Connect the outlet of button to the first inlet of random 1285. Create a number box (press i)6.
Connect the outlet of random 128 to the inlet of the number box3. Create a new button (press
b)4. Connect the outlet of button to the first inlet of random 1285. Create a number box (press
i)6. Connect the outlet of random 128 to the inlet of the number boxFIGURE 2.1outputs random
numbers from 0 to 127 when a bang is received | the _RAT_patch.maxpatFIGURE 2.1outputs
random numbers from 0 to 127 when a bang is received | the _RAT_patch.maxpatDo you
remember that kid that you went to grammar school with who asked you to count to 10 and when
you started counting “1, 2, 3 . . .” he stopped you and laughed as he declared “No! You forgot
the number zero!!!” I’m sure you remember that kid, or maybe you were that kid. Well, in Max, we
almost always start counting at the number 0, not the number 1. With the argument 128, the
random object will randomly output a total of 128 possible numbers starting at 0, which means
that the range of numbers being randomly generated from random will be between 0 and 127.7.
Lock your patch and click the button to see random numbers between 0 and 1277. Lock your
patch and click the button to see random numbers between 0 and 127MIDI (Musical Instrument
Digital Interface)The MIDI protocol is a language that computers use to convey musical
messages. Synthesizers as well as nearly all computer music software applications deal with
MIDI in some way. What are these MIDI messages?In essence, MIDI is a bunch of messages in
which a total of 128 numbers, the numbers 0–127, are used to represent musical elements like
pitch and velocity. The lowest MIDI note, 0, is the pitch C at 5 octaves below middle C. The
number 1 is the C /D directly above that C, and so on. The MIDI note 12 is the C above the
lowest C.Velocity is a measure of MIDI volume represented by the same number numbers 0–
127. The value 0 means that the note is off whereas the value 127 is the loudest volume that
MIDI can produce. Therefore, the note 60 with a velocity of 127 could be described as middle C
at a very loud volume.FIGURE 2.2MIDI Note C as it relates to the grand staffFIGURE 2.2MIDI
Note C as it relates to the grand staffSynthesizing MIDI NumbersWith the objects described
earlier, we are able to generate random numbers, which is not a very musical task. However,
since MIDI uses numbers to represent pitches, there’s no reason we can’t use those random
numbers as pitches. We would then hear each random number as a random pitch. To
accomplish this, we need to format those pitches into a MIDI message that includes some
information about the velocity of the random pitch and how long the note will sound. An easy
way to do this formatting is with the makenote object. The makenote object takes two numbers
as arguments to specify a default velocity (first argument) and default duration (second
argument) which will be associated with the random pitch value. The duration value is how long,
in milliseconds, the note will last until makenote sends out a velocity 0 value to turn the note off.
Unlock your patch and8. Create a new object called makenote with the arguments 100 and
5009. Connect the first outlet of the number box to the first inlet of makenote 100 50010. Create



2 number boxes11. Connect each outlet of makenote 100 500 to the inlet of the 2 newly created
number boxes, respectively12. Lock your patch and click the button8. Create a new object called
makenote with the arguments 100 and 5009. Connect the first outlet of the number box to the
first inlet of makenote 100 50010. Create 2 number boxes11. Connect each outlet of makenote
100 500 to the inlet of the 2 newly created number boxes, respectively12. Lock your patch and
click the buttonYou’ve likely noticed that although we see the numbers change, there is no
sound. Remember, we’ve only now organized a bunch of messages; we haven’t included an
object to allow us to hear the note through our computer’s sound-card. With the objects we’ve
assembled this far, clicking on the button will generate a random number between 0 and 127,
the full range of MIDI pitches. The random number will be treated as the pitch in a MIDI message
and partnered with a default velocity value, which we have supplied as 100. The note will last for
500 milliseconds, after which the makenote object will output a velocity value of 0 for that pitch
turning the note off.FIGURE 2.3formats a MIDI message using the random number as pitch. |
the_RAT_patch.maxpatFIGURE 2.3formats a MIDI message using the random number as pitch.
| the_RAT_patch.maxpatLook at the number box connected to makenote’s last outlet as you
click the button. It outputs the velocity value of 100 for half a second and then sends the “note
off” message: velocity 0. The makenote object keeps track of what numbers it receives and
ensures that all notes are given a “note off”/velocity 0 message after the duration value, in this
case, 500 milliseconds.Now, let’s actually hear what this sounds like by adding the object
noteout so that makenote can communicate with our soundcard.If you unlock your patch and
hold your mouse over the two outlets of the makenote object, you will see that it sends MIDI
pitch numbers out of the left outlet and MIDI velocity numbers out of the right outlet. The noteout
object takes pitch numbers in its leftmost inlet and velocity numbers in its middle inlet. With your
patch unlocked13. Create a new object called noteout14. Connect the outlets of makenote 100
500 to the first 2 inlets of noteout13. Create a new object called noteout14. Connect the outlets
of makenote 100 500 to the first 2 inlets of noteoutThe noteout object takes a number in its third
inlet to specify the MIDI channel number. You can also specify a default argument for the MIDI
channel by supplying a number in the object box after the word noteout. For now, we’ll use the
object’s default MIDI channel, channel 1.15. Lock your patch and click the button to generate a
random number, which will be synthesized as a MIDI pitch with a velocity of 100 and a duration
of 500 milliseconds15. Lock your patch and click the button to generate a random number,
which will be synthesized as a MIDI pitch with a velocity of 100 and a duration of 500
millisecondsSince the duration of each note lasts one half of a second, it would be nice to have
the patch automatically generate a new random note each half a second.FIGURE 2.4sends a
random number out | the_RAT_patch .maxpatFIGURE 2.4sends a random number out |
the_RAT_patch .maxpatAdding TimingThe metro object functions like a metronome sending out
bangs at a specified interval of time. The time, in milliseconds, is specified as an argument for
metro. In the same patch, unlock your patch and16. Create a new object called metro and give it
the argument 50017. Create a button18. Connect the outlet of metro 500 to the inlet of the



button16. Create a new object called metro and give it the argument 50017. Create a button18.
Connect the outlet of metro 500 to the inlet of the buttonWhen the metro object is “on,” it will
cause the button to blink (send bangs) every 500 milliseconds. To turn the metro on, we will use
the toggle object.The toggle object is an on/off switch for Max objects. Like a light switch, toggle
has two states: on or off. The toggle is such a common object in Max that it has its own key
command shortcut for putting the object in your patch by pressing the t key.19. Create a new
object called toggle20. Connect the outlet of the toggle to the first inlet of metro 50019. Create a
new object called toggle20. Connect the outlet of the toggle to the first inlet of metro 500FIGURE
2.5sends a random number out | the_RAT_patch.maxpatFIGURE 2.5sends a random number
out | the_RAT_patch.maxpat21. Lock the patch and click on the toggle to turn it on21. Lock the
patch and click on the toggle to turn it onAn X means the toggle is on and that the metro object
will begin sending out bang messages to the button every 500 milliseconds.22. Click on the
toggle again to turn it off22. Click on the toggle again to turn it offThe toggle actually only outputs
the numbers 0 and 1 where a 0 indicates that something is off and 1 indicates that something is
on. We could have also sent the metro object a message box containing a 1 to turn it on, and
another message box with a 0 in it to turn it off, but toggle provides a more graphical way of
doing it.Since our metro 500 is outputting bangs, it seems we have an extra button in our patch.
Unlock your patch and23. Delete the button connected to metro 500’s outlet by highlighting the
button and pressing delete24. Connect the outlet of metro 500 to the inlet of the button above
the random 128 object23. Delete the button connected to metro 500’s outlet by highlighting the
button and pressing delete24. Connect the outlet of metro 500 to the inlet of the button above
the random 128 objectWith the toggle turned on, the metro will trigger a random number to
become synthesized every 500 milliseconds.25. Lock the patch and click on the toggle to turn it
on26. Click on the toggle again to turn it off25. Lock the patch and click on the toggle to turn it
on26. Click on the toggle again to turn it offThis patch creates what my students and I
affectionately call Random Atonal Trash or the RAT patch.FIGURE 2.6creates random atonal
trash | the_RAT_patch .maxpatFIGURE 2.6creates random atonal trash |
the_RAT_patch .maxpatNow that we’ve made our first RAT patch, we will discuss some of the
ways that you can control this patch. Currently, the patch has only one control: the toggle to turn
the patch on and off, which generates random pitches. However, there are many variables within
the patch that could conceivably have controls. For instance, if you want to change the speed of
the metro, you can send a number, either as a message box or a number box, to metro’s right
inlet to replace metro’s default argument of 500. Unlock your patch and27. Create a number box
to the upper right of metro 50028. Connect the first outlet of the number box to metro 500’s
second inlet27. Create a number box to the upper right of metro 50028. Connect the first outlet
of the number box to metro 500’s second inletIf you change the number inside the newly created
number box by clicking in it (locked) and typing a new number,1 the number of milliseconds
metro will wait until it sends out another bang will change from being every 500 milliseconds to
whatever number you specify. This is how you replace arguments for objects. Arguments don’t



change visually within objects just internally, so even though the 500 remains in the object box,
metro’s argument will change to whatever you enter in the number box. Since we’ve “hard-
coded” the number 500 as metro’s default argument, when you open the patch, the metro
object’s default time interval will be 500 milliseconds and, thus, will send out bangs every 500
milliseconds until a new number is supplied to metro’s second inlet.Since metro’s speed and
makenote’s duration are both 500 milliseconds, it makes sense that if we change the argument
for one, we should change it for the other or else we’d have either overlapping or staccato notes.
If you hold your mouse over makenote’s third inlet, you will see that it receives a duration
value.29. Create a new number box near makenote 100 50030. Connect the first outlet of this
number box to the last inlet of makenote 100 50029. Create a new number box near makenote
100 50030. Connect the first outlet of this number box to the last inlet of makenote 100 500If you
specify the same argument for both the metro and the makenote, you will ensure that generated
notes are legato and not staccato or overlapping.FIGURE 2.7control your RAT patch by
changing the default arguments | the_RAT_patch.maxpatFIGURE 2.7control your RAT patch by
changing the default arguments | the_RAT_patch.maxpat31. Lock the patch and click on the
toggle to turn it on32. Change the arguments for metro and makenote by clicking in the newly
created number boxes33. Turn the toggle off31. Lock the patch and click on the toggle to turn it
on32. Change the arguments for metro and makenote by clicking in the newly created number
boxes33. Turn the toggle offThis patch functions fine as it is, but what would really be useful for
those who will use this patch (your users) would be some sort of graphical object that allows you
to control numbers more easily than the number boxes alone. One such object is the slider
object. Unlock your patch and34. Create a new object called slider34. Create a new object called
sliderWhen you create a new object call slider, the object turns into a vertical control resembling
a fader on a mixing board. By default, slider outputs the numbers 0–127 depending on where the
horizontal knob in the slider is positioned. If you connect the slider to the two number boxes that
control metro speed and make-note duration, you can control both numbers simultaneously with
one control.35. Connect the outlet of slider to the inlet of the number boxes connected to the last
inlet of metro and makenote36. Lock the patch on click on the toggle to turn it on35. Connect the
outlet of slider to the inlet of the number boxes connected to the last inlet of metro and
makenote36. Lock the patch on click on the toggle to turn it onFIGURE 2.8control your RAT
patch with UI objects like slider | the_RAT_patch.maxpatFIGURE 2.8control your RAT patch with
UI objects like slider | the_RAT_patch.maxpatAlgorithmic CompositionThe term algorithmic
composition is used to describe music that is composed by using some sort of process. It
commonly refers to music composed with the use of computer algorithms or processes.
However, algorithmic composition is as old as composition itself.One of the earliest examples is
found in Guido D’Arezzo’s treatise on medieval music Micrologus, written around 1026. Guido
notated a scale on the staff and wrote a different vowel beneath each pitch. Then, using some
Latin text, he matched the vowel sound of each syllable in the text to the pitch in his scale that
used the similar-sounding vowel. In effect, the word alleluia might be used to yield the pitches C



for syllable a, D for syllable e (from “lle”), G for syllable u (from “lu”), and A for syllable a (from
“ia”). Imagine creating a similar compositional activity by using the patch you just made as a tool
where, instead of using the vowels a, e, i, o, and u, you used the numbers 1 through 8.FIGURE
AGuido D’Arezzo-style algorithmic compositionAnother type of algorithmic technique, often
credited to Mozart, was used to compose a minuet by reordering precomposed measures of
music through controlled chance. In one such technique, a number of 2-bar “opening” phrases
were composed along with an equal number of 2-bar “closing” phrases that end in some form of
cadence. Each opening and closing phrase was given a letter as an identifier and placed in 1 of
2 hats. As guests entered the party, each drew a slip of paper with a one-letter identifier written
on it from 1 of 2 hats that referred to one of the opening or closing phrases. The order of the
letters, then, indicated the order in which the phrases should be played. When all the guests had
arrived, a musician would then perform the new piece composed algorithmically through
recombination of the precomposed phrases. Mozart’s so-called Musikalisches Würfelspiel (K.
516f), or “music dice game,” used a similar controlled-randomness approach by rolling dice.This
technique of recombinance is similar to the Experiments in Musical Intelligence (EMI) described
by David Cope (1991; 1996; 2000) in which new compositions were created in the style of
composers such as J. S. Bach, Chopin, and Beethoven through an algorithmic process data-
driven by the works of these composers.In Interactive Music Systems, Robert Rowe (1993)
describes 3 methods of algorithmic composition:Generative methods use sets of rules to
produce complete musical output from the stored fundamental material.Sequenced techniques
use prerecorded music fragments in response to some real-time input. Some aspects of these
fragments may be varied in performance, such as tempo playback, dynamic shape, slight
rhythmic variations, etc.Transformative methods take some existing musical material and apply
transformation to it to produce variants. According to the technique, these variants may or may
not be recognizable related to the original. For transformative algorithms, the source material is
complete musical input.All compositions are generally in some nature algorithmic even if they do
not use a computer; a computer, however, can help to make the composition process much
more efficient. Estonian composer Arvo Pärt’s Cantus in Memoriam Benjamin Britten (1977) is a
prolation canon in which each instrument plays the descending notes of the a minor scale at
different harmonic speeds. In this composition, once the composer decided on this process, the
nature of composing the piece on staff paper was largely a matter of adhering to the process
and putting the notes into the right place. Of course, there are numerous musical judgments that
the composer also made in addition to carrying out the process. The point of this illustration is
that when the composer decided on a process, he had at least two choices: do it by hand, which
he did, or, if he had known a programming language, use a computer to carry out the task. The
latter would have been much more efficient and would have yielded the same piece.Though you
may not be interested in composing in the style of Pärt or Cope, we can certainly gather the
notion that technology-assisted composition can make traditional compositional processes
more efficient. Technology, and Max in particular, can also be used to develop compositional



processes that are both anchored in tradition and radically new.In future chapters, we will
continue to look at the ways that Max can be used to allow individuals to compose and perform
music, as well as the many ways that Max can help educators to teach composition and
theory.Algorithmic CompositionThe term algorithmic composition is used to describe music that
is composed by using some sort of process. It commonly refers to music composed with the use
of computer algorithms or processes. However, algorithmic composition is as old as composition
itself.One of the earliest examples is found in Guido D’Arezzo’s treatise on medieval music
Micrologus, written around 1026. Guido notated a scale on the staff and wrote a different vowel
beneath each pitch. Then, using some Latin text, he matched the vowel sound of each syllable
in the text to the pitch in his scale that used the similar-sounding vowel. In effect, the word
alleluia might be used to yield the pitches C for syllable a, D for syllable e (from “lle”), G for
syllable u (from “lu”), and A for syllable a (from “ia”). Imagine creating a similar compositional
activity by using the patch you just made as a tool where, instead of using the vowels a, e, i, o,
and u, you used the numbers 1 through 8.FIGURE AGuido D’Arezzo-style algorithmic
compositionAnother type of algorithmic technique, often credited to Mozart, was used to
compose a minuet by reordering precomposed measures of music through controlled chance. In
one such technique, a number of 2-bar “opening” phrases were composed along with an equal
number of 2-bar “closing” phrases that end in some form of cadence. Each opening and closing
phrase was given a letter as an identifier and placed in 1 of 2 hats. As guests entered the party,
each drew a slip of paper with a one-letter identifier written on it from 1 of 2 hats that referred to
one of the opening or closing phrases. The order of the letters, then, indicated the order in which
the phrases should be played. When all the guests had arrived, a musician would then perform
the new piece composed algorithmically through recombination of the precomposed phrases.
Mozart’s so-called Musikalisches Würfelspiel (K. 516f), or “music dice game,” used a similar
controlled-randomness approach by rolling dice.This technique of recombinance is similar to the
Experiments in Musical Intelligence (EMI) described by David Cope (1991; 1996; 2000) in which
new compositions were created in the style of composers such as J. S. Bach, Chopin, and
Beethoven through an algorithmic process data-driven by the works of these composers.In
Interactive Music Systems, Robert Rowe (1993) describes 3 methods of algorithmic
composition:Generative methods use sets of rules to produce complete musical output from the
stored fundamental material.Sequenced techniques use prerecorded music fragments in
response to some real-time input. Some aspects of these fragments may be varied in
performance, such as tempo playback, dynamic shape, slight rhythmic variations,
etc.Transformative methods take some existing musical material and apply transformation to it to
produce variants. According to the technique, these variants may or may not be recognizable
related to the original. For transformative algorithms, the source material is complete musical
input.All compositions are generally in some nature algorithmic even if they do not use a
computer; a computer, however, can help to make the composition process much more efficient.
Estonian composer Arvo Pärt’s Cantus in Memoriam Benjamin Britten (1977) is a prolation



canon in which each instrument plays the descending notes of the a minor scale at different
harmonic speeds. In this composition, once the composer decided on this process, the nature of
composing the piece on staff paper was largely a matter of adhering to the process and putting
the notes into the right place. Of course, there are numerous musical judgments that the
composer also made in addition to carrying out the process. The point of this illustration is that
when the composer decided on a process, he had at least two choices: do it by hand, which he
did, or, if he had known a programming language, use a computer to carry out the task. The
latter would have been much more efficient and would have yielded the same piece.Though you
may not be interested in composing in the style of Pärt or Cope, we can certainly gather the
notion that technology-assisted composition can make traditional compositional processes
more efficient. Technology, and Max in particular, can also be used to develop compositional
processes that are both anchored in tradition and radically new.In future chapters, we will
continue to look at the ways that Max can be used to allow individuals to compose and perform
music, as well as the many ways that Max can help educators to teach composition and
theory.Algorithmic CompositionThe term algorithmic composition is used to describe music that
is composed by using some sort of process. It commonly refers to music composed with the use
of computer algorithms or processes. However, algorithmic composition is as old as composition
itself.One of the earliest examples is found in Guido D’Arezzo’s treatise on medieval music
Micrologus, written around 1026. Guido notated a scale on the staff and wrote a different vowel
beneath each pitch. Then, using some Latin text, he matched the vowel sound of each syllable
in the text to the pitch in his scale that used the similar-sounding vowel. In effect, the word
alleluia might be used to yield the pitches C for syllable a, D for syllable e (from “lle”), G for
syllable u (from “lu”), and A for syllable a (from “ia”). Imagine creating a similar compositional
activity by using the patch you just made as a tool where, instead of using the vowels a, e, i, o,
and u, you used the numbers 1 through 8.FIGURE AGuido D’Arezzo-style algorithmic
compositionFIGURE AGuido D’Arezzo-style algorithmic compositionAnother type of algorithmic
technique, often credited to Mozart, was used to compose a minuet by reordering precomposed
measures of music through controlled chance. In one such technique, a number of 2-bar
“opening” phrases were composed along with an equal number of 2-bar “closing” phrases that
end in some form of cadence. Each opening and closing phrase was given a letter as an
identifier and placed in 1 of 2 hats. As guests entered the party, each drew a slip of paper with a
one-letter identifier written on it from 1 of 2 hats that referred to one of the opening or closing
phrases. The order of the letters, then, indicated the order in which the phrases should be
played. When all the guests had arrived, a musician would then perform the new piece
composed algorithmically through recombination of the precomposed phrases. Mozart’s so-
called Musikalisches Würfelspiel (K. 516f), or “music dice game,” used a similar controlled-
randomness approach by rolling dice.This technique of recombinance is similar to the
Experiments in Musical Intelligence (EMI) described by David Cope (1991; 1996; 2000) in which
new compositions were created in the style of composers such as J. S. Bach, Chopin, and



Beethoven through an algorithmic process data-driven by the works of these composers.In
Interactive Music Systems, Robert Rowe (1993) describes 3 methods of algorithmic
composition:Generative methods use sets of rules to produce complete musical output from the
stored fundamental material.Sequenced techniques use prerecorded music fragments in
response to some real-time input. Some aspects of these fragments may be varied in
performance, such as tempo playback, dynamic shape, slight rhythmic variations,
etc.Transformative methods take some existing musical material and apply transformation to it to
produce variants. According to the technique, these variants may or may not be recognizable
related to the original. For transformative algorithms, the source material is complete musical
input.All compositions are generally in some nature algorithmic even if they do not use a
computer; a computer, however, can help to make the composition process much more efficient.
Estonian composer Arvo Pärt’s Cantus in Memoriam Benjamin Britten (1977) is a prolation
canon in which each instrument plays the descending notes of the a minor scale at different
harmonic speeds. In this composition, once the composer decided on this process, the nature of
composing the piece on staff paper was largely a matter of adhering to the process and putting
the notes into the right place. Of course, there are numerous musical judgments that the
composer also made in addition to carrying out the process. The point of this illustration is that
when the composer decided on a process, he had at least two choices: do it by hand, which he
did, or, if he had known a programming language, use a computer to carry out the task. The
latter would have been much more efficient and would have yielded the same piece.Though you
may not be interested in composing in the style of Pärt or Cope, we can certainly gather the
notion that technology-assisted composition can make traditional compositional processes
more efficient. Technology, and Max in particular, can also be used to develop compositional
processes that are both anchored in tradition and radically new.In future chapters, we will
continue to look at the ways that Max can be used to allow individuals to compose and perform
music, as well as the many ways that Max can help educators to teach composition and
theory.37. Click on the slider and increase or decrease the horizontal knob to send the numbers
0–127 to the argument inlets of metro and makenote38. Turn the toggle off37. Click on the slider
and increase or decrease the horizontal knob to send the numbers 0–127 to the argument inlets
of metro and makenote38. Turn the toggle offAs I mentioned, by default, slider outputs numbers
from 0 to 127. To increase or decrease the range of numbers slider outputs, open up slider’s
Inspector menu. Note that the “output minimum” will offset the starting number. For example, if
your slider range is 200 and your minimum number is 50, the slider will output the numbers 50–
249, a range of 200 numbers. Unlock your patch and39. Open the Inspector for slider and
change the range of this slider to 1000 and leave its output minimum at the default value 039.
Open the Inspector for slider and change the range of this slider to 1000 and leave its output
minimum at the default value 0You may feel that the notes come out too fast when the slider
value is set too low. In fact, on some slower computers, if the metro object tries to send out
bangs at a rate faster than around 20 milliseconds, it isn’t always stable. There is a way to help



the latter with something called Overdrive which we’ll discuss in Chapter 10. To address the
former concern, we can specify a minimum value for slider to output.40. In the Inspector for
slider, set the output minimum to 2040. In the Inspector for slider, set the output minimum to
20Because we want to make our patches foolproof, it’s a good idea to put in default arguments
and limits to restrict the range of numbers to known or desired values. To do this,41. Open the
Inspector for the number box connected to metro’s last inlet and set the minimum value to 2042.
Do the same as the previous step for the number box connected to makenote’s last inlet41.
Open the Inspector for the number box connected to metro’s last inlet and set the minimum
value to 2042. Do the same as the previous step for the number box connected to makenote’s
last inletSave this patch as a “the_RAT_patch.maxpat.” Before you close the RAT patch,
highlight and copy the makenote and noteout objects, as we’ll paste them into a new patch. This
brings up a good technique: reuse working parts of patches whenever possible.Slider
PatchClose the old patch and create a new patch.1. Paste makenote 100 500 and noteout into
the new patch or simply create these 2 objects2. Connect the 2 outlets of makenote 100 500 to
the first 2 inlets of noteout3. Create a new object called slider4. Connect the outlet of slider
directly to makenote 100 500’s left inlet5. Lock the patch and increase or decrease the slider
position1. Paste makenote 100 500 and noteout into the new patch or simply create these 2
objects2. Connect the 2 outlets of makenote 100 500 to the first 2 inlets of noteout3. Create a
new object called slider4. Connect the outlet of slider directly to makenote 100 500’s left inlet5.
Lock the patch and increase or decrease the slider positionIn this patch, the numbers 0–127
flow directly from slider to makenote to note-out without the need for any number boxes. Though
this may save a few seconds in the creation of a new patch, it is good practice to use number
boxes after every user interface (UI) object and other objects where the actual numbers you are
working with are unclear. If something in your patch is not working right, it’s much easier to
locate the problem if you can see where numbers are, or are not, going. Save the patch as
the_RAT_reused.maxpat and close the patch.FIGURE 2.9parts of the RAT patch reused |
the_RAT_reused .maxpatFIGURE 2.9parts of the RAT patch reused |
the_RAT_reused .maxpatRat Patch 2Re-open the RAT patch you created earlier or, for good
practice, rebuild the RAT patch from memory and select Save As from the File menu at the top.
Name the file the_RAT_patch_2.maxpat.As musicians, we are not used to thinking about
musical time in terms of milliseconds; the tempo object would be more appropriate as it allows
us to discuss time in beats per minute, multiples of the beat, and division of the beat into notes
(quarters, eighths, sixteenths, etc.). Unlock the patch and1. Delete the slider from this patch2.
Double click the metro 500 object and highlight and replace the metro 500 with the word tempo
with the arguments 120 for initial tempo in beats per minute (BPM), 1 for beat multiplier, and 8
for beat division, in this case, the eighth note.1. Delete the slider from this patch2. Double click
the metro 500 object and highlight and replace the metro 500 with the word tempo with the
arguments 120 for initial tempo in beats per minute (BPM), 1 for beat multiplier, and 8 for beat
division, in this case, the eighth note.Our new patch with the tempo object functions similarly to



the original RAT patch, but we now have the ability to work with timing in terms of beat values,
values that musicians are typically more accustomed to working with. Currently, the tempo will
send a bang on every eighth note at 120 beats per minute. The number box that formerly
controlled the metro time interval can now be used to control the BPM value for tempo. We
know, from our discussion of changing default arguments, that the 8 indicating eighth notes can
be changed, so let’s give our patch the ability to beat whole, half, quarter, eighth and sixteenth
notes.FIGURE 2.10the RAT patch controlled in BPM instead of milliseconds |
the_RAT_patch_2.maxpatFIGURE 2.10the RAT patch controlled in BPM instead of milliseconds
| the_RAT_patch_2.maxpat3. Create 5 message boxes (press m) containing the number 1 for
whole notes, 2 for half notes, 4 for quarter notes, 8 for eighth notes, and 16 for sixteenth notes,
respectively4. Connect the outlet of each of these 5 message boxes to the fourth inlet of the
tempo object (the inlet that corresponds to the beat division value)3. Create 5 message boxes
(press m) containing the number 1 for whole notes, 2 for half notes, 4 for quarter notes, 8 for
eighth notes, and 16 for sixteenth notes, respectively4. Connect the outlet of each of these 5
message boxes to the fourth inlet of the tempo object (the inlet that corresponds to the beat
division value)Other beat division values are possible, but let’s start with these numbers.5. Lock
the patch and turn the tempo object on via the toggle6. Change the beat division of tempo by
clicking the different message boxes you created7. Turn off the toggle5. Lock the patch and turn
the tempo object on via the toggle6. Change the beat division of tempo by clicking the different
message boxes you created7. Turn off the toggleAlthough we know what will happen to the
tempo when you click the message 8, the average user of your patch may not understand how
to use the control. Let’s take a moment to make some more articulate controls to our patch.
Unlock your patch and8. Create 5 new message boxes containing the text Whole Note, Half
Note, Quarter Note, 8th Note, and 16th Note, respectively8. Create 5 new message boxes
containing the text Whole Note, Half Note, Quarter Note, 8th Note, and 16th Note,
respectivelyThe tempo object will not understand these much more descriptive message boxes,
so we will connect these message boxes to the first inlet of the numerical message boxes you
created earlier. When we do so, clicking on the descriptive message box will send a bang to the
numerical message box that tempo can interpret.9. Connect the outlet of the message box
containing the text Whole Note to the first inlet of the message box containing the number 110.
Connect the outlet of the message box containing the text Half Note to the first inlet of the
message box containing the number 211. Connect the outlet of the message box containing the
text Quarter Note to the first inlet of the message box containing the number 412. Connect the
outlet of the message box containing the text Eighth Note to the first inlet of the message box
containing the number 813. Connect the outlet of the message box containing the text 16th Note
to the first inlet of the message box containing the number 1614. Lock the patch and turn the
toggle on15. Change the beat division of tempo by clicking the descriptive message boxes you
created16. Turn off the toggle9. Connect the outlet of the message box containing the text Whole
Note to the first inlet of the message box containing the number 110. Connect the outlet of the



message box containing the text Half Note to the first inlet of the message box containing the
number 211. Connect the outlet of the message box containing the text Quarter Note to the first
inlet of the message box containing the number 412. Connect the outlet of the message box
containing the text Eighth Note to the first inlet of the message box containing the number 813.
Connect the outlet of the message box containing the text 16th Note to the first inlet of the
message box containing the number 1614. Lock the patch and turn the toggle on15. Change the
beat division of tempo by clicking the descriptive message boxes you created16. Turn off the
toggleWe can create an even more descriptive message box that triggers both a tempo change
and a beat division change by connecting its outlet to other message boxes containing the
desired arguments. Unlock your patch and17. Create a message box containing the text 8th
Notes at Largo18. Create 2 message boxes containing the text 50 and 8, respectively19.
Connect the outlet of the message 8th Notes at Largo to the first inlet of the message boxes 50
and 8, respectively20. Connect the outlet of message 50 to the number box connected to
tempo’s second inlet21. Connect the outlet of message 8 to tempo’s last inlet17. Create a
message box containing the text 8th Notes at Largo18. Create 2 message boxes containing the
text 50 and 8, respectively19. Connect the outlet of the message 8th Notes at Largo to the first
inlet of the message boxes 50 and 8, respectively20. Connect the outlet of message 50 to the
number box connected to tempo’s second inlet21. Connect the outlet of message 8 to tempo’s
last inlet1. Lock the patch and turn the toggle on2. Click on the message 8th Notes at Largo to
trigger the value 50 to be sent as an argument for the tempo and 8 to be sent as an argument for
the beat division3. Turn off the toggle1. Lock the patch and turn the toggle on2. Click on the
message 8th Notes at Largo to trigger the value 50 to be sent as an argument for the tempo and
8 to be sent as an argument for the beat division3. Turn off the toggleNote that instead of a
descriptive message box, a single button could also have been used to trigger the change of
multiple values. In principle, the multiple message boxes are acting like dominoes, hitting into
each other in order to trigger the numerical message to the object.4. Save and close this patch4.
Save and close this patchFIGURE 2.11message boxes trigger beat divisions of the tempo object
| the_RAT_patch_2.maxpatFIGURE 2.11message boxes trigger beat divisions of the tempo
object | the_RAT_patch_2.maxpatFIGURE 2.12message boxes trigger multiple argument
changes to tempo | the_RAT_patch_2.maxpatFIGURE 2.12message boxes trigger multiple
argument changes to tempo | the_RAT_patch_2.maxpatMIDI InputThe next section involves
getting MIDI data into Max using a MIDI controller of some kind. If you have a MIDI keyboard or
other device, take this time to connect it to your computer. You will need to close and restart Max
if your device was not connected or powered up when you opened Max.We know how to get
MIDI data out of Max using the noteout object. We can get MIDI data into Max using the notein
object. Create a new patch and1. Create a new object called notein2. Create 3 number boxes3.
Connect each of the 3 outlets of notein to the inlet of each number box, respectively4. Create a
new object called noteout5. Connect the first outlet of each of the 3 number boxes to the 3 inlets
of noteout, respectively1. Create a new object called notein2. Create 3 number boxes3. Connect



each of the 3 outlets of notein to the inlet of each number box, respectively4. Create a new
object called noteout5. Connect the first outlet of each of the 3 number boxes to the 3 inlets of
noteout, respectivelyFIGURE 2.13basic MIDI device input | MIDI_IO.maxpatFIGURE 2.13basic
MIDI device input | MIDI_IO.maxpatAs you play notes on your MIDI device, you can see the
numerical MIDI values for pitch, velocity, and MIDI channel displayed in the 3 number boxes. On
your MIDI device, play middle C softly. The first number box will read 60 and the second number
box will read some value between 0 and 127 depending on how softly you played the note.
Notice that when you take your hand off the keyboard, you send out a velocity value of zero for
whatever pitch(es) you were playing. These velocity zero messages are commonly referred to as
“note off” messages. Even if you play just one key on your keyboard, there are multiple numbers
that are expressed as part of the MIDI message for that note.The notein and noteout objects
communicate with your computer’s sound-card and any available MIDI devices. When the patch
is locked, you can double click on one of these objects to see a list of all MIDI devices currently
connected to your computer.MIDI data are sent on streams called channels. This allows a user
to send musical data-like pitches and velocity for separate instruments through a single cable
without all of the separate MIDI data being merged into one instrument. Data on each MIDI
channel can then be assigned to use different timbres and can even be routed to other
synthesizers.In MIDI, a program refers to the type of timbre used in the synthesis of MIDI pitches
and velocities. Before synthesizer manufacturers agreed on certain standards, later known as
General MIDI, there were inconsistencies among the ways these manufacturers organized their
MIDI programs. If your favorite piano sound was located at program number 001 on one
keyboard, that same program number on another keyboard might be a trumpet sound.When the
General MIDI (GM) specification was created, the 128 MIDI programs were standardized so that
synthesizer manufactures had the same timbres in the same locations. For example, GM
program 0 is always “acoustic grand piano” while program 127 is always “gunshot.”2To change
the MIDI program value in Max, use the pgmout object. This object allows you to send the
numbers 0–127 to change the MIDI timbre.6. Create a new object called slider7. Create a
number box8. Connect the outlet of slider to the inlet of the number box9. Create a new object
called pgmout10. Connect the first outlet of the number box to the first inlet of the pgmout
object6. Create a new object called slider7. Create a number box8. Connect the outlet of slider
to the inlet of the number box9. Create a new object called pgmout10. Connect the first outlet of
the number box to the first inlet of the pgmout objectThe pgmout object does not need to be
connected to any further objects. Like noteout, it communicates with your computer’s MIDI
output devices.11. Lock the patch and increase/decrease the slider to change the MIDI program
while playing notes on your MIDI keyboard11. Lock the patch and increase/decrease the slider
to change the MIDI program while playing notes on your MIDI keyboardFIGURE 2.14send MIDI
program changes through pmout | MIDI_IO.maxpatFIGURE 2.14send MIDI program changes
through pmout | MIDI_IO.maxpatAs you know, the default slider range is 0–127 which works
perfectly with the range of numbers that pgmout can receive. You have now programmed a fully



functional MIDI keyboard synthesizer capable of changing timbre.Your MIDI keyboard sends
other types of MIDI data besides pitch, velocity, program, and channel. Your controller likely has
two wheels on the left-hand side: one marked modulation and one marked pitch bend. These
wheels send data into Max using the ctlin object and the bendin3 object.Let’s make an
instrument in which pitch is controlled by the modulation wheel and velocity is controlled by the
pitch bend wheel. Unlock your patch and12. Create a new object called ctlin13. Create a number
box14. Connect the first outlet of ctlin to the inlet of the number box15. Create a new object
called bendin16. Create a number box17. Connect the first outlet of bendin to the inlet of the
number box18. Create a makenote object with the arguments 100 and 30019. Connect the first
outlet of the number box receiving from ctlin to the first inlet of makenote 100 30020. Connect
the first outlet of the number box receiving from bendin to the second inlet of makenote 100
30021. Create a new object called noteout22. Connect both outlets of makenote 100 300 to the
first two inlets of noteout12. Create a new object called ctlin13. Create a number box14. Connect
the first outlet of ctlin to the inlet of the number box15. Create a new object called bendin16.
Create a number box17. Connect the first outlet of bendin to the inlet of the number box18.
Create a makenote object with the arguments 100 and 30019. Connect the first outlet of the
number box receiving from ctlin to the first inlet of makenote 100 30020. Connect the first outlet
of the number box receiving from bendin to the second inlet of makenote 100 30021. Create a
new object called noteout22. Connect both outlets of makenote 100 300 to the first two inlets of
noteoutFIGURE 2.15mapping wheel data to pitch and velocity | MIDI_IO.maxpatFIGURE
2.15mapping wheel data to pitch and velocity | MIDI_IO.maxpatYou will now be able to control
notes and velocity just by moving the two wheels. Give it a shot.Since this “wheel” synthesizer is
going to exist in the same patch as the functional keyboard synthesizer we made earlier, we
should specify its noteout object to exist on MIDI channel 2 by supplying the argument 2 to
noteout. To be consistent, let’s go back and supply an argument of 1 for our keyboard
synthesizer. With your patch unlocked23. Double click the noteout object receiving from the ctlin
and bendin and type the number 2 next to it24. Double click the noteout object receiving from
the notein and type the number 1 next to it23. Double click the noteout object receiving from the
ctlin and bendin and type the number 2 next to it24. Double click the noteout object receiving
from the notein and type the number 1 next to itNow that our MIDI data are operating on two
different channels, we can change aspects of the instrument, such as timbre, on one channel
without changing the other.25. Highlight the slider, number box, and pgmout entity and copy/
paste it to the right of the ctlin and bendin entity26. Double click the newly copied pgmout object
on the right and type the number 2 next to it27. Double click the pgmout object you made earlier
(Step 9) and type the number 1 next to it25. Highlight the slider, number box, and pgmout entity
and copy/paste it to the right of the ctlin and bendin entity26. Double click the newly copied
pgmout object on the right and type the number 2 next to it27. Double click the pgmout object
you made earlier (Step 9) and type the number 1 next to itSpecifying MIDI channel arguments
for the noteout and pgmout objects will allow the “keyboard” synth and the “wheel” synth to use



different MIDI programs simultaneously without interfering with each other because they are on
separate MIDI channels, 1 and 2.28. Lock the patch and set both sliders to different values, then
use the MIDI keyboard and mod wheels to produce notes in some way28. Lock the patch and
set both sliders to different values, then use the MIDI keyboard and mod wheels to produce
notes in some way

Interactive Composition: Strategies Using Ableton Live and Max for Live Max/MSP/Jitter for
Music: A Practical Guide to Developing Interactive Music Systems for Education and More
Refining Sound: A Practical Guide to Synthesis and Synthesizers Multimedia Programming
Using Max/MSP and TouchDesigner Music Habits - The Mental Game of Electronic Music
Production: Finish Songs Fast, Beat Procrastination and Find Your Creative Flow

http://dl.neutronbyte.com/pdf-file/18oYWaTP/e/GlmP/KqPw/dVqvp/Max-MSP-Jitter-for-Music-A-Practical-Guide-to-Developing-Interactive-Music-Systems-for-Education-and-More


Parker, “Great introduction with many useful tools. Got me started in max in less than two
weeks. Much of it is covered in the max help files but I found this format more accessible. He
also clearly put a lot of work into the patches used for explanation. Helpful especially if you plan
to stay harmonic in Max. Every step is clarified and explained.  Recommended.”

Andie, “Perfect condition!. Slightly curvy cover but otherwise perfect condition! All pages in tact
and clean :)”

Relja, “Good book, easy to follow. great book to get started with Max”

Alexandros Papaefthymiou, “Great book, really helpful for beginners.. Really liked that covers
many aspects of Max”

byron, “Five Stars. solid”

Timothy L Clement, “Five Stars. nicely written tutorial”

ANTONIO A NAZARETH, “Five Stars. I recommend!”

laborator, “for kindle version which help me a lot. Helpful!”

JSA, “A great way to learn Max/MSP. I have looked at Max/MSP (and Pure Data) several times
over the years, and never got very far. However, this book changed all that! It is a first-rate
introduction. The text is clear, the examples are good, and everything I have tried works just fine.
As a bonus, it is fun to read and the examples are useful. An excellent book.”

M Hill, “Great introduction. Excellent book. Great introduction and general overview. Now I'd like
something more detailed”

D, “ottimo. Un bel libro, anche se secondo me non ai livelli del nostrano "musica elettronica e
sound design".L'autore ti trasporta nell'universo di Max con pratiche divertenti ed educative.”

The book by V. J. Manzo has a rating of  5 out of 4.6. 38 people have provided feedback.

Halftitle page Title page Copyright page Contents Foreword Preface Acknowledgments About
the Companion Website Halftitle page 1 Introduction to Programming 2 Generating Music 3
Math and Music 4 Scales and Chords 5 Interactive Ear Training 6 Data Structures 7 Control
Interfaces 8 Control Interfaces Continued 9 Tools for Music Theory Concepts 10 Working with
Time 11 Building Standalone Applications 12 Introduction to Max for Live 13 Working with Audio



14 Audio Playback and Pitch Tracking 15 Audio Buffers 16 Audio Effects and Processing 17
Working with Live Video 18 Working with Video Files 19 Research Instruments 20 Informal
Music Learning Instruments 21 Interactive Compositions References



Language: English
Paperback: 24 pages
Item Weight: 4.8 ounces
Dimensions: 9 x 0.09 x 12 inches
File size: 17980 KB
Text-to-Speech: Enabled
Enhanced typesetting: Enabled
X-Ray: Not Enabled
Word Wise: Not Enabled
Sticky notes: On Kindle Scribe
Print length: 431 pages
Spiral-bound: 752 pages
Calendar: 24 pages
Screen Reader: Supported

http://dl.neutronbyte.com/pdf-file/18oYWaTP/d

